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About This Guide
This guide will see you through your initial contact with SUSE Linux. Whether you
are a first time user or an experienced administrator, check out the various parts of this
manual to learn how to use and enjoy your SUSE Linux system.

Setup
Learn how to install and maintain your SUSE Linux system.

Basics
Get an introduction to the Linux desktop and to the most important software options
for SUSE Linux. In addition to that, learn how to find help or additional documen-
tation in case you need more in-depth information about your system.

Desktop
Learn more about the your preferred desktop, GNOME or KDE.

Troubleshooting
Check out a compilation of the most frequent problems and annoyances and learn
how to solve these problems on your own.

1 Feedback
We want to hear your comments and suggestions about this manual and the other doc-
umentation included with this product. Please use the User Comments feature at the
bottom of each page of the online documentation and enter your comments there.

2 Additional Documentation
There are other manuals available on this SUSE Linux product, either online at
http://www.novell.com/documentation/ or in your installed system under
/usr/share/doc/manual:

http://www.novell.com/documentation/


SUSE Linux Reference
This guide covers advanced system administration tasks with SUSE Linux. Find
an online version of this document at http://www.novell.com/
documentation/suse10/.

SUSE Linux Applications
This guide features a selection of the most important tools offered by your SUSE
Linux. Find an online version of this document athttp://www.novell.com/
documentation/suse101/.

Novell AppArmor 2.0 Administration Guide
This guide contains in-depth information about the use of AppArmor in your envi-
ronment. Find an online version of this document at http://www.novell
.com/documentation/apparmor/.

3 Documentation Conventions
The following typographical conventions are used in this manual:

• /etc/passwd: filenames and directory names

• placeholder: replace placeholder with the actual value

• PATH: the environment variable PATH

• ls, --help: commands, options, and parameters

• user: users or groups

• Alt , Alt + F1 : a key to press or a key combination; keys are shown in uppercase
as on a keyboard

• File, File → Save As: menu items, buttons

• Dancing Penguins (Chapter Penguins, ↑Reference): This is a reference to a chapter
in another book.
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4 About the Making of This Manual
This book is written in Novdoc, a subset of DocBook (see http://www.docbook
.org). The XML source files were validated by xmllint, processed by xsltproc,
and converted into XSL-FO using a customized version of Norman Walsh's stylesheets.
The final PDF is formatted through XEP from RenderX.
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1Installation with YaST
The installation of a SUSE Linux system is performed by the system assistant YaST.
Adjust the default settings as described here to install a system that meets your needs.
Background information is provided where appropriate.

1.1 System Start-Up for Installation
Insert the first SUSE Linux CD or the DVD into the drive. Then reboot the computer
to start the installation program from the medium in the drive.

1.1.1 Selecting the Source of the Installation
Data

You can install from a local installation source, such as the SUSE Linux CDs or DVD
or get the installation sources from an FTP, HTTP, or NFS server. Any of these ap-
proaches require physical access to the system to install and user interaction during the
installation. The installation procedure is basically the same, no matter which installation
source or method you prefer.

Installing from the SUSE Linux Media
Install from physical boot media (your SUSE Linux media kit) as follows:

1 Insert the media into your CD or DVD drive.
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2 Reboot the system.

3 At the boot screen, select Installation and follow the instructions given in Sec-
tion 1.2, “The Boot Screen” (page 5) and the following sections.

Installing from a Network Server Using SLP
If your network setup supports OpenSLP and your network installation source has been
configured to announce itself via OpenSLP (see Section “Setting Up the Server Holding
the Installation Sources” (Chapter 1, Remote Installation, ↑Reference)), proceed as
follows to install SUSE Linux.

1 Set up an installation server as described in Section “Setting Up the Server
Holding the Installation Sources” (Chapter 1, Remote Installation, ↑Reference).

2 Insert the first CD of the media kit into the CD-ROM drive an reboot the machine.

3 At the boot screen, select Installation, press F4 then select SLP.

The installation program retrieves the location of the network installation source
using OpenSLP and configures the network connection with DHCP. If the DHCP
network configuration fails, you are prompted to enter the appropriate parameters
manually. The installation then proceeds normally.

4 Finish the installation as if you had chosen to install from physical media.

Installing from a Network Server
To perform a manual installation using a network installation source, proceed as follows:

1 Set up an installation server as described in Section “Setting Up the Server
Holding the Installation Sources” (Chapter 1, Remote Installation, ↑Reference).

2 Insert the first CD or DVD of the media kit into the corresponding drive then
reboot the machine.

3 At the boot screen, select Installation and use the boot options prompt to pass
additional information, such as:
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• Location of the installation server:
install=protocol:inst_source

Replace protocol with the protocol prefix for the service used by the in-
stallation server (nfs, http, or ftp). Replace inst_source with the
IP address of the installation server.

• Network configuration parameters if your setup does not support DHCP
configuration (see Section “Using Custom Boot Options” (Chapter 1, Remote
Installation, ↑Reference) for reference).

4 Press Enter to boot for installation. If no network parameters have been specified
at the boot options prompt, the installation routines try to set up the network using
DHCP. If this fails, you are prompted for these parameters. After you have pro-
vided them, the installation proceeds.

5 Finish the installation as if you had chosen to install from the physical media.

1.2 The Boot Screen
The boot screen displays a number of options for the installation procedure. Boot from
Hard Disk boots the installed system. This item is selected by default, because the CD
is often left in the drive. To install the system, select one of the installation options with
the arrow keys. The relevant options are:

Installation
The normal installation mode. All modern hardware functions are enabled.

Installation—ACPI Disabled
If the normal installation fails, this might be due to the system hardware not sup-
porting ACPI (advanced configuration and power interface). If this seems to be the
case, use this option to install without ACPI support.

Installation—Safe Settings
Boots the system with the DMA mode (for CD-ROM drives) and power management
functions disabled. Experts can also use the command line to enter or change kernel
parameters.
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Use the function keys indicated in the bar at the bottom of the screen to change a
number of installation settings.

F1
Get context-sensitive help for the active element of the boot screen.

F2
Select the display language for the installation.

A few seconds after starting the installation, SUSE Linux loads a minimal Linux system
to run the installation procedure. If you want to know what is going on during the boot
process, press Esc to see messages and copyright notices scroll by. At the end of the
loading process, the YaST installation program starts. After a few more seconds, the
screen should display the graphical installer.

The actual installation of SUSE Linux begins at this point. All YaST screens have a
common layout. All buttons, entry fields, and lists can be accessed with the mouse or
the keyboard. If your mouse pointer does not move, the mouse has not been detected
automatically. In this case, use the keyboard for the time being. Navigation with the
keyboard is similar to the description in Section 2.11.1, “Navigation in Modules”
(page 74).

1.3 Language Selection
YaST and SUSE Linux in general can be configured to use different languages according
to your needs. The language selected here is also used for the keyboard layout. In addi-
tion, YaST uses the language setting to guess a time zone for the system clock. These
settings can be modified later along with the selection of secondary languages to install
on your system. If your mouse does not work, select the language with the arrow keys
and press Tab until Next is highlighted. Then press Enter to confirm your language
selection.

1.4 License Agreement
Read the license agreement that is displayed on screen thoroughly. If you agree to the
terms, choose Yes, I Agree to the License Agreement and click Next to confirm your
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selection. If you do not agree to the license agreement, you are not allowed to install
SUSE Linux and the installation terminates.

1.5 System Analysis
Select New installation or Update an existing system. Updating is only possible if a
SUSE Linux system is already installed. When a SUSE Linux system is already installed,
use Other to access two advanced options: boot the installed system with Boot installed
system or, if the installed system fails to boot, you can try to fix the problem with Repair
installed system. If no SUSE Linux system is installed, you can only perform a new
installation.

The following sections describe the procedure of installing a new system. Find detailed
instructions for a system update in Section 2.3.7, “Updating the System” (page 41).
Find a description of the system repair options in Section “Using YaST System Repair”
(page 239).

1.6 Time Zone
In this dialog, select your region and time zone from the lists. During installation, both
are preselected according to the selected installation language. Choose between Local
Time and UTC (GMT) under Hardware Clock Set To. The selection depends on how
the BIOS hardware clock is set on your machine. If it is set to GMT, which corresponds
to UTC, your system can rely on SUSE Linux to switch from standard time to daylight
saving time and back automatically. Click Change to set the current date and time.
When finished, click Next to continue the installation.

1.7 Desktop Selection
In SUSE Linux, you can choose from various desktops.KDE andGNOME are powerful
graphical desktop environments similar to Windows©. Find information about these
in Chapter 5, Getting Started with the KDE Desktop (page 137) and Chapter 7, Getting
Started with the GNOME Desktop (page 175). If you do not want either, choose Other
and click Select for more options. With Minimal Graphical System, install a graphical
window manager that allows for running stand-alone X applications and console win-
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dows but does not provide the usual integrated desktop functionality. In Text Mode,
only console terminals are available.

1.8 Installation Summary
After a thorough system analysis, YaST presents reasonable suggestions for all instal-
lation settings. The options that sometimes need manual intervention in common instal-
lation situations are presented under the Overview tab. Find more special options in the
Expert tab. After configuring any of the items presented in these dialogs, you are always
returned to the summary window, which is updated accordingly. The individual settings
are discussed in the following sections.

Figure 1.1 Installation Settings

1.8.1 Partitioning
In most cases, YaST proposes a reasonable partitioning scheme that can be accepted
without change. YaST can also be used to customize the partitioning. This section de-
scribes the necessary steps.
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Partition Types
Every hard disk has a partition table with space for four entries. An entry in the partition
table can correspond to a primary partition or an extended partition. Only one extended
partition entry is allowed, however.

A primary partition simply consists of a continuous range of cylinders (physical disk
areas) assigned to a particular operating system. With primary partitions only, you
would be limited to four partitions per hard disk, because more do not fit in the partition
table. This is why extended partitions are used. Extended partitions are also continuous
ranges of disk cylinders, but an extended partition may itself be subdivided into logical
partitions. Logical partitions do not require entries in the partition table. In other words,
an extended partition is a container for logical partitions.

If you need more than four partitions, create an extended partition as the fourth partition
or earlier. This extended partition should span the entire remaining free cylinder range.
Then create multiple logical partitions within the extended partition. The maximum
number of logical partitions is 15 on SCSI, SATA, and Firewire disks and 63 on (E)IDE
disks. It does not matter which types of partitions are used for Linux. Primary and log-
ical partitions both work fine.

Required Disk Space
YaST normally proposes a reasonable partitioning scheme with sufficient disk space.
If you want to implement your own partitioning scheme, consider the following recom-
mendations concerning the requirements for different system types.

Minimal System: 500 MB
No graphical interface (X Window System) is installed, which means that only
console applications can be used. Also, only a very basic selection of software is
installed.

Minimal System with Graphical Interface: 700 MB
This includes the X Window System and some applications.

Default System: 2.5 GB
This includes a modern desktop environment, like KDE or GNOME, and also
provides enough space for large application suites, such as OpenOffice.org and
Netscape or Mozilla.
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The partitions to create depend on the available space. The following are some basic
partitioning guidelines:

Up to 4 GB:
One partition for the swap space and one root partition (/). In this case, the root
partition must allow for those directories that often reside on their own partitions
if more space is available.

4 GB or More:
A swap partition, a root partition (1 GB), and one partition each for the following
directories as needed: /usr (4 GB or more), /opt (4 GB or more), and /var
(1 GB). If you do not want to have separate partitions for these directories, add the
suggested disk space to the root partition. The rest of the available space can be
used for /home.

Depending on the hardware, it might also be useful to create a boot partition (/boot)
to hold the boot mechanism and the Linux kernel. This partition should be located at
the start of the disk and should be at least 8 MB or one cylinder. As a rule of thumb,
always create such a partition if it was included in YaST's original proposal. If you are
unsure about this, create a boot partition to be on the safe side.

You should also be aware that some (mostly commercial) programs install their data
in /opt. Therefore, either create a separate partition for /opt or make the root partition
large enough. KDE and GNOME are also installed in /opt.

Partitioning with YaST
When you select the partitioning item in the suggestion window for the first time, the
YaST partitioning dialog displays the proposed partition settings. Accept these current
settings as they are or change them before continuing. Alternatively, discard all the
settings and start over from scratch.

Nothing in the partitioning setup is changed if you select Accept Proposal. If you select
Base Partition Setup on This Proposal, the Expert Partitioner opens. It allows tweaking
the partition setup in every detail. This dialog is explained in Section 2.5.6, “Partitioner”
(page 53). The original setup as proposed by YaST is offered there as a starting point.

Selecting Create Custom Partition Setup opens the dialog for hard disk selection. Use
the list to choose among the existing hard disks on your system. SUSE Linux will be
installed on the disk selected in this dialog.
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The next step is to determine whether the entire disk should be used (Use Entire Hard
Disk) or whether to use any existing partitions (if available) for the installation. If a
Windows operating system was found on the disk, you are asked whether to delete or
resize the partition. Before doing so, read Section “Resizing a Windows Partition”
(page 11). If desired, go to the Expert Partitioner dialog to create a custom partition
setup as described in Section 2.5.6, “Partitioner” (page 53).

WARNING: Using the Entire Hard Disk for Installation

If you choose Use Entire Hard Disk, all existing data on that disk is completely
erased later in the installation process and is then lost.

YaST checks during the installation whether the disk space is sufficient for the software
selection made. If not, YaST automatically changes the software selection. The proposal
dialog displays a notice to inform you about this. As long as there is sufficient disk
space available, YaST simply accepts your settings and partitions the hard disk accord-
ingly.

Resizing a Windows Partition
If a hard disk containing a Windows FAT or NTFS partition is selected as the installation
target, YaST offers to delete or shrink this partition. In this way, you can install SUSE
Linux even if there is currently not enough space on the hard disk. This functionality
is especially useful if the selected hard disk contains only one Windows partition that
covers the entire hard disk. This is sometimes the case on computers where Windows
comes preinstalled. If YaST sees that there is not enough space on the selected hard
disk, but that space could be made available by deleting or shrinking a Windows parti-
tion, it presents a dialog in which to choose one of these two options.
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Figure 1.2 Possible Options for Windows Partitions

If you select Delete Windows Completely, the Windows partition is marked for deletion
and the space is used for the installation of SUSE Linux.

WARNING: Deleting Windows

If you delete Windows, all data will be lost beyond recovery as soon as the
formatting starts.

To shrink the Windows partition, interrupt the installation and boot Windows to prepare
the partition from there. Although this step is not strictly required for FAT partitions,
it speeds up the resizing process and also makes it safer. These steps are vital for NTFS
partitions.

FAT File System
In Windows, first run scandisk to make sure that the FAT partition is free of lost
file fragments and crosslinks. After that, run defrag to move files to the beginning
of the partition. This accelerates the resizing procedure in Linux.

If you have optimized virtual memory settings for Windows so a contiguous swap
file is used with the same initial (minimum) and maximum size limit, consider an-
other step. With these Windows settings, the resizing might split the swap file into
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many small parts scattered all over the FAT partition. Also, the entire swap file
would need to be moved during the resizing, which makes the process rather slow.
It is therefore useful to disable these Windows optimizations for the time being
and reenable them after the resizing has been completed.

NTFS File System
In Windows, run scandisk and defrag to move the files to the beginning of the hard
disk. In contrast to the FAT file system, you must perform these steps. Otherwise
the NTFS partition cannot be resized.

IMPORTANT: Disabling the Windows Swap File

If you operate your system with a permanent swap file on an NTFS file system,
this file may be located at the end of the hard disk and remain there despite
defrag. Therefore, it may be impossible to shrink the partition sufficiently. In
this case, temporarily deactivate the swap file (the virtual memory in Windows).
After the partition has been resized, reconfigure the virtual memory.

After these preparations, return to the Linux partitioning setup and select ShrinkWindows
Partition. After a quick check of the partition, YaST opens a dialog with a suggestion
for resizing the Windows partition.

Figure 1.3 Resizing the Windows Partition
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The first bar graph shows how much disk space is currently occupied by Windows and
how much space is still available. The second bar graph shows how the space would
be distributed after the resizing, according to YaST's current proposal. See Figure 1.3,
“Resizing the Windows Partition” (page 13). Accept the proposed settings or use the
slider to change the partition sizing (within certain limits).

If you leave this dialog by selecting Next, the settings are stored and you are returned
to the previous dialog. The actual resizing takes place later, before the hard disk is for-
matted.

IMPORTANT: Windows Systems Installed on NTFS Partitions

By default, the Windows versions NT, 2000, and XP use the NTFS file system.
Unlike FAT file systems, NTFS file systems can only be read from Linux. This
means you can read your Windows files from Linux, but you cannot edit them.
If you want write access to your Windows data and do not need the NTFS file
system, reinstall Windows on a FAT32 file system. In this case, you will have
full access to your Windows data from SUSE Linux.

1.8.2 Software
SUSE Linux contains a number of software packages for various application purposes.
Click Software in the suggestion window to start the software selection and modify the
installation scope according to your needs. Select your categories from the list in the
middle and see the description in the right window. Each category contains a number
of software packages that meet most requirements for that category. For more detailed
selection of software packages to install, select Details to switch to the YaST Package
Manager. See Figure 1.4, “Installing and Removing Software with the YaST Package
Manager” (page 15).
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Figure 1.4 Installing and Removing Software with the YaST Package Manager

Changing the Installation Scope
If you have specific software needs, modify the current selection with the package
manager, which greatly eases this task. The package manager offers various filter criteria
to simplify selection from the numerous packages in SUSE Linux.

The filter selection box is located at the top left under the menu bar. The default filter
is Selections. It sorts program packages by application purpose, such as multimedia or
office applications. These groups are listed under the filter selection box. The packages
included in the current system type are preselected. Click the check boxes to select or
deselect entire groups for installation.

The right part of the window displays a table listing the individual packages included
in the current group. The table column furthest to the left shows the current status of
each package. Two status flags are especially relevant for the installation: Install (the
box in front of the package name is checked) and Do Not Install (the box is empty). To
select or deselect individual software packages, click the status box until the desired
status is displayed. Alternatively, right-click the package line to access a pop-up menu
listing all the possible status settings. To learn more about them, read the detailed de-
scription of this module in Section 2.3.1, “Installing and Removing Software” (page 31).
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Other Filters
Click the filter selection box to view the other possible filters. The selection according
to Package Groups can also be used for the installation. This filter sorts the program
packages by subjects in a tree structure to the left. The more you expand the branches,
the more specific the selection of packages is and the fewer packages are displayed in
the list of associated packages to the right.

Use Search to search for a specific package. This is explained in detail in Section 2.3.1,
“Installing and Removing Software” (page 31).

Package Dependencies and Conflicts
You cannot simply install any combination of software packages. The different software
packages must be compatible. Otherwise they might interfere with each other and cause
conflicts that affect the system as a whole. Therefore, you may see alerts about unre-
solved package dependencies or conflicts after selecting or deselecting software packages
in this dialog. If installing SUSE Linux for the first time or if you do not understand
the alerts, read Section 2.3.1, “Installing and Removing Software” (page 31), which
provides detailed information about the operation of the package manager and a brief
summary of the software organization in Linux.

WARNING

The software preselected for installation is based on long-standing experience
and is usually suitable for the needs of most newcomers and advanced home
users. In general, there is no need to change anything here. However, if you
decide to select or deselect any packages, you should be aware of the conse-
quences. In particular, observe any warnings and avoid deselecting any packages
of the base system.

Exiting the Software Selection
When satisfied with your software selection and all package dependencies or conflicts
are resolved, click Accept to apply your changes and exit the module. During the instal-
lation, the changes are recorded internally and applied later when the actual installation
starts.
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1.8.3 Language
The language was selected at the beginning of the installation as described in Section 1.3,
“Language Selection” (page 6). However, you can change this setting here and also
select any additional languages to install on your system. In the upper part of this dialog,
select the primary language. This is the language that will be activated after installation.
Adapt your keyboard and time zone settings to the selected primary language by selecting
those options, if desired. Optionally, use Details to set the language for the user root.
There are three options:

ctype only
The value of the variable LC_CTYPE in the file /etc/sysconfig/language
is adopted for the user root. This sets the localization for language-specific
function calls.

yes
The user root has the same language settings as the local user.

no
The language settings for the user root are not affected by the language selection.
All locale variables are unset.

Make the setting for the locale explicitly with Detailed Locale Setting.

The list in the lower part of the language dialog allows for selection of additional lan-
guages to install. For all the languages selected in this list, YaST checks if there are
any language-specific packages for any packages in your current software selection. If
so, these packages are installed.

Click Accept to complete the configuration.

1.8.4 System
This dialog presents all the hardware information YaST could obtain about your com-
puter. Select any item in the list and click Details to see detailed information about the
selected item. You may also add PCI IDs to device drivers with this dialog.
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1.8.5 Keyboard Layout
Select the keyboard layout from the list. By default, the layout corresponds to the se-
lected language. After changing the layout, test the characters that are special to the
selected language layout to make sure that the selection is correct. To set special options
regarding keyboard behavior, click Expert Settings. Find more information about that
in Section 2.4.9, “Keyboard Layout” (page 46). When finished, click Accept to return
to the installation settings dialog.

1.8.6 Booting
During the installation, YaST proposes a boot configuration for your system. Normally,
you can leave these settings unchanged. However, if you need a custom setup, modify
the proposal for your system.

One possibility is to configure the boot mechanism to rely on a special boot floppy.
Although this has the disadvantage that it requires the floppy to be in the drive when
booting, it leaves an existing boot mechanism untouched. Normally this should not be
necessary, however, because YaST can configure the boot loader to boot other existing
operating systems as well. Another possibility with the configuration is to change the
location of the boot mechanism on the hard disk.

To change the boot configuration proposed by YaST, select Booting to open a dialog
in which to change many details of the boot mechanism. For information, read Sec-
tion “Configuring the Boot Loader with YaST” (Chapter 9, The Boot Loader, ↑Refer-
ence). The boot method should only be changed by experienced computer users.

1.8.7 Default Runlevel
SUSE Linux can boot to different runlevels. Normally there should be no need to change
anything here, but if necessary set the default runlevel with this dialog. Refer to Sec-
tion 2.5.11, “System Services (Runlevel)” (page 58) for information about runlevel
configuration.
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1.8.8 Time Zone
In this dialog, change your region and time zone by selecting them from the lists. Choose
between Local Time and UTC (GMT) under Hardware Clock Set To. The selection
depends on how the BIOS hardware clock is set on your machine. If it is set to GMT,
which corresponds to UTC, your system can rely on SUSE Linux to switch from standard
time to daylight saving time and back automatically. Click Change to set the current
date and time. When finished, click Accept to return to the installation settings dialog.

1.8.9 Performing the Installation
After making all installation settings, click Accept in the suggestion window to begin
the installation. Confirm with Install in the dialog that opens. The installation usually
takes between 15 and 30 minutes, depending on the system performance and the software
selected. As soon as all packages are installed, YaST boots into the new Linux system,
after which you can configure the hardware and set up system services.

1.9 Configuration
After completing the basic system setup and the installation of all selected software
packages, provide a password for the account of the system administrator (the root
user). You can then configure your Internet access and network connection. With a
working Internet connection, you can perform an update of the system as part of the
installation. You can also configure an authentication server for centralized user admin-
istration in a local network. Finally, configure the hardware devices connected to the
machine.

1.9.1 Hostname
The hostname is the computer's name in the network. The fully qualified domain name,
needed here, includes the name of the domain to which the computer belongs. Each
server and client in the network should have a unique hostname.

If you are located in a local network, you might receive your hostname over DHCP, in
which case you should not modify the name. To receive the hostname over DHCP, select
Change Hostname via DHCP.
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1.9.2 root Password
root is the name of the superuser, the administrator of the system. Unlike regular
users, which may or may not have permission to do certain things on the system, root
has unlimited power to do anything: change the system configuration, install programs,
and set up new hardware. If users forget their passwords or have other problems with
the system, root can help. The root account should only be used for system admin-
istration, maintenance, and repair. Logging in as root for daily work is rather risky:
a single mistake could lead to irretrievable loss of many system files.

For verification purposes, the password for root must be entered twice. Do not forget
the root password. Once entered, this password cannot be retrieved.

WARNING: The root User

The user root has all the permissions needed to make changes to the system.
To carry out such tasks, the root password is required. You cannot carry out
any administrative tasks without this password.

1.9.3 Network Configuration
You can now choose whether to use NetworkManager or the traditional method to
manage all your network devices. NetworkManager is the new tool enabling automatic
connection establishment with minimal user intervention. It is ideal for mobile comput-
ing. Also configure the network devices of your system and make security settings, for
example, for a firewall or proxy. To configure your network hardware at this stage, refer
to Section “Configuring a Network Connection with YaST” (Chapter 18, Basic Net-
working, ↑Reference). Otherwise, select Skip Configuration and click Next. Network
hardware can also be configured after the system installation has been completed.

NOTE: Network Devices and Update

If you skip the network device configuration, your system will be offline and
unable to retrieve any available updates or include them in the installation.
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As well as device configuration, configure network accessibility–related settings:

Firewall Configuration
When you connect to a network, a firewall is started automatically on the configured
interface. The configuration proposal for the firewall is updated automatically every
time the configuration of the interfaces or services is modified. To adapt the auto-
matic settings to your own preferences, click Change → Firewall. In the dialog
that opens, determine whether the firewall should be started. If you do not want
the firewall to be started, select the appropriate option and exit the dialog. To start
and configure the firewall, click Next for a series of dialogs similar to those de-
scribed in Section “Configuring with YaST” (Chapter 4, Security in Linux, ↑Refer-
ence).

VNC Remote Administration
To administer your machine remotely by VNC, click Change → VNC Remote Ad-
ministration, enable remote administration, and open the port in the firewall. If you
have multiple network devices and want to select on which to open the port, click
Firewall Details and select the network device. You can also use SSH, a more secure
option, for remote administration.

Proxy
If you have a proxy server in your network to control access to the network, enter
the server name and all other required information to enable access to the Internet.

Internet Connection Test
If you have configured an Internet connection, you can test it now. For this purpose,
YaST establishes a connection to the SUSE Linux server and checks if any product
updates are available for your version of SUSE Linux. If there are such updates, they
can be included in the installation. Also, the latest release notes are downloaded. You
can read them at the end of the installation.

To start the test, select Yes, Test Connection to the Internet and click Next. In the next
dialog, view the progress of the test and the results of the test. If the test fails, click
Back to return in the previous dialog and correct the configuration or skip the test. If
you need more information about the test process, click View Logs.

If you do not want to test the connection at this point, select No, Skip This Test then
Next. This also skips downloading product updates and release notes.
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If you have multiple network interfaces in your system, verify that the the right card is
used to connect to the Internet. To do so, click Change device.

1.9.4 Online Update Configuration
To get technical support and product updates, first register and activate your product.
Online Update Configuration provides assistance for doing so. If you are offline or
want to skip this step, select Configure Later.

In Include for Convenience, select whether to obtain some of the necessary information
from your system. This simplifies the registration process. If you want to see what is
required to register your system or what happens with your data, use Details.

1.9.5 Online Update
If YaST was able to connect to the SUSE Linux servers, select whether to perform a
YaST online update. If there are any patched packages available on the servers, download
and install them now to fix known bugs or security issues.

IMPORTANT: Downloading Software Updates

The download of updates might take quite some time, depending on the
bandwidth of the Internet connection and the size of the update files.

1.9.6 Users
This step has two parts. In the first part, choose the user authentication method. The
second part depends on the selected authentication method.

User Authentication
If network access was configured successfully during the previous steps of the installa-
tion, you now have four possibilities for managing user accounts on your system.
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Local (/etc/passwd)
Users are administered locally on the installed host. This is a suitable option for
stand-alone workstations. User data is managed by the local file /etc/passwd.
All users who are entered in this file can log in to the system even if no network
is available.

LDAP
Users are administered centrally on an LDAP server for all systems in the network.

NIS
Users are administered centrally on a NIS server for all systems in the network.

Windows Domain
SMB authentication is often used in mixed Linux and Windows networks.

NOTE: Content of the Authentication Menu

If you use the custom package selection and one or more authentication
methods are missing from the menu, you probably did not select the packages
required for it.

If all requirements are met, YaST opens a dialog in which to select the user administra-
tion method. If you do not have the necessary network connection, create local user
accounts.

Creating Local User Accounts
Linux is an operating system that allows several users to work on the same system at
the same time. Each user needs a user account to log in to the system. By having user
accounts, the system gains a lot in terms of security. For instance, regular users cannot
change or delete files needed for the system to work properly. At the same time, the
personal data of a given user cannot be modified, viewed, or tampered with by other
users. Users can set up their own working environments and always find them unchanged
when logging back in.

If you decide against using an authentication server for user authentication, create local
users. Any data related to user accounts (name, login, password, etc.) is stored and
managed on the installed system.
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Figure 1.5 Entering the Username and Password

A local user account can be created using the dialog shown in Figure 1.5, “Entering the
Username and Password” (page 24). After entering the first name and last name,
specify a username (login). Click Suggestion for the system to generate a username
automatically.

Finally, enter a password for the user. Reenter it for confirmation (to ensure that you
did not type something else by mistake). The username tells the system who a user is
and the password is used to verify this identity.

WARNING: Username and Password

Remember both your username and the password because they are needed
each time you log in to the system.

To provide effective security, a password should be between five and eight characters
long. The maximum length for a password is 128 characters. However, if no special
security modules are loaded, only the first eight characters are used to discern the
password. Passwords are case-sensitive. Special characters like umlauts are not allowed.
Other special characters (7-bit ASCII) and the digits 0 to 9 are allowed.
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Two additional options are available for local users:

Receive System Messages via E-Mail
Checking this box sends the user messages created by the system services. These
are usually only sent to root, the system administrator. This option is useful for
the most frequently used account, because it is highly recommended to log in as
root only in special cases.

Automatic Login
This option is only available if KDE is used as the default desktop. It automatically
logs the current user into the system when it starts. This is mainly useful if the
computer is operated by only one user.

WARNING: Automatic Login

With the automatic login enabled, the system boots straight into your desktop
with no authentication at all. If you store sensitive data on your system, you
should not enable this option if the computer can also be accessed by others.

Click User Management to create more than one user. Refer to Section 2.9.1, “User
Management” (page 67) for more information about user management.

Configuring the Host as an LDAP Client
To implement user administration by LDAP, configure an LDAP client in the next step.
This section only describes the configuration of the client side. Configuration of an
LDAP server is described in Chapter LDAP—A Directory Service (↑Reference).

Click Use LDAP to enable the use of LDAP. Select Use LDAP but Disable Logins in-
stead if you want to use LDAP for authentication, but do not want other users to log in
to this client. Enter the IP address of the LDAP server to use and the LDAP base DN
to select the search base on the LDAP server. To retrieve the base DN automatically,
click Fetch DN. YaST then checks for any LDAP database on the specified server ad-
dress. Choose the appropriate base DN from the search results given by YaST. If TLS
or SSL protected communication with the server is required, select LDAP TLS/SSL. If
the LDAP server still uses LDAPv2, explicitly enable the use of this protocol version
by selecting LDAP Version 2. Select Start Automounter to mount remote directories
on your client, such as a remotely managed home directory. Click Finish to apply your
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settings. LDAP client configuration is discussed in further detail in Section “The YaST
LDAP Client” (Chapter 25, LDAP—A Directory Service, ↑Reference).

Configuring the Host as a NIS Client
To implement user administration by NIS, configure a NIS client in the next step. This
section only describes the configuration of the client side. Configuration of a NIS
server with YaST is described in Chapter Using NIS (↑Reference).

In the NIS client dialog, first select whether the host has a static IP address or gets one
with DHCP. If you select DHCP, you cannot specify a NIS domain or NIS server ad-
dress, because these are provided by the DHCP server. Information about DHCP is
available in Chapter DHCP (↑Reference). If a static IP address is used, specify the NIS
domain and the NIS server manually.

To search for NIS servers broadcasting in the network, check the relevant option. You
can also specify several NIS domains and set a default domain. For each domain, select
Edit to specify several server addresses or enable the broadcast function on a per-domain
basis.

In the expert settings, use Answer Remote Hosts to allow other network hosts to query
which server your client is using. If you activate Broken Server, responses from servers
on unprivileged ports are also accepted. For more information, refer to the man page
of ypbind.

Configuring the Host as a Windows Domain Member
To implement user administration using a Samba or Windows server, configure a
Samba client in the next step. This section only describes the configuration of the client
side. Samba configuration is described in further detail in Chapter Samba (↑Reference).

In the Windows Domain Membership dialog, enter the NT or Active Directory domain
or Samba workgroup to join or use Browse to select from a list of available domains.
Select Create Home Directory on Login if you want to create home directories for any
user logging in to the domain from your local machine. Click Finish to apply your set-
tings and provide the necessary credentials.
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1.9.7 Cleanup
This step does not require any user interaction. The installation program launches the
SuSEconfig script to write the system configuration. Depending on the CPU and the
amount of memory, this process can take some time.

1.9.8 Release Notes
After completing the user authentication setup, YaST displays the release notes. Reading
them is advised because they contain important up-to-date information that was not
available when the manuals were printed. If you have installed update packages, read
the most recent version of the release notes, as fetched from SUSE Linux's servers.

1.9.9 Hardware Configuration
At the end of the installation, YaST opens a dialog for the configuration of the graphics
card and other hardware components connected to the system, such as printers or sound
cards. Click the individual components to start the hardware configuration. For the most
part, YaST detects and configures the devices automatically.

You can skip any peripheral devices and configure them later. To skip the configuration,
select Skip Configuration and click Next.

However, you should configure the graphics card right away. Although the display
settings as autoconfigured by YaST should be generally acceptable, most users have
very strong preferences as far as resolution, color depth, and other graphics features
are concerned. To change these settings, select the respective item and set the values
as desired. To test your new configuration, click Test the Configuration.

1.9.10 Completing Installation
After a successful installation, YaST shows the Installation Completed dialog. In this
dialog, select whether to clone your newly installed system for AutoYaST. To clone
your system, select Clone This System for AutoYaST. The profile of the current system
is stored in /root/autoyast.xml.
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AutoYaST is a system for installing one or more SUSE Linux systems automatically
without user intervention. AutoYaST installations are performed using a control file
with installation and configuration data.

Finish the installation of SUSE Linux with Finish in the final dialog.

1.10 Graphical Login
SUSE Linux is now installed. Unless you enabled the automatic login function, you
should see the graphical login on your screen where you can enter your username and
password to log in to the system. If automatic login is activated, the desktop starts au-
tomatically.
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2System Configuration with YaST
YaST, the setup tool used for installation, is also the configuration tool for SUSE Linux.
This chapter covers the configuration of your system with YaST. This includes most
of the hardware, the graphical user interface, Internet access, security settings, user
administration, installation of software, system updates, and system information. Both
graphical and text modes of YaST are available and provide the similar functionality.

Configure the system with YaST using various YaST modules. Depending on the
hardware platform and the installed software, there are different ways to access YaST
in the installed system.

In KDE or GNOME, start the YaST Control Center from the main menu. Before YaST
starts, you are prompted to enter the root password, because YaST needs system ad-
ministrator permissions to change the system files.

To start YaST from the command line, enter the commands su (for changing to the
user root) and yast2. To start the text version, enter yast instead of yast2. Also
use the command yast to start the program from one of the virtual consoles.

For hardware platforms that do not support a display device of their own and for remote
administration on other hosts, run YaST remotely. First, open a console on the host on
which to display YaST and enter the command
ssh -X root@<system-to-configure> to log in to the system to configure
as root and redirect the X server output to your terminal. Following the successful
SSH login, enter yast2 to start YaST in graphical mode.
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To start YaST in text mode on another system, use
ssh root@<system-to-configure> to open the connection. Then start YaST
with yast.

To save time, the individual YaST modules can be started directly. To start a module,
enter yast2 module_name. View a list of all module names available on your
system with yast2 -l or yast2 --list. Start the network module, for example,
with yast2 lan.

2.1 YaST Language
To change the language of YaST, select System → Language Selection in the YaST
Control Center. Choose a language, exit the YaST Control Center, log out of the system,
then log in again. The next time you start YaST, the new language setting is used. This
also changes the language for the entire system.

If you need work in a different language but do not want to change the system language
setting, you can temporarily change the LANG variable. To do so, export LANG with
your preferred language. For example, for English, enter the command:
export LANG="en_US"; yast2

This command changes the LANG setting only in your current session. The language
setting of other users and your other sessions, like terminal windows, remains unchanged.

If you run YaST remotely over SSH, YaST uses the language settings of your local
system.

2.2 The YaST Control Center
When you start YaST in the graphical mode, the YaST Control Center, as shown in
Figure 2.1, “The YaST Control Center” (page 31), opens. The left frame contains the
available categories. When you click a category, its contents are listed in the right frame.
Then select the desired module. For example, if you select Hardware and click Sound
in the right frame, a configuration dialog opens for the sound card. The configuration
of the individual items usually consists of several steps. Press Next to proceed to the
following step.
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The left frame of most modules displays the help text, which offers suggestions for
configuration and explains the required entries. To get help in modules without a help
frame, press F1 or choose Help. After selecting the desired settings, complete the
procedure by pressing Accept on the last page of the configuration dialog. The configu-
ration is then saved.

Figure 2.1 The YaST Control Center

2.3 Software

2.3.1 Installing and Removing Software
To install, uninstall, and update software on your machine, use Software → Software
Management. This opens a package manager dialog as shown in Figure 2.2, “YaST
Package Manager” (page 32).
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Figure 2.2 YaST Package Manager

In SUSE Linux, software is available in the form of RPM packages. Normally, a
package contains everything needed for a program: the program itself, the configuration
files, and all documentation. A list of individual packages is displayed to the right in
the individual package window. The content of this list is determined by the currently
selected filter. If, for example, the Selections filter is selected, the individual package
window displays all packages of the current selection.

In the package manager, each package has a status that determines what to do with the
package, such as “Install” or “Delete.” This status is shown by a symbol in a status box
at the beginning of the line. Change the status by clicking or selecting the desired status
from the menu that opens when the item is right-clicked. Depending on the current sit-
uation, some of the possible status flags may not be available for selection. For example,
a package that has not yet been installed cannot be set to “Delete.” View the available
status flags with Help → Symbols.

The font color used for various packages in the individual package window provides
additional information. Installed packages for which a newer version is available on
the installation media are displayed in blue. Installed packages whose version numbers
are higher than those on the installation media are displayed in red. However, because
the version numbering of packages is not always linear, the information may not be
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perfect, but should be sufficient to indicate problematic packages. If necessary, check
the version numbers.

Installing Packages
To install packages, select packages for installation and click Accept. Selected packages
should have the Install status icon . The package manager automatically checks the
dependencies and selects any other required packages (resolution of dependencies). To
view other packages required for installation before clicking Accept, choose Extras →
Show Automatic Package Changes from the main menu. After installing packages,
continue working with the package manager by clicking Install More or close it by
clicking Finish.

The package manager provides preselected groups for installation. You can select an
entire group instead of single packages. To view these groups, use Filter in the left
frame.

TIP: List of All Available Packages

To display all packages on your installation media, use the filter Package Groups
and select zzz All at the bottom of the tree. SUSE Linux contains a number of
packages and it might take some time to display this long list.

The Selections filter groups the program packages according to their application purpose,
such as multimedia or office applications. The various groups of the Selections filter
are listed with the installed packages preselected. Click the status box at the beginning
of a line to install or uninstall this pattern. Select a status directly by right-clicking the
pattern and using the context menu. From the individual package overview to the right,
which displays the packages included in the current pattern, select and deselect individ-
ual packages.

To find language-specific packages, such as translated texts for the user interface of
programs, documentation, and fonts, use the Language filter. This filter shows a list of
all languages supported by SUSE Linux. If you select one of these, the right frame
shows all packages available for this language. Among these, all packages applying to
your current software selection are automatically tagged for installation.
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NOTE

Because language-specific packages may depend on other packages, the package
manager may select additional packages for installation.

Packages and Installation Sources
If you want to find only packages from the specific source, use the Installation Sources
filter. In the default configuration, this filter shows a list of all packages from the selected
source. To restrict the list, use a secondary filter.

To view a list of the all installed packages from the selected installation source, select
the filter Installation Sources then select Installation Summary from Secondary Filters
and deactivate all check boxes except Keep.

The package status in the individual package window can be changed as usual. However,
the changed package may no longer meet the search criteria. To remove such packages
from the list, update the list with Update List.

Installing Source Packages
A package containing the source files for the program is usually available. The sources
are not needed for running the program, but you may want to install the sources to
compile a custom version of the program.

To install sources for selected program, mark the check box in the Source column. If
you cannot see a check box, your installation sources do not contain the source of the
package.

Removing Packages
To remove packages, assign the correct status to the packages to remove and click Ac-
cept. Selected packages should have the Delete status. If a package required by other
installed packages is marked for deletion, the package manager issues an alert with
detailed information and alternative solutions.
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Reinstalling Packages
If you find damaged files that belong to package or you want to reinstall the original
version of a package from your installation media, reinstall the package. To reinstall
packages, select packages for reinstallation and click Accept. Selected packages should
have the Update status . If any dependency issues arise with installed packages, the
package manager issues an alert with detailed information and alternative solutions.

Searching for Packages, Applications, and Files
To find a specific package, use the Search filter. Enter a search string and click Search.
By specifying various search criteria, you can restrict the search to display a few or
even only one package. You can also define special search patterns using wild cards
and regular expressions in Search Mode.

TIP: Quick Search

In addition to the Search filter, all lists of the package manager feature a quick
search. Simply enter a letter to move the cursor to the first package in the list
whose name begins with this letter. The cursor must be in the list (by clicking
the list).

To find a package by name, select Name, enter the name of the package to find in the
search field, and click Search. To find a package by text in the description, select
Summary and Descriptions, enter a search string, and click Search.

To search for the package that contains a certain file, enter the name of the file, select
RPM "Provides", and click Search. To find all packages that depend on a particular
package, select RPM "Requires", enter the name of package, and click Search.

If you are familiar with the package structure of SUSE Linux, you can use the Package
Groups filter to find packages by subject. This filter sorts the program packages by
subjects, such as applications, development, and hardware, in a tree structure to the left.
The more you expand the branches, the more specific the selection is. This means
fewer packages are displayed in the individual package window.
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Installation Summary
After selecting the packages for installation, update, or deletion, view the installation
summary with Installation Summary. It shows how packages will be affected when you
click Accept. Use the check boxes to the left to filter the packages to view in the indi-
vidual package window. For example, to check which packages are already installed,
deactivate all check boxes except Keep.

The package status in the individual package window can be changed as usual. However,
the respective package may no longer meet the search criteria. To remove such packages
from the list, update the list with Update List.

Information about Packages
Get information about the selected package with the tabs in the bottom right frame. If
another version of the package is available, you get information about both versions.

The Description tab with the description of the selected package is automatically active.
To view information about package size, version, installation media, and other technical
details, select Technical Data. Information about provided and required files is in De-
pendencies. To view available versions with their installation sources, click Versions.

Disk Usage
During the selection of the software, the resource window at the bottom left of the
module displays the prospective disk usage of all mounted file systems. The colored
bar graph grows with every selection. As long as it remains green, there is sufficient
space. The bar color slowly changes to red as you approach the limit of disk space. If
you select too many packages for installation, an alert is displayed.

Checking Dependencies
Some packages depend on other packages. This means that the software of the package
only works properly if another package is also installed. There are some packages with
identical or similar functionalities. If these packages use the same system resource, they
should not be installed at the same time (package conflict).
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When the package manager starts, it examines the system and displays installed pack-
ages. When you select to install and remove packages, the package manager automati-
cally checks the dependencies and selects any other required packages (resolution of
dependencies). If you select or deselect conflicting packages, the package manager in-
dicates this and submits suggestions for solving the problem (resolution of conflicts).

Check Dependencies and Autocheck are located under the information window. If you
clickCheck Dependencies, the package manager checks if the current package selection
results in any unresolved package dependencies or conflicts. In the event of unresolved
dependencies, the required additional packages are selected automatically. For package
conflicts, the package manager opens a dialog that shows the conflict and offers various
options for solving the problem.

If you activate Autocheck, any change of a package status triggers an automatic check.
This is a useful feature, because the consistency of the package selection is monitored
permanently. However, this process consumes resources and can slow down the package
manager. For this reason, the autocheck is not activated by default. In either case, a
consistency check is performed when you confirm your selection with Accept.

For example, sendmail and postfixmay not be installed concurrently. Figure 2.3,
“Conflict Management of the Package Manager” (page 38) shows the conflict message
prompting you to make a decision. postfix is already installed. Accordingly, you
can refrain from installing sendmail, remove postfix, or take the risk and ignore
the conflict.

WARNING: Handling Package Conflicts

Unless you are very experienced, follow the suggestions of YaST when handling
package conflicts, because otherwise the stability and functionality of your
system could be endangered by the existing conflict.

System Configuration with YaST 37



Figure 2.3 Conflict Management of the Package Manager

Installing -devel Packages
The package manager provides functions for quick and easy installation of devel and
debug packages. To install all devel packages for your installed system, choose Extras
→ Install All Matching — -devel Packages. To install all debug packages for your in-
stalled system, choose Extras → Install All Matching — -debuginfo Packages.

2.3.2 Installing Add-On Products
Add-on products are extensions for your system. You can install a third party add-on
product or a special extension of your SUSE Linux, for example, the SDK add-on or a
CD with binary drivers. To install a new add-on, use Software → Add-On Product.
You can select various types of product media, like CD, FTP or local directory. You
can work also directly with ISO files. To add an add-on as ISO file media, select Local
Directory then choose ISO Images.

After successfully adding the add-on media, the package manager window appears. If
the add-on provides a new selection , see the new item in the Selections filter. To view
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the list of all packages from the selected installation source, select the filter Installation
Sources and choose the installation source to view. To view packages from a selected
add-on by package groups, select the secondary filter Package Groups.

Binary Drivers
Some hardware needs binary-only drivers for correct function. If you have such hard-
ware, refer to the release notes for more information about availability of binary drivers
for your system. To read the release notes, open YaST and select Miscellaneous →
Release Notes.

2.3.3 Selecting the Installation Source
You can use multiple installation sources of several types. Select them and enable their
use for installation or update using Software → Installation Source. When started, it
displays a list of all previously registered sources. Following a normal installation from
CD, only the installation CD is listed. Click Add to include additional sources in this
list. Sources can be CDs, DVDs, or network sources, such as NFS and FTP servers.
Even directories on the local hard disk can be selected as the installation medium. See
the detailed YaST help text for more details.

All registered sources have an activation status in the first column of the list. Enable
or disable individual installation sources by clicking Activate or Deactivate. During
the installation of software packages or updates, YaST selects a suitable entry from the
list of activated installation sources. When you exit the module with Close, the current
settings are saved and applied to the configuration modules Software Management and
System Update.

2.3.4 Updating Software Online
Install important updates and improvements with YaST Online Update (YOU). The
current patches for your SUSE product are available from the SUSE catalogs. To add
or remove catalogs, use the Software → Installation Source module, described in Sec-
tion 2.3.3, “Selecting the Installation Source” (page 39).
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Find the list of available patches on the left. Patches are sorted by security importance:

Security
You must install these patches. Not installing the patches is a real security hazard.

Recommended
You should install these patches, because your computer could be compromised.

Optional
You can install these patches, but if you do not install them your computer remains
secure.

To install a patch, select it in the list and click Accept. You can select multiple patches.
To cancel your changes, click Cancel.

If you need special settings, for example, if your computer is behind a proxy server,
use the command line tool rug. It is described in Section 2.12, “Update from the Com-
mand Line” (page 76).

2.3.5 Automatic Online Update
Software → Online Update Setup allows you to schedule automatic online updates.
First enable automatic online update by activating Enable Automatic Update then set
the time of the update. If you want to have full control over installed patches, you can
schedule only the download of patches and install patches manually later. To download
patches only, check Only Download Patches.

Some patches need some additional actions, for example, patches for the kernel require
a reboot for activation. Information about the additional actions are provided with pre-
installation information. To use automatic update only for normal patches without
preinstallation information, check Skip Patches with Preinstall Information. Click
Finish to exit the dialog.

2.3.6 Updating from a Patch CD
The Patch CD Update module from the Software section installs patches from CD, not
from an FTP server. The advantage lies in a much faster update with CD. After the
patch CD is inserted, all patches on the CD are displayed in the dialog. Select the desired
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packages for installation from the list of patches. The module issues an error message
if no patch CD is present. Insert the patch CD then restart the module.

2.3.7 Updating the System
Update the version of SUSE Linux installed on your system with Software → System
Update. During operation, you can only update application software, not the base system.
To update the base system, boot the computer from an installation medium, such as
CD. When selecting the installation mode in YaST, select Update.

The procedure for updating the system is similar to a new installation. Initially, YaST
examines the system, determines a suitable update strategy, and presents the results in
a suggestion dialog. Click Change or the individual items to change any details.

Update Options
Set the update method for your system. Two options are available.

Update with Installation of New Software and Features Based on the Selection
To update the entire system to the latest versions of software, select one of the
predefined selections. These selections ensure that packages that did not exist pre-
viously are also installed.

Only Update Installed Packages
This option merely updates packages that already exist on the system. No new
features are installed.

Additionally, you can use Delete Outdated Packages to remove packages that do not
exist in the new version. By default, this option is preselected to prevent outdated
packages from unnecessarily occupying hard disk space.

Packages
Click Packages to start the package manager and select or deselect individual packages
for update. Any package conflicts should be resolved with the consistency check. The
use of the package manager is covered in detail in Section 2.3.1, “Installing and Remov-
ing Software” (page 31).
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Backup
During the update, the configuration files of some packages may be replaced by those
of the new version. Because you may have modified some of the files in your current
system, the package manager normally makes backup copies of the replaced files. With
this dialog, determine the scope of these backups.

IMPORTANT: Scope of the Backup

This backup does not include the software. It only contains configuration files.

Language
Primary and other languages currently installed on the system are listed here. Change
them by clicking Language in the displayed configuration or withChange→ Language.
Optionally, adapt the keyboard layout and time zone to the region where the primary
language is spoken. Find more about language selection in Section 2.5.14, “Language
Selection” (page 59).

Important Information about Updates
The system update is a very complex procedure. For each program package, YaST must
first check which version is installed on the computer then determine what needs to be
done to replace the old version with the new version correctly. YaST also tries to adopt
any personal settings of the installed packages.

In most cases, YaST replaces old versions with new ones without problems. A backup
of the existing system should be performed prior to updating to ensure that existing
configurations are not lost during the update. Conflicts can then be resolved manually
after the update has finished.

2.3.8 Checking Media
If you encounter any problems using the SUSE Linux installation media, you can check
the CDs or DVDs with Software → Media Check. Media problems are more likely to
occur with media you burn yourself. To check that a SUSE Linux CD or DVD is error-
free, insert the medium into the drive and run this module. Click Start for YaST to
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check the MD5 checksum of the medium. This may take several minutes. If any errors
are detected, you should not use this medium for installation.

2.3.9 Registering SUSE Linux
The registration and activation of your product is a precondition for technical support
and product updates. If you skipped the registration during installation, you can register
later with the help of the Product Registration module from Software. Before you start
registration, prepare your contact e-mail and registration key.

In Include for Convenience, select whether to obtain some of the necessary information
from your system. This simplifies the registration process. If you want to see what is
required to register your system or what happens with your data, use Details.

2.4 Hardware
New hardware must first be installed or connected as directed by the vendor. Turn on
external devices, such as the printer or the modem, and start the appropriate YaST
module. Most devices are automatically detected by YaST and the technical data is
displayed. If the automatic detection fails, YaST offers a list of devices (model, vendor,
etc.) from which to select the suitable device. Consult the documentation enclosed with
your hardware for more information.

IMPORTANT: Model Designations

If your model is not included in the device list, try a model with a similar des-
ignation. However, in some cases the model must match exactly, because sim-
ilar designations do not always indicate compatibility.

2.4.1 Bluetooth
Configure Bluetooth devices with Hardware → Bluetooth. Click Enable Bluetooth
Services to begin configuration. Bluetooth configuration is covered in detail in Section
“Configuring Bluetooth with YaST” (Chapter 34,Wireless Communication, ↑Reference).
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2.4.2 Infrared Device
Configure an infrared device with Hardware → Infrared Device. Click Start IrDa to
begin configuration. You can configurePort and Limit Baud Rate here. Find information
about infrared devices in Section “Infrared Data Transmission” (Chapter 34, Wireless
Communication, ↑Reference).

2.4.3 Graphics Card and Monitor
Configure graphics cards and monitors with Hardware → Graphics Card andMonitor.
It uses the the SaX2 interface, described in Section 2.13, “SaX2” (page 79).

2.4.4 Printer
Configure a printer with Hardware → Printer. If a printer is properly connected to the
system, it should be detected automatically. Find detailed instructions for configuring
printers with YaST in Section “Configuring the Printer” (Chapter 11, Printer Operation,
↑Reference).

2.4.5 Hard Disk Controller
Normally, the hard disk controller of your system is configured during the installation.
If you add controllers, integrate these into the system withHardware→Disk Controller.
You can also modify the existing configuration, but this is generally not necessary.

The dialog presents a list of detected hard disk controllers and enables assignment of
the suitable kernel module with specific parameters. Use Test Loading of Module to
check if the current settings work before they are saved permanently in the system.

WARNING: Configuration of the Hard Disk Controller

This is an expert tool. Your system may no longer boot if you make incorrect
settings. If you make changes, use the test option.
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2.4.6 Hardware Information
Display detected hardware and technical data usingHardware→Hardware Information.
Click any node of the tree for more information about a device. This module is especially
useful, for example, when submitting a support request for which you need information
about your hardware.

Save the hardware information displayed to a file by clicking Save to File. Select the
desired directory and filename then click Save to create the file.

2.4.7 IDE DMA Mode
Activate and deactivate the DMA mode for your IDE hard disks and your IDE CD and
DVD drives in the installed system with Hardware → IDE DMA Mode. This module
does not have any effect on SCSI devices. DMA modes can substantially increase the
performance and data transfer speed in your system.

During installation, the current SUSE Linux kernel automatically activates DMA for
hard disks but not for CD drives, because default DMA activation for all drives often
causes problems with CD drives. Use the DMA module to activate DMA for your
drives. If the drive supports the DMA mode without any problems, the data transfer
rate of your drive can be increased by activating DMA.

NOTE

DMA (direct memory access) means that your data can be transferred directly
to the RAM, bypassing the processor control.

2.4.8 Joystick
Configure a joystick connected to the sound card with Hardware → Joystick. Select
your joystick type in the list provided. If your joystick is not listed, select Generic
Analog Joystick. After selecting your joystick, make sure that it is connected then click
Test to test the functionality. Click Continue and YaST installs the required files. After
the Joystick Test window appears, test the joystick by moving it in all directions and
pressing all buttons. Each movement should be displayed in the window. If you are
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satisfied with the settings, click OK to return to the module and Finish to complete
configuration.

If you have a USB device, this configuration is not necessary. Plug in the joystick and
start using it.

2.4.9 Keyboard Layout
To configure the keyboard for the console, run YaST in text mode then use Hardware
→ Keyboard Layout. After clicking the module, the current layout is displayed. To
choose another keyboard layout, select the desired layout from the list provided. Test
the layout in Test by pressing keys on the keyboard.

Fine-tune the settings by clicking Expert Settings. You can adjust the key repeat rate
and delay and configure the start-up state by choosing the desired settings in Start-Up
States. For Devices to Lock, enter a space-separated list of devices to which to apply
the Scroll Lock , Num Lock , and Caps Lock settings. ClickOK to complete the fine-tuning.
Finally, after all selections have been made, click Accept for your changes to take effect.

To set up the keyboard for the graphical environment, run the graphical YaST then select
Keyboard Layout. Find information about the graphical configuration in Section 2.13.3,
“Keyboard Properties” (page 84).

2.4.10 Mouse Model
When configuring the mouse for the graphical environment, clickMouseModel to access
the SaX2 mouse configuration. Refer to Section 2.13.2, “Mouse Properties” (page 83)
for details.

To configure your mouse for the text environment, use YaST in text mode. After entering
text mode and selecting Hardware → Mouse Model, use the keyboard arrow keys to
choose your mouse from the provided list. Then click Accept to save the settings and
exit the module.
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2.4.11 Scanner
Connect and turn on your scanner then select Hardware → Scanner to configure it.
Most supported scanners are detected automatically. Select the scanner to configure
and click Edit. If your scanner is not listed, click Add to open the manual configuration
dialog. Select the appropriate vendor and model from the list and click Next to proceed
with the installation. To modify a configured scanner, select it then click Edit.

After the scanner has been determined by either automatic detection or user selection,
installation is carried out. Click Finish to complete the installation. If the installation
is successful, a corresponding message appears. To test your scanner after installation,
insert a document into your scanner and click Other → Test.

Scanner Not Detected
Only supported scanners can be detected automatically. Scanners connected to another
network host cannot be detected. The manual configuration distinguishes three types
of scanners: USB scanners, SCSI scanners, and network scanners.

USB Scanner
After the scanner is selected, YaST attempts to load the USB modules. If your
scanner is very new, the modules may not be loaded automatically. In this case,
continue automatically to a dialog in which to load the USB module manually.
Refer to the YaST help text for more information.

SCSI Scanner
SCSI devices are normally detected. Specify the device, such as /dev/sg0. If
problems arise, refer to the YaST help text. Remember always to shut down the
system before connecting or disconnecting a SCSI scanner.

Network Scanner
Enter the IP address or the hostname. To configure a network scanner, refer to the
database article Scanning in Linux (http://en.opensuse.org/SDB:SDB).

If your scanner is not detected, the device is probably not supported. However, some-
times even supported scanners are not detected. If this is the case, proceed with the
manual scanner selection. If you can identify your scanner in the list of vendors and
models, select it. If not, select Cancel. Information about scanners that work with Linux
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is provided at http://cdb.suse.de/ and http://www.sane-project
.org/.

WARNING: Assigning a Scanner Manually

Assign the scanner manually only if you are absolutely sure. An incorrect selec-
tion could damage your hardware.

Troubleshooting
Your scanner may not have been detected for one of the following reasons:

• The scanner is not supported. Checkhttp://cdb.suse.de/ for a list of Linux-
compatible devices.

• The SCSI controller was not installed correctly.

• There were termination problems with your SCSI port.

• The SCSI cable is too long.

• The scanner has a SCSI light controller that is not supported by Linux.

• The scanner is defective.

WARNING

SCSI scanners should not be connected or disconnected while the system is
running. Shut the system down first.

2.4.12 TV and Radio Cards
Configure TV and radio cards with Hardware → TV Card. If your card was automati-
cally detected, it is displayed in the list. In this case, select the card and click Edit. If
your card was not detected, click Add. If you have already configured TV or radio cards,
select a card to modify then click Edit.

During the automatic hardware detection, YaST attempts to assign the correct tuner to
your card. If you are not sure, simply keep the setting Default (recognized) and check
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whether it works. If you cannot set all channels, click Select Tuner and select the correct
tuner type from the list.

If you are familiar with the technical details, you can use the expert dialog to make
settings for a TV or radio card. Select a kernel module and its parameters in this dialog.
Also check all parameters of your TV card driver. To do this, select the respective pa-
rameters and enter the new value in the parameter line. Confirm the new values with
Apply or restore the default values with Reset.

Configure audio settings if your TV or radio card is connected to the installed sound
card. Make the connection with a cable from output of the TV or radio card to the ex-
ternal audio input of the sound card. If you have not yet configured your sound card,
select Configure Sound Card to configure it as described in Section 2.4.13, “Sound”
(page 49).

If your TV or radio card has speaker jacks, you can also connect the speakers directly
without using the sound card. There are also TV cards without any sound function,
which do not require an audio configuration, such as those for CCD cameras.

When editing a configuration, you can also configure the TV stations by clicking TV
Channel. Set the proper TV Standard and Frequency Table for your area and click Scan
the Channels. A list of stations appears. After scanning has been completed, click OK
to return to the configuration dialog.

2.4.13 Sound
Use Hardware → Sound to configure a sound card. Most sound cards are detected au-
tomatically and listed. Select the one to configure or modify then click Edit. Use Delete
to remove a sound card. This deactivates existing entries of configured sound cards in
/etc/modprobe.d/sound.

ClickOther to open a dialog in which to customize the sound module options manually.
With Add, configure additional sound cards. If YaST detects another sound card, select
it then use Edit.

The volume and configuration of all sound cards installed are saved when you click
Finish. The mixer settings are saved to the file /etc/asound.conf and the ALSA
configuration data is appended at the end of the files /etc/modprobe.d/sound
and /etc/sysconfig/hardware.
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If YaST is unable to detect your sound card automatically, proceed as follows:

1 Click Add to open a dialog in which to select a sound card vendor and model.
Refer to your sound card documentation for the information required. Find a
reference list of sound cards supported by ALSA with their corresponding sound
modules in /usr/share/doc/packages/alsa/cards.txt and at
http://www.alsa-project.org/~goemon/. After making your selec-
tion, click Next.

2 In Setup Dialog, choose the configuration level in the first setup screen. With
Quick Automatic Setup, you are not required to go through any of the further
configuration steps and no sound test is performed. The sound card is configured
automatically. With Normal Setup, you can adjust the output volume and play a
test sound. Advanced setup with possibility to change options allows you to
customize the sound card options manually.

In this dialog, there is also a shortcut to joystick configuration. Click it and select
the joystick type in the following dialog. Click Next to continue.

3 In Sound Card Volume, test your sound configuration and make adjustments to
the volume. You should start at about ten percent to avoid damage to your
speakers or hearing. A test sound should be audible when you click Test. If you
cannot hear anything, increase the volume. PressContinue to complete the sound
configuration. The volume setting is then saved.

If you use aCreative Soundblaster Live orAWE sound card, copy SF2 sound
fonts to your hard disk from the original Soundblaster driver CD-ROM with Install
Sound Fonts. The sound fonts are saved in the directory /usr/share/sfbank/
creative/.

For playback of MIDI files, check Start Sequencer. This way, the modules for sequencer
support are loaded along with the sound modules.

2.5 System
This group of modules is designed to help you manage your system. All modules in
this group are system-related and serve as valuable tools for ensuring that your system
runs properly and your data is managed efficiently.
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2.5.1 Backup
Create a backup of both your system and data using System→ System Backup. However,
the backup created by the module does not include the entire system. The system is
backed up by saving important storage areas on your hard disk that may be crucial when
trying to restore a system, such as the partition table or master boot record (MBR).
Data is backed up by saving changed files of packages accessible on installation media,
entire packages that are unaccessible (such as online updates), and files not belonging
to packages, such as many of the configuration files in /etc or the directories under
/home.

2.5.2 Restoration
With System → System Restoration, restore your system from a backup archive created
with System Backup. First, specify where the archives are located (removable media,
local hard disks, or network file systems). ClickNext to view the description and contents
of the individual archives and select what to restore from the archives.

You can also uninstall packages that were added since the last backup and reinstall
packages that were deleted since the last backup. These two steps enable you to restore
the exact system state at the time of the last backup.

WARNING: System Restoration

Because this module normally installs, replaces, or uninstalls many packages
and files, use it only if you have experience with backups. Otherwise you may
lose data.

2.5.3 Boot and Rescue Disks
Create boot and rescue disks with System→ Boot or Rescue Floppy. These floppy disks
are helpful if the boot configuration of your system is damaged. The rescue disk is es-
pecially necessary if the file system of the root partition is damaged.

The following options are available:
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Standard Boot Floppy
Use this option to create the standard boot floppies with which to boot an installed
system. Depending on the architecture, the actual number of boot disks may vary,
but you should create all the boot disks presented in the dialog because all these
disks are necessary for booting. They are also needed for starting the rescue system.

Rescue Floppy
This disk contains a special environment that allows you to perform maintenance
tasks in your installed system, such as checking and repairing the file system and
updating the boot loader. To start the rescue system, boot with the standard boot
disks then select Manual Installation → Start Installation or System → Rescue
System. Insert the rescue disk when prompted.

Custom Floppy
Use this to write any existing floppy disk image from the hard disk to a floppy disk.

Download Floppy Image
With this, enter a URL and authentication data to download a floppy disk image
from the Internet.

To create one of these floppy disks, select the corresponding option and click Next.
Insert a floppy disk when prompted. Click Next again to create the floppy disk.

2.5.4 Boot Loader Configuration
To configure booting for systems installed on your computer, use the System → Boot
Loader module. A detailed description of how to configure the boot loader with YaST
is available in Section “Configuring the Boot Loader with YaST” (Chapter 9, The Boot
Loader, ↑Reference).

2.5.5 LVM
The logical volume manager (LVM) is a tool for custom partitioning of hard disks with
logical drives. Find information about LVM in Section “LVM Configuration” (Chapter 2,
Advanced Disk Setup, ↑Reference).
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2.5.6 Partitioner
With the expert dialog, shown in Figure 2.4, “The YaST Partitioner” (page 53), manu-
ally modify the partitioning of one or several hard disks. Partitions can be added,
deleted, resized, and edited. Also access the soft RAID and LVM configuration from
this YaST module.

WARNING

Although it is possible to modify the partitions in the installed system, this
should be handled only by experts. Otherwise the risk of making a mistake that
causes data loss is very high. If you repartition a hard disk in use, reboot the
system right afterwards. It is safer to use the rescue system than repartition
the system while running.

Figure 2.4 The YaST Partitioner

All existing or suggested partitions on all connected hard disks are displayed in the list
of the YaST Expert Partitioner dialog. Entire hard disks are listed as devices without
numbers, such as /dev/hda or /dev/sda. Partitions are listed as parts of these de-
vices, such as /dev/hda1 or /dev/sda1. The size, type, file system, and mount
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point of the hard disks and their partitions are also displayed. The mount point describes
where the partition appears in the Linux file system tree.

If you run the expert dialog during installation, any free hard disk space is also listed
and automatically selected. To provide more disk space to SUSE Linux, free the needed
space starting from the bottom toward the top of the list (starting from the last partition
of a hard disk toward the first). For example, if you have three partitions, you cannot
use the second exclusively for SUSE Linux and retain the third and first for other oper-
ating systems.

Creating a Partition
Select Create. If several hard disks are connected, a selection dialog appears in which
to select a hard disk for the new partition. Then, specify the partition type (primary or
extended). Create up to four primary partitions or up to three primary partitions and
one extended partition. Within the extended partition, create several logical partitions
(see Section “Partition Types” (page 9)).

Select the file system to use and a mount point, if necessary. YaST suggests a mount
point for each partition created. Details of the parameters are provided in the next section.
Select OK to apply your changes. The new partition is then listed in the partition table.
If you clickNext, the current values are adopted. During installation you are then returned
to the suggestion screen.

Partitioning Parameters
When you create a new partition or modify an existing partition, set various parameters.
For new partitions, suitable parameters are set by YaST and usually do not require any
modification. To perform manual settings, proceed as follows:

1. Select the partition.

2. Click Edit to edit the partition and set the parameters:

File System ID
Even if you do not want to format the partition at this stage, assign it a file
system ID to ensure that the partition is registered correctly. Possible values
include Linux, Linux swap, Linux LVM, and Linux RAID. For LVM and
RAID details, refer to Section “LVM Configuration” (Chapter 2, Advanced
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Disk Setup, ↑Reference) and Section “Soft RAID Configuration” (Chapter 2,
Advanced Disk Setup, ↑Reference).

File System
To format the partition immediately within the scope of the installation,
specify one of the following file systems for the partition: Swap, Ext2, Ext3,
ReiserFS, or JFS. Refer to Chapter File Systems in Linux (↑Reference) for
details on the various file systems.

Swap is a special format that allows the partition to be used as virtual
memory. ReiserFS is the default file system for the Linux partitions. Reiser-
FS, JFS, and Ext3 are journaling file systems. These file systems are able
to restore the system very quickly after a system crash, because write pro-
cesses are logged during the operation. Furthermore, ReiserFS is very fast
in handling lots of small files. Ext2 is not a journaling file system. However,
it is rock solid and good for smaller partitions, because it does not require
much disk space for management.

File System Options
Set various parameters for the selected file system here. Depending on the
file system used, various options are offered for experts.

Encrypt File System
If you activate the encryption, all data is written to the hard disk in encrypted
form. This increases the security of sensitive data, but slightly reduces the
system speed, because the encryption takes some time. More information
about the encryption of file systems is provided in Section “Encrypting
Partitions and Files” (Chapter 4, Security in Linux, ↑Reference).

Fstab Options
Here, specify various parameters for the administration file of the file systems
(/etc/fstab).

Mount Point
Specifies the directory at which the partition should be mounted in the file
system tree. Select from various YaST proposals or enter any other name.

3. Select Next to activate the partition.
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If you partition manually, create a swap partition of at least 256 MB. The swap partition
is used to free the main memory of data that is not used at the present moment. This
keeps the main memory free for the most frequently-used important data.

Expert Options
Expert opens a menu containing the following commands:

Reread Partition Table
Rereads the partitioning from disk. For example, you need this after manual parti-
tioning in the text console.

Delete Partition Table and Disk Label
This completely overwrites the old partition table. For example, this can be helpful
if you have problems with unconventional disk labels. Using this method, all data
on the hard disk is lost.

More Partitioning Tips
If the partitioning is performed by YaST and other partitions are detected in the system,
these partitions are also entered in the file /etc/fstab to enable easy access to this
data. This file contains all partitions in the system with their properties, such as the file
system, mount point, and user permissions.

Example 2.1 /etc/fstab: Partition Data
/dev/sda1    /data1    auto      noauto,user 0 0
/dev/sda5    /data2    auto      noauto,user 0 0 
/dev/sda6    /data3    auto      noauto,user 0 0

The partitions, regardless of whether they are Linux or FAT partitions, are specified
with the options noauto and user. This allows any user to mount or unmount these
partitions as needed. For security reasons, YaST does not automatically enter the exec
option here, which is needed for executing programs from the location. However, to
run programs from there, you can enter this option manually. This measure is necessary
if you encounter system messages such as bad interpreter or Permission denied.
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Partitioning and LVM
From the expert partitioner, access the LVM configuration with LVM (see Section “LVM
Configuration” (Chapter 2, Advanced Disk Setup, ↑Reference)). However, if a working
LVM configuration already exists on your system, it is automatically activated as soon
as you enter the LVM configuration for the first time in a session. In this case, any disks
containing a partition belonging to an activated volume group cannot be repartitioned
because the Linux kernel cannot reread the modified partition table of a hard disk when
any partition on this disk is in use. However, if you already have a functioning LVM
configuration on your system, physical repartitioning should not be necessary. Instead,
change the configuration of the logical volumes.

At the beginning of the physical volumes (PVs), information about the volume is written
to the partition. To reuse such a partition for other non-LVM purposes, it is advisable
to delete the beginning of this volume. For example, in the VG system and PV /dev/
sda2, do this with the command dd if=/dev/zero of=/dev/sda2 bs=512
count=1.

WARNING: File System for Booting

The file system used for booting (the root file system or /boot) must not be
stored on an LVM logical volume. Instead, store it on a normal physical partition.

2.5.7 PCI Device Drivers
Each kernel driver contains a list of device IDs of all devices it supports. If a new device
is not in any driver's database, the device is treated as unsupported, even if it can be
used with an existing driver. With this YaST module from System section, you can add
PCI IDs. Only advanced users should attempt to use this YaST module.

To add an ID, click Add and select how to assign it: by selecting a PCI device from a
list or by manually entering PCI values. In the first option, select the PCI device from
the provided list then enter the driver or directory name. If the directory is left empty,
the driver name is used as the directory name. When assigning PCI ID values manually,
enter the appropriate data to set up a PCI ID. Click OK to save your changes.
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To edit a PCI ID, select the device driver from the list and click Edit. Edit the information
and click OK to save your changes. To delete an ID, select the driver and click Delete.
The ID immediately disappears from the list. When finished, click OK.

2.5.8 Power Management
The System → Power Management module helps you work with saving energy tech-
nologies. It is especially important on laptops to extend their operational time. Find
detailed information about using this module in Section “The YaST Power Management
Module” (Chapter 33, Power Management, ↑Reference).

2.5.9 Powertweak Configuration
Powertweak is a SUSE Linux utility for tweaking your system to peak performance by
tuning some kernel and hardware configurations. It should be used only by advanced
users. After starting it with System → Powertweak, it detects your system settings and
lists them in tree form in the left frame of the module. You can also use Search to find
a configuration variable. Select the option to tweak to display it on the screen along
with its directory and settings. To save the settings, click Finish then confirm it by
clicking OK.

2.5.10 Profile Manager
Create, manage, and switch among system configurations with System → Profile
Management, the YaST system configuration profile management (SCPM) module.
This is especially useful for mobile computers that are used in different locations (in
different networks) and by different users. Nevertheless, this feature is useful even for
stationary machines, because it enables the use of various hardware components or test
configurations. For more information about SCPM basics and handling, refer to Chap-
ter System Configuration Profile Management (↑Reference).

2.5.11 System Services (Runlevel)
Configure runlevels and the services that start in them with System → System Services
(Runlevel). For more information about the runlevels in SUSE Linux and a description
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of the YaST runlevel editor, refer to Section “Configuring System Services (Runlevel)
with YaST” (Chapter 8, Booting and Configuring a Linux System, ↑Reference).

2.5.12 /etc/sysconfig Editor
The directory /etc/sysconfig contains the files with the most important settings
for SUSE Linux. Use System → /etc/sysconfig Editor to modify the values and save
them to the individual configuration files. Generally, manual editing is not necessary,
because the files are automatically adapted when a package is installed or a service is
configured. More information about/etc/sysconfig and the YaST sysconfig editor
is available in Section “Changing the System Configuration Using the YaST sysconfig
Editor” (Chapter 8, Booting and Configuring a Linux System, ↑Reference).

2.5.13 Time and Date Configuration
The time zone is initially set during installation, but you can change it with System →
Date and Time. Also use this to change the current system date and time.

To change the time zone, select the region in the left column and the location or time
zone in the right column. With Hardware Clock Set To, set whether the system clock
should use Local Time or UTC (Coordinated Universal Time). UTC is often used in
Linux systems. Machines with additional operating systems, such as Microsoft Windows,
mostly use local time.

Set the current system time and date with Change. In the dialog that opens, modify the
time and date by entering new values or adjusting them with the arrow buttons. Press
Apply to save the changes.

2.5.14 Language Selection
The primary and secondary languages for your system are set during installation.
However, they can be changed at any time using System → Language. The primary
language set in YaST applies to the entire system, including YaST and the desktop en-
vironment. This is the language you expect to use most of the time. Secondary languages
are languages that are sometimes needed by users for a variety of purposes, such as
desktop language or word processing.
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Figure 2.5 Setting the Language

Select the main language to use for your system in Primary Language. To adjust the
keyboard or time zone to this setting, enable Adapt Keyboard Layout or Adapt Time
Zone.

Set how locale variables are set for the root user with Details. Also use Details to set
the primary language to a dialect not available in the main list. These settings are written
into the file /etc/sysconfig/language.

2.6 Network Devices
All network devices connected to the system must be initialized before they can be used
by a service. The detection and configuration of these devices is done in the module
group Network Devices.

2.6.1 DSL, ISDN, Modem, or Network Card
To configure a DSL, ISDN, or network interface or a modem, select the appropriate
module from the Network Devices section. For a device that is detected automatically,
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select it from the list then click Edit. If your device has not been detected, click Add
and select it manually. To edit an existing device, select it then click Edit. For more
detailed information, see Section “Configuring a Network Connection with YaST”
(Chapter 18, Basic Networking, ↑Reference). For wireless network interfaces, see
Chapter Wireless Communication (↑Reference).

TIP: CDMA and GPRS Modems

You can configure supported CDMA and GPRS modems as regular modems in
the YaST modem module.

2.6.2 Fax
Configure a fax system with Network Devices → Fax. Set up the fax system for one or
more users, but each user must have a unique fax number. When adding or editing
users, configure the username, fax numbers, outgoing MSN, station ID, headline, and
desired action.

2.6.3 Phone Answering Machine
Configure your SUSE Linux system to function as a telephone answering machine with
Network Devices → Phone Answering Machine. Configure it for one or more users,
but each user must have a unique telephone number. When adding or editing users,
configure the username, telephone numbers, delay, duration, and desired action. Assign
a PIN (personal identification number) to provide the user with remote access to the
machine.

2.7 Network Services
This group contains tools to configure all kinds of services in the network. These include
name resolution, user authentication, and file services.
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2.7.1 Mail Transfer Agent
You can configure your mail settings in Network Services → Mail Transfer Agent if
you send your e-mail with sendmail, postfix, or the SMTP server of your provider. You
can fetch mail via the fetchmail program, for which you can also enter the details of
the POP3 or IMAP server of your provider. Alternatively, use a mail program of your
choice, such as KMail or Evolution, to set your access data. In this case, you do not
need this module.

To configure your mail with YaST, specify the type of your connection to the Internet
in the first dialog. Choose one of the following options:

Permanent
Select this option if you have a dedicated line to the Internet. Your machine is online
permanently, so no dial-up is required. If your system is part of a local network
with a central e-mail server, select this option to ensure permanent access to your
e-mail messages.

Dial-Up
This item is relevant for users who have a computer at home, are not located in a
network, and occasionally connect to the Internet.

No Connection
If you do not have access to the Internet and are not located in a network, you
cannot send or receive e-mail.

Activate virus scanning for your incoming and outgoing e-mail with AMaViS by select-
ing that option. The package is installed automatically as soon as you activate the mail
filtering feature. In the following dialogs, specify the outgoing mail server (usually the
SMTP server of your provider) and the parameters for incoming mail. Set the diverse
POP or IMAP servers for mail reception by various users. Using this dialog, you can
also assign aliases, use masquerading, or set up virtual domains. Click Finish to exit
the mail configuration.
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2.7.2 Other Available Services
Many other network modules are available in YaST Network Services.

DHCP Server
Use this to set up a custom DHCP server in only a few steps. Chapter DHCP
(↑Reference) provides basic knowledge about the subject and a step-by-step descrip-
tion of the configuration process.

DNS Server
Configuring a DNS server that is responsible for name resolution is recommended
for larger networks. You can use DNS Server for this as described in Section “Con-
figuration with YaST” (Chapter 20, The Domain Name System, ↑Reference).
Chapter The Domain Name System (↑Reference) provides background information
about DNS.

DNS and Hostname
Use this module to configure the hostname and DNS if these settings were not al-
ready made while configuring the network devices. Also use it to change the host-
name and domain name. If the provider has been configured correctly for DSL,
modem, or ISDN access, the list of name servers contains the entries that were ex-
tracted automatically from the provider data. If you are located in a local network,
you might receive your hostname via DHCP, in which case you should not modify
the name.

HTTP Server
To run your own Web server, configure Apache in HTTP Server. Find more infor-
mation in Chapter The Apache HTTP Server (↑Reference).

Hostnames
When booting and in small networks, you can use Hostnames for hostname resolu-
tion instead of DNS. The entries in this module reflect the data of the file /etc/
hosts. For more information, read Section “ /etc/hosts ” (Chapter 18, Basic
Networking, ↑Reference).

Kerberos Client
If you have a Kerberos server in your network for network authentication, use
Kerberos Client.
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LDAP Client
If using LDAP for user authentication in the network, configure the client in LDAP
Client. Information about LDAP and a detailed description of the client configuration
with YaST are available in Section “The YaST LDAP Client” (Chapter 25,
LDAP—A Directory Service, ↑Reference).

NFS Client
With NFS client, mount directories provided by NFS server in your own file trees.
Use NFS Client to configure your system to access an NFS server in the network.
A description of the YaST module and background information about NFS are
provided in Chapter Sharing File Systems with NFS (↑Reference).

NFS Server
With NFS, run a file server that all members of your network can access. This file
server can be used to make certain applications, files, and storage space available
to users. InNFS Server, you can configure your host as an NFS server and determine
the directories to export for general use by the network users. All users with the
appropriate permissions can mount these directories in their own file trees. A de-
scription of the YaST module and background information about NFS are provided
in Chapter Sharing File Systems with NFS (↑Reference).

NIS Client
If you run NIS server to administer user data on a central place and distribute it to
the clients, configure the client here. Detailed information about NIS client and
configuration with YaST is available in Section “Configuring NIS Clients”
(Chapter 21, Using NIS, ↑Reference).

NIS Server
If you run more than one system, local user administration (using the files /etc/
passwd and /etc/shadow) is impractical and requires a lot of maintenance.
In this case, administer user data on a central server and distribute it to the clients
from there. NIS is one option for this. Detailed information about NIS and its
configuration with YaST is available in Section “Configuring a NIS Master Server”
(Chapter 21, Using NIS, ↑Reference).

NTP Client
NTP (network time protocol) is a protocol for synchronizing hardware clocks over
a network. Information about NTP and instructions for configuring it with YaST
are available in Chapter Time Synchronization with NTP (↑Reference).
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Network Services (xinetd)
Configure the network services (such as finger, talk, and ftp) to start when SUSE
Linux boots usingNetwork Services. These services enable external hosts to connect
to your computer. Various parameters can be configured for every service. By de-
fault, the master service that manages the individual services (inetd or xinetd) is
not started.

When this module starts, choose whether to start inetd or xinetd. The selected
daemon can be started with a standard selection of services. Alternatively, compose
your own selection of services with Add, Delete, and Edit.

WARNING: Configuring Network Services (xinetd)

The composition and adjustment of network services on a system is a
complex procedure that requires a comprehensive understanding of the
concept of Linux services. The default settings are usually sufficient.

Proxy
Configure Internet proxy client settings in Proxy. Click Enable Proxy then enter
the desired proxy settings. You can test these settings by clicking Test Proxy Set-
tings. A small window informs you whether your proxy settings work correctly.
After your settings have been entered and tested, save them by clicking Accept.

Remote Administration
To administer your machine remotely from another machine, use Remote Adminis-
tration. To maintain your system remotely, use a VNC client, such as krdc, or a
Java-enabled browser. Although remote administration using VNC is simple and
fast, it is less secure than using SSH, so you should always keep this in mind when
using a VNC server. Find detailed information about installing with a VNC client
in Section “Simple Remote Installation via VNC—Static Network Configuration”
(Chapter 1, Remote Installation, ↑Reference).

Allow remote administration by selecting Allow Remote Administration in Remote
Administration Settings. Selecting Do Not Allow Remote Administration disables
this function. Click Open Port in Firewall to allow access to your computer.
ClickingFirewall Details displays network interfaces with open ports in the firewall.
Select the desired interface and click OK to return to the main dialog. Click Accept
to complete the configuration.
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The YaST Remote Administration module is highly recommended for configuring
VNC on your machine. Although the SaX2 interface also allows you to set remote
access properties, it is not a substitute for YaST. It only enables you to configure
your X server as a host for VNC sessions. For more information, refer to Sec-
tion 2.13.6, “Remote Access Properties” (page 85).

Routing
Use Routing to configure the paths data takes over the network. In most cases, only
enter the IP address of the system through which to send all data inDefault Gateway.
To create more complicated configurations, use Expert Configuration.

Samba Server
In a heterogeneous network consisting of Linux and Windows hosts, Samba controls
the communication between the two worlds. Information about Samba and the
configuration of servers is provided in Chapter Samba (↑Reference).

Windows Domain Membership
In a heterogeneous network consisting of Linux and Windows hosts, Samba controls
the communication between the two worlds. With the Samba Client module, you
can configure your computer as member of a Windows domain. Find information
about Samba and the configuration of clients in Chapter Samba (↑Reference).

2.8 AppArmor
Novell AppArmor is designed to provide easy-to-use application security for both
servers and workstations. Novell AppArmor is an access control system that lets you
specify which files each program may read, write, and execute. To enable or disable
Novell AppArmor on your system, use AppArmor Control Panel. Information about
Novell AppArmor and a detailed description of the configuration with YaST are
available in Novell AppArmor 2.0 Administration Guide (↑Novell AppArmor 2.0 Ad-
ministration Guide).

2.9 Security and Users
A basic aspect of Linux is its multiuser capability. Consequently, several users can
work independently on the same Linux system. Each user has a user account identified
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by a login name and a personal password for logging in to the system. All users have
their own home directories where personal files and configurations are stored.

2.9.1 User Management
Create and edit users with Security and Users → User Management. It provides an
overview of users in the system, including NIS, LDAP, Samba, and Kerberos users if
requested. If you are part of an extensive network, click Set Filter to list all users cate-
gorically (for example, root or NIS users). You can also customize filter settings by
clicking Customize Filter.

To add new users, click Add and enter the appropriate data. Complete the addition by
clicking Accept. The new user can immediately log in using the newly created login
name and password.

TIP: Autologin

If you are the only user of your system, you can configure autologin. Autologin
automatically logs a user into the system after it starts. To activate autologin,
select the user from the list of users and click Login Settings. Then choose Au-
tologin and click OK.

Disable user login with the corresponding option. Fine-tune user profiles in Details.
Here, manually set the user ID, home directory, default login shell, and assign the new
user to specific groups. Configure the validity of the password in Password Settings.
Click Accept to save all changes.

To delete a user, select the user from the list and click Delete. Then mark whether to
delete the home directory and click Yes to confirm.

For advanced user administration, use Expert Options to define the default settings for
the creation of new users. Select the user authentication method (such as NIS, LDAP,
Kerberos, or Samba), login settings (only with KDM or GDM), and the algorithm for
password encryption. Default for New Users and Password Encryption apply only to
local users. Authentication and User Sources provides a configuration overview and
the option to configure the client. Advanced client configuration is also possible using
this module. After accepting the configuration, return to the initial configuration
overview. ClickWrite Changes Now to save all changes without exiting the configuration
module.
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2.9.2 Group Management
To create and edit groups, select Security and Users → Group Management or click
Groups in the user administration module. Both dialogs have the same functionality,
allowing you to create, edit, or delete groups.

The module gives an overview of all groups. As in the user management dialog, change
filter settings by clicking Set Filter.

To add a group, click Add and fill in the appropriate data. Select group members from
the list by checking the corresponding box. Click Accept to create the group. To edit a
group, select the group to edit from the list and click Edit. Make all necessary changes
then save them with Accept. To delete a group, simply select it from the list and click
Delete.

Click Expert Options for advanced group management. Find more about these options
in Section 2.9.1, “User Management” (page 67).

2.9.3 Local Security
To apply a set of security settings to your entire system, use Security and Users →
Local Security. These settings include security for booting, login, passwords, user cre-
ation, and file permissions. SUSE Linux offers three preconfigured security sets: Home
Workstation, Networked Workstation, and Networked Server. Modify the defaults with
Details. To create your own scheme, use Custom Settings.

The detailed or custom settings include:

Password Settings
To have new passwords checked by the system for security before they are accepted,
clickCheck New Passwords and Test for Complicated Passwords. Set the minimum
password length for newly created users. Define the period for which the password
should be valid and how many days in advance an expiration alert should be issued
when the user logs in to the text console.

Boot Settings
Set how the key combination Ctrl + Alt + Del should be interpreted by selecting
the desired action. Normally, this combination, when entered in the text console,
causes the system to reboot. Do not modify this setting unless your machine or
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server is publicly accessible and you are afraid someone could carry out this action
without authorization. If you select Stop, this key combination causes the system
to shut down. With Ignore, this key combination is ignored.

If you use the KDE login manager (KDM), set permissions for shutting down the
system in Shutdown Behavior of KDM. Give permission to Only root (the system
administrator), All Users,Nobody, or Local Users. IfNobody is selected, the system
can only be shut down from the text console.

Login Settings
Typically, following a failed login attempt, there is a waiting period lasting a few
seconds before another login is possible. This makes it more difficult for password
sniffers to log in. Optionally activate Record Successful Login Attempts and Allow
Remote Graphical Login. If you suspect someone is trying to discover your pass-
word, check the entries in the system log files in /var/log. To grant other users
access to your graphical login screen over the network, enable Allow Remote
Graphical Login. Because this access possibility represents a potential security
risk, it is inactive by default.

User Addition
Every user has a numerical and an alphabetical user ID. The correlation between
these is established using the file /etc/passwd and should be as unique as pos-
sible. Using the data in this screen, define the range of numbers assigned to the
numerical part of the user ID when a new user is added. A minimum of 500 is
suitable for users. Automatically generated system users start with 1000. Proceed
in the same way with the group ID settings.

Miscellaneous Settings
To use predefined file permission settings, select Easy, Secure, or Paranoid. Easy
should be sufficient for most users. The setting Paranoid is extremely restrictive
and can serve as the basic level of operation for custom settings. If you select
Paranoid, remember that some programs might not work correctly or even at all,
because users no longer have permission to access certain files.

Also set which user should launch the updatedb program, if installed. This pro-
gram, which automatically runs on a daily basis or after booting, generates a
database (locatedb) in which the location of each file on your computer is stored.
If you select Nobody, any user can find only the paths in the database that can be
seen by any other (unprivileged) user. If root is selected, all local files are indexed,
because the user root, as superuser, may access all directories. Make sure that
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the options Current Directory in root's Path and Current Directory in Path of
Regular Users are deactivated. Only advanced users should consider using these
options because these settings may pose a significant security risk if used incorrectly.
To have some control over the system even if it crashes, click Enable Magic SysRq
Keys.

Click Finish to complete your security configuration.

2.9.4 Firewall
SuSEfirewall2 can protect your machine against attacks from the Internet. Configure
it with Security and Users → Firewall.

TIP: Automatic Activation of the Firewall

YaST automatically starts a firewall with suitable settings on every configured
network interface. Start this module only if you want to reconfigure the firewall
with custom settings or deactivate it.

2.10 Miscellaneous
The YaST Control Center has several modules that cannot easily be classified into the
first six module groups. They can be used for things like viewing log files and installing
drivers from a vendor CD.

2.10.1 Support Query
Miscellaneous → Support Query offers the possibility to collect all system information
needed by the support team to find your problem so you can get help to solve it as soon
is possible. Regarding your query, select the problem category in the following window.
When all information is gathered, attach it to your support request.
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2.10.2 Release Notes
The release notes are an important source about installation, update, configuration, and
technical issues. The release notes are continuously updated and published through
online update. Use Miscellaneous → Release Notes to view the release notes.

2.10.3 Start-Up Log
View information concerning the start-up of the computer in Miscellaneous → View
Start-Up Log. This is one of the first places you might want to look when encountering
problems with the system or when troubleshooting. It shows the boot log /var/log/
boot.msg, which contains the screen messages displayed when the computer starts.
Viewing the log can help determine if the computer started properly and if all services
and functions were started correctly.

2.10.4 System Log
Use Miscellaneous → View System Log to view the system log that keeps track of the
operations of your computer in var/log/messages. Kernel messages, sorted ac-
cording to date and time, are also recorded here. View the status of certain system
components using the box at the top. The following options are possible from the system
log and boot log modules:

/var/log/messages
This is the general system log file. Here, view kernel messages, users logging in
as root, and other useful information.

/proc/cpuinfo
This displays processor information, including its type, make, model, and perfor-
mance.

/proc/dma
This shows which DMA channels are currently being used.

/proc/interrupts
This shows which interrupts are in use and how many of each have been in use.
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/proc/iomem
This displays the status of input/output memory.

/proc/ioports
This shows which I/O ports are in use at the moment.

/proc/meminfo
This displays memory status.

/proc/modules
This displays the individual modules.

/proc/mounts
This displays devices currently mounted.

/proc/partitions
This shows the partitioning of all hard disks.

/proc/version
This displays the current version of Linux.

/var/log/YaST2/y2log
This displays all YaST log messages.

/var/log/boot.msg
This displays information concerning the start-up of the system.

/var/log/faillog
This displays login failures.

/var/log/warn
This displays all system warnings.

2.10.5 Vendor Driver CD
Install device drivers from a Linux driver CD that contains drivers for SUSE Linux
with Miscellaneous → Vendor Driver CD. When installing SUSE Linux from scratch,
use this YaST module to load the required drivers from the vendor CD after the instal-
lation.
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2.11 YaST in Text Mode
This section is mainly intended for system administrators and experts who do not run
an X server on their systems and depend on the text-based installation tool. It provides
basic information about starting and operating YaST in text mode.

When YaST is started in text mode, the YaST Control Center appears first. See Fig-
ure 2.6, “Main Window of YaST in Text Mode” (page 73). The main window consists
of three areas. The left frame, which is surrounded by a thick white border, features the
categories to which the various modules belong. The active category is indicated by a
colored background. The right frame, which is surrounded by a thin white border, pro-
vides an overview of the modules available in the active category. The bottom frame
contains the buttons for Help and Exit.

Figure 2.6 Main Window of YaST in Text Mode

When the YaST Control Center is started, the category Software is selected automati-
cally. Use ↓ and ↑ to change the category. To start a module from the selected
category, press → . The module selection now appears with a thick border. Use ↓
and ↑ to select the desired module. Keep the arrow keys pressed to scroll through the
list of available modules. When a module is selected, the module title appears with a
colored background and a brief description is displayed in the bottom frame.
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Press Enter to start the desired module. Various buttons or selection fields in the
module contain a letter with a different color (yellow by default). Use Alt + yellow_let-
ter to select a button directly instead of navigating there with Tab . Exit the YaST
Control Center by pressing the Exit button or by selecting Exit in the category overview
and pressing Enter .

2.11.1 Navigation in Modules
The following description of the control elements in the YaST modules assumes that
all function keys and Alt key combinations work and are not assigned different global
functions. Read Section 2.11.2, “Restriction of Key Combinations” (page 75) for infor-
mation about possible exceptions.

Navigation among Buttons and Selection Lists
Use Tab and Alt + Tab or Shift + Tab to navigate among the buttons and
the frames containing selection lists.

Navigation in Selection Lists
Use the arrow keys ( ↑ and ↓ ) to navigate among the individual elements in an
active frame containing a selection list. If individual entries within a frame exceed
its width, use Shift + → or Shift + ← to scroll horizontally to the right and
left. Alternatively, use Ctrl + E or Ctrl + A . This combination can also be
used if using → or ← would result in changing the active frame or the current
selection list, as in the Control Center.

Buttons, Radio Buttons, and Check Boxes
To select buttons with empty square brackets (check boxes) or empty parentheses
(radio buttons), press Space or Enter . Alternatively, radio buttons and check
boxes can be selected directly with Alt + yellow_letter . In this case, you do not
need to confirm with Enter . If you navigate to an item with Tab , press Enter to
execute the selected action or activate the respective menu item.

Function Keys
The F keys ( F1 to F12 ) enable quick access to the various buttons. Which
function keys are actually mapped to which buttons depends on the active YaST
module, because the different modules offer different buttons (Details, Info, Add,
Delete, etc.). Use F10 for OK, Next, and Finish. Press F1 to access the YaST
help, which shows the functions mapped to the individual F keys.
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Figure 2.7 The Software Installation Module

2.11.2 Restriction of Key Combinations
If your window manager uses global Alt combinations, the Alt combinations in
YaST might not work. Keys like Alt or Shift can also be occupied by the settings of
the terminal.

Replacing Alt with Esc
Alt shortcuts can be executed with Esc instead of Alt . For example, Esc + H
replaces Alt + H .

Backward and Forward Navigation with Ctrl + F and Ctrl + B
If the Alt and Shift combinations are occupied by the window manager or the
terminal, use the combinations Ctrl + F (forward) and Ctrl + B (backward)
instead.

Restriction of Function Keys
The F keys are also used for functions. Certain function keys might be occupied
by the terminal and may not be available for YaST. However, the Alt key combi-
nations and function keys should always be fully available on a pure text console.
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2.11.3 Starting the Individual Modules
To save time, the individual YaST modules can be started directly. To start a module,
enter:
yast <module_name>

View a list of all module names available on your system with yast -l or yast
--list. Start the network module, for example, with yast lan.

2.12 Update from the Command Line
SUSE Linux comes with a new command line tool for installing and updating packages,
rug. It works with the rcd daemon to install, update, and remove software according to
the commands given. It can install software from local files or from servers. You may
use one or more remote servers, known as services. Supported services are mount for
local files and yum or ZENworks for servers.

rug sorts software from services into catalogs (also known as channels), groups of
similar software. For example, one catalog might contain software from an update
server and another some software from a third-party software vendor. Subscribe to in-
dividual catalogs to control the display of available packages and prevent the accidental
installation of unwanted software. Operations are normally performed only on software
from catalogs to which you are subscribed.

The most commonly used command is rug update, which downloads and installs
patches in catalogs to which you are subscribed. If you only want to update software,
this is the only command you need. To obtain a list of all packages from one catalog,
use rug pa catalogname. Replace catalogname with name of your catalog.
To list all available services, use rug sl. Some other useful rug commands and their
functions are shown in Table 2.1, “rug Commands” (page 76).

Table 2.1 rug Commands

FunctionCommand

List the catalogsca
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FunctionCommand

Add a servicesa

Register a servicereg

Subscribe to a catalogsub

Refresh the lists of patchesrefresh

2.12.1 rug User Management
One of the biggest advantages of rug is user management. Normally only root can
update or install new packages. With rug, you can distribute the right to update the
system to other users and restrict them, for example, only to the update right without
the possibility to remove software. Privileges you can grant are:

install
User may install new software

lock
User may set package locks

remove
User may remove software

subscribe
User may change channel subscriptions

trusted
User is considered trusted, so may install packages without package signatures

upgrade
User may update software packages

view
This allows the user to see which software is installed on the machine and which
software is in available channels. The option is relevant only to remote users, local
users are normally permitted to view installed and available packages.
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superuser
Permits all rug commands except user management and settings, which must be
done locally.

To give a user permission to update the system, use the command rug ua
username upgrade. Replace username with the name of the user. To revoke the
privileges of a user, use command rug ud username. To list users with their rights,
use rug ul.

To change the current privileges of a user, userug ue username. Replaceusername
with name of the desired user. The edit command is interactive. It lists privileges of the
selected user and the offers you a prompt. Enter the plus (+) or minus (-) symbol and
the name of the privilege then press Enter . For example, to permit the user to delete
software, enter +remove. To save and quit, press Enter on a blank line.

2.12.2 Scheduling Updates
Using rug, the system can be updated automatically, for example, with scripts. The
simplest example is the fully automatic update. To do this, as root configure a cron
job that executes rug up -y. The up -y option downloads and installs the patches
from your catalogs without confirmation.

However, you may not want the patches installed automatically. Instead, you may want
to retrieve the patches and select the patches for installation at a later time. To download
patches only, use the command rug up -dy. The up -dy option downloads the
patches from your catalogs without confirmation and saves them to the rug cache. The
default location of the rug cache is /var/cache/redcarpet.

2.12.3 Configuring rug
rug comes with many preferences to provide the update functionality in different network
configurations. To list the preferences that may be set, use rug get. To set a preference
variable, enter rug set. For example, adjust settings if you need to update your system,
but the computer is behind a proxy server. Before downloading updates, send your
username and password to the proxy server. To do so, use the commands:
rug set proxy-url url_path
rug set proxy-username name
rug set proxy-password password
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Replace url_path with the name of your proxy server. Replace name with your
username. Replace password with your password.

2.12.4 For More Information
For more information about updating from the command line, enter rug --help or
see the rug(1)man page. The --help option is also available for all rug commands.
If, for example, you want to read help forrugupdate, enterrugupdate --help.

2.13 SaX2
Configure the graphical environment of your system with Hardware → Graphics Card
and Monitor. This opens the SUSE Advanced X11 Configuration interface (SaX2),
where you can configure devices such as your mouse, keyboard, or display devices.
This interface can also accessed from the main menu by clicking System → Configura-
tion → SaX2.

2.13.1 Card and Monitor Properties
Adjust the settings for your graphics card and display device in Card and Monitor
Properties. If you have more than one graphics card installed, each device is shown in
a separate dialog reachable by a tab. At the top of the dialog, see the current settings
for the selected graphics card and the monitor that is attached to it. If more than one
screen can be connected to the card (dual head), the monitor on the primary output is
shown. Normally, the card and display device are detected automatically by the system
during installation. However, you can tune many parameters manually or even change
the display device completely.
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Figure 2.8 Card and Monitor Properties

TIP: Autodetecting New Display Hardware

If you change your display hardware after installation, use sax2 -r on the
command line to cause SaX2 to detect your hardware. You must be root to
run SaX2 from the command line.

Graphics Card
It is not possible to change the graphics card because only known models are supported
and these are detected automatically. However, you can change many options that affect
the behavior of the card. Normally, this should not be necessary because the system
already has set them up appropriately during installation. If you are an expert and want
to tweak some of the options, click Options next to the graphics card and select the
option to change. To assign a value needed to a certain option, enter this value in the
dialog that appears after selecting that option. Click OK to close the options dialog.
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Monitor
To change the current settings for the monitor, click Change next to the monitor. A
new dialog opens in which to adjust various monitor-specific settings. This dialog has
several tabs for various aspects of monitor operation. Select the first tab to manually
select the vendor and model of the display device in two lists. If your monitor is not
listed, you can choose one of the VESA or LCD modes that suit your needs or, if you
have a vendor driver disk or CD, click Utility Disk and follow the instructions on the
screen to use it. Check Activate DPMS to use display power management signaling.
Display Size, with the geometrical properties of the monitor, and Sync Frequencies,
with the ranges for the horizontal and vertical sync frequencies of your monitor, are
normally set up correctly by the system, but you can modify these values manually.
After making all adjustments, click OK to close this dialog.

WARNING: Changing Monitor Frequencies

Although there are safety mechanisms, you should still be very careful when
changing the allowed monitor frequencies manually. Incorrect values might
destroy your monitor. You should always refer to the monitor's manual before
changing frequencies.

Resolution and Color Depth
The resolution and color depth can be chosen directly from two lists in the middle of
the dialog. The resolution you select here marks the highest resolution to use. All
common resolutions down to 640x480 are also added to the configuration automatically.
Depending on the graphical desktop used, you can switch to any of these later without
the need for reconfiguration.

Dual Head
If you have a graphics card with two outputs installed in your computer, you can connect
two screens to your system. Two screens that are attached to the same graphics card
are referred to as dual head. SaX2 automatically detects multiple display devices in the
system and prepares the configuration accordingly. To use the dual head mode of a
graphics card, check Activate Dual Head Mode at the bottom of the dialog and click
Configure to set the dual head options and the arrangement of the screens in the dual
head dialog.
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The tabs in the row at the top of the dialog each correspond to a graphics card in your
system. Select the card to configure and set its multihead options in the dialog below.
In the upper part of the multihead dialog, click Change to configure the additional
screen. The possible options are the same as for the first screen. Choose the resolution
to use for this screen from the list. Select one of three possible multihead modes.

Traditional Multihead
Each monitor represents an individual unit. The mouse pointer can switch between
the screens.

Cloned Multihead
In this mode, all monitors display the same contents. The mouse is only visible on
the main screen.

Xinerama Multihead
All screens combine to form a single large screen. Program windows can be posi-
tioned freely on all screens or scaled to a size that fills more than one monitor.

NOTE

Linux currently does not offer 3D support for Xinerama multihead environ-
ments. In this case, SaX2 deactivates the 3D support.

The arrangement of the dual head environment describes the sequence of the individual
screens. By default, SaX2 configures a standard layout that follows the sequence of the
detected screens, arranging all screens in a row from left to right. In the Arrangement
part of the dialog, determine the way the monitors are arranged by selecting one of the
sequence buttons. Click OK to close the dialog.

TIP: Using a Beamer with Laptop Computers

To connect a beamer to a laptop computer, activate dual head mode. In this
case, SaX2 configures the external output with a resolution of 1024x768 and
a refresh rate of 60 Hz. These values suit most beamers very well.

Multihead
If you have more than one graphics card installed in your computer, you can connect
more than one screen to your system. Two or more screens that are attached to different

82 Start-Up



graphics cards are referred to as multihead. SaX2 automatically detects multiple
graphics cards in the system and prepares the configuration accordingly. By default,
SaX2 configures a standard layout that follows the sequence of the detected graphics
cards, arranging all screens in a row from left to right. The additional Arrangement tab
allows for changing this layout manually. Drag the icons representing the individual
screens in the grid and click OK to close the dialog.

3D Acceleration
If your graphics card supports 3D acceleration, you can switch it on and off with Activate
3D Acceleration.

Testing the Configuration
Click OK in the main window after completing the configuration of your monitor and
your graphics card, then test your settings. This ensures that your configuration is suitable
for your devices. If the image is not steady, terminate the test immediately by pressing
Ctrl + Alt + Backspace and reduce the refresh rate or the resolution and color depth.

NOTE

Regardless of whether you run a test, all modifications are only activated when
you restart the X server.

2.13.2 Mouse Properties
Adjust the settings for your mouse in Mouse Properties. If you have more than one
mouse with different drivers installed, each driver is shown in a separate tab. Multiple
devices operated by the same driver are shown as one mouse. Activate or deactivate
the currently selected mouse with the check box at the top of the dialog. Below the
check box, see the current settings for that mouse. Normally, the mouse is detected
automatically, but you can change it manually if the automatic detection fails. Refer to
the documentation for your mouse for a description of the model. ClickChange to select
the vendor and model from two lists then click OK to confirm your selection. In the
options part of the dialog, set various options for operating your mouse.

System Configuration with YaST 83



Activate 3-Button Emulation
If your mouse has only two buttons, a third button is emulated when you click both
buttons simultaneously.

Activate Mouse Wheel
Check this box to use a scroll wheel.

Emulate Wheel with Mouse Button
If your mouse does not have a scroll wheel but you want to use similar functional-
ity, you can assign an additional button for this. Select the button to use. While
pressing this button, any movement of the mouse is translated into scroll wheel
commands. This feature is especially useful with trackballs.

When you are satisfied with your settings, click OK to confirm your changes.

NOTE

Any changes you make here take effect only after you restart the X server.

2.13.3 Keyboard Properties
Use this dialog to adjust the settings for operating your keyboard in the graphical envi-
ronment. In the upper part of the dialog, select the type, language layout, and variant.
Use the test field at the bottom of the dialog to check if special characters are displayed
correctly. Select additional layouts and variants to use from the list in the middle. De-
pending on the type of your desktop, these may be switched in the running system
without the need for reconfiguration. After you click OK, the changes are applied im-
mediately.

2.13.4 Tablet Properties
Use this dialog to configure a graphics tablet attached to your system. Click the
Graphics Tablet tab to select vendor and model from the lists. Currently, SUSE Linux
supports only a limited number of graphics tablets. To activate the tablet, check Activate
This Tablet at the top of the dialog.

In the Port and Mode dialog, configure the connection to the tablet. SaX2 enables the
configuration of graphics tablets connected to the USB port or the serial port. If your
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tablet is connected to the serial port, verify the port. /dev/ttyS0 refers to the first
serial port. /dev/ttyS1 refers to the second. Additional ports use similar notation.
Choose appropriate Options from the list and select the Primary Tablet Mode suitable
for your needs.

If your graphics tablet supports electronic pens, configure them in Electronic Pens.
Add eraser and pen and set their properties after clicking Properties.

When you are satisfied with the settings, click OK to confirm your changes.

2.13.5 Touchscreen Properties
Use this dialog to configure touchscreens attached to your system. If you have more
than one touchscreen installed, each device is shown in a separate dialog reachable by
a tab. To activate the currently selected touchscreen, check Assign a Touchscreen to
Display at the top of the dialog. Select vendor and model from the lists below and set
an appropriateConnection Port at the bottom. You can configure touchscreens connected
to the USB port or the serial port. If your touchscreen is connected to the serial port,
verify the port. /dev/ttyS0 refers to the first serial port. /dev/ttyS1 refers to the
second. Additional ports use similar notation. When you are satisfied with your settings,
click OK to confirm your changes.

2.13.6 Remote Access Properties
VNC (Virtual Network Computing) is a client-server solution that gives access a remote
X server with a slim and easy-to-use client. This client is available for a variety of op-
erating systems, including Microsoft Windows, Apple's MacOS, and Linux. Find addi-
tional information about VNC at http://www.realvnc.com/.

Use this dialog to configure your X server as a host for VNC sessions. If you want VNC
clients to connect to your X server, check Allow Access to Display Using VNC Protocol.
Set a password to restrict access to your VNC-enabled X server. Check Allow Multiple
VNC Connections if more than one VNC client should connect to the X server at the
same time. Allow HTTP access by checking Activate HTTP Access and setting the port
to be use in HTTP Port.

When you are satisfied with your settings, click OK to save your changes.
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2.14 Troubleshooting
All error messages and alerts are logged in the directory /var/log/YaST2. The
most important file for finding YaST problems is y2log.

2.15 For More Information
More information about YaST can be found on the following Web sites and directories:

• /usr/share/doc/packages/yast2—Local YaST development documen-
tation

• http://www.opensuse.org/YaST_Development—The YaST project
page in the openSUSE wiki

• http://forge.novell.com/modules/xfmod/project/
?yast—Another YaST project page
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3Working with the Shell
When booting your Linux system, you are usually directed to a graphical user interface
that guides you through the login process and the following interactions with the system.
Although graphical user interfaces have become very important and user-friendly, using
them is not the only way to communicate with your system. You can also use a text-
oriented communication like a command line interpreter, usually called the shell, where
you can enter commands. Because Linux provides options to start shell windows from
the graphical user interface, you can easily use both methods.

In administration, shell-based applications are especially important for controlling
computers over slow network links or if you want to perform tasks as root on the
command line. For Linux “newbies” it might be rather unusual to enter commands in
a shell, but you will soon realize that the shell is not only for administrators—in fact,
using the shell is often the quickest and easiest way to perform some daily tasks.

There are several shells for UNIX or Linux. The default shell in SUSE Linux is Bash
(GNU Bourne-Again Shell).

This chapter deals with a couple of basics you need to know for using the shell. This
includes the following topics: how to enter commands, the directory structure of Linux,
how to work with files and directories and how to use some basic functions, the user
and permission concept of Linux, an overview of important shell commands, and a
short introduction to the vi editor, which is a default editor always available in Unix
and Linux systems.
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3.1 Getting Started with the Bash
Shell

In Linux, you can use the command line parallel to the graphical user interface and
easily switch between them. To start a terminal window from the graphical user interface
in KDE, click the Konsole icon in the panel. In GNOME, click the GNOME Terminal
icon in the panel.

The Konsole or the GNOME Terminal window appears, showing the prompt on the
first line like in Figure 3.1, “Example of a Bash Terminal Window” (page 90). The
prompt usually shows your login name (in this example, tux), the hostname of your
computer (here, knox), and the current path (in this case, your home directory, indicated
by the tilde symbol, ~). When you are logged in on a remote computer this information
always shows you which system you are currently working on. When the cursor is after
this prompt, you can send commands directly to your computer system.

Figure 3.1 Example of a Bash Terminal Window

3.1.1 Entering Commands
A command consists of several elements. The first element is always the actual com-
mand, followed by parameters or options. You can type a command and edit it by using
← , → , <— , Del , and Space . You can also add options or correct typing errors.
The command is executed when you press Enter .
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IMPORTANT: No News Is Good News

The shell is not verbose: in contrast to some graphical user interfaces, it usually
does not provide confirmation messages when commands have been executed.
Messages only appear in case of problems or errors.

Also keep this in mind for commands to delete objects. Before entering a
command like rm for removing a file, you should know if you really want to
get rid of the object: it will be deleted irretrievably, without enquiry.

Using Commands without Options
Look at the structure of commands using a simple example: the ls command, used to
list the contents of a directory. The command can be used with or without options. En-
tering the plain ls command shows the contents of the current directory:

Figure 3.2 The ls Command

Unlike in MS Windows, files in Linux may have a file extension, such as .txt, but
do not need to have one. This makes it difficult to differentiate between files and folders
in this output of the ls. By default, the colors can give you a hint: directories are usu-
ally shown in blue, files in black.

Using Commands with Options
A better way to get more details about the contents of a directory is using the ls com-
mand with a string of options. Options modify the way a command works so that you
can get it to do specific tasks. Options are separated from the command with a blank
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and are prefixed with a hyphen. The ls -l command shows the contents of the same
directory in full detail (long listing format):

Figure 3.3 The ls -l Command

On the left of each object name, information about the object is shown in several
columns. The most important are the following: The first column shows the file type
of the object (in this example, d for directory or - for normal files). The next nine
columns show the user permissions for the object. Columns 11 and 12 show the name
of the file owner and the group (in this case, tux and users). Find information about
user permissions and the user concept of Linux in Section 3.2, “Users and Access Per-
missions” (page 102). The next column shows the file size in bytes. Then date and time
of the last change are displayed. The last column shows the object name.

If you want to see even more, you can combine two options for the ls command and
enter ls -la. The shell now also shows hidden files in the directory, indicated by a
dot in front (for example, .hiddenfile).

Getting Help
Nobody is expected to know all options of all commands by heart. If you remember
the command name but are not sure about the options, you can enter the command
followed by a blank and --help. This --help option exists for many commands.
Entering ls --help displays all the options for the ls command.
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3.1.2 Linux Directory Structure
Because the shell does not offer a graphical overview of directories and files like the
tree view in a file manager, it is useful to have some basic knowlegde of the default
directory structure in a Linux system. You can think of directories as electronic folders
in which files, programs, and subdirectories are stored. The top level directory in the
hierarchy is the root directory, referred to as /. This is the place from which all other
directories can be accessed.

Figure 3.4, “Excerpt from a Standard Directory Tree” (page 94) shows the standard
directory tree in Linux, with the home directories of the example users xyz, linux,
and tux. The /home directory contains the directories in which the individual users
can store their personal files.

NOTE: Home Directory in a Network Environment

If you are working in a network environment, your home directory may not be
called /home. It can be mapped to any directory in the file system.

The following list provides a brief description of the standard directories in Linux.
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Figure 3.4 Excerpt from a Standard Directory Tree

X11R6

manlibbin

Mail

xterm xvxdm

f2c

bintuxlinux

ld.so

test.c

yxz

bin

libetc local sbin

manlibbin ftp

bin lib pub

kde gnome

faq howto packages

share

doc man

/

st0sdahda

vmlinuz

etc home media mnt opt proc rootlib sbin varusrtmpsyssrvbin boot dev

/
Root directory, starting point of the directory tree

/home
Personal directories of users

/dev
Device files that represent hardware components

/etc
Important files for system configuration

/etc/init.d
Boot scripts

/usr/bin
Generally accessible programs
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/bin
Programs needed early in the boot process

/usr/sbin
Programs reserved for the system administrator

/sbin
Programs reserved for the system administrator and needed for booting

/usr/include
Header files for the C compiler

/usr/include/g++
Header files for the C++ compiler

/usr/share/doc
Various documentation files

/usr/share/man
System manual pages (man pages)

/usr/src
Source code of system software

/usr/src/linux
Kernel source code

/tmp, /var/tmp
Temporary files

/usr
All application programs

/var
Configuration files (such as those linked from /usr)

/var/log
System log files

/var/adm
System administration data
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/lib
Shared libraries (for dynamically linked programs)

/proc
Process file system

/sys
System file system where all device information for the kernel is gathered

/usr/local
Local, distribution-independent extensions

/opt
Optional software, larger add-on program packages (such as KDE, GNOME, and
Netscape)

3.1.3 Working with Directories and Files
To address a certain file or directory, you must specify the path leading to that directory
or file. There are two ways to specify a path:

• The entire (absolute) path from the root directory to the respective file

• A path starting from the current directory (relative path)

Absolute paths always start with a slash. Relative paths do not have a slash at the begin-
ning.

NOTE: Linux Is Case-Sensitive

Linux distinguishes between uppercase and lowercase in the file system. For
example, entering test.txt or Test.txtmakes a difference in Linux. Keep
this in mind when entering filenames or paths.

To change directories, use the cd command. Enter the directory to go to as an option
of the command. Refer to the current directory with a dot (.). The next higher level in
the tree is represented by two dots (..). To switch to the parent directory of your current
directory, enter cd ... Do not forget to enter a blank after the cd command to separate
the command from the options. Your prompt now shows the path to the parent of the
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directory where you ran the command. To switch to a directory two levels higher than
the current directory, enter cd ../... ls -l ../.. lists the contents of the direc-
tory two levels higher.

Examples of Addressing a File
The cd commands in Section 3.1.3, “Working with Directories and Files” (page 96)
used relative paths. You can use also absolute paths. For example, suppose you want
to copy a file from your home directory to a subdirectory of /tmp:

1 First, from your home directory create a subdirectory in /tmp:

a If your current directory is not your home directory, enter cd ~ to switch
to it. From anywhere in the file system, you can reach your home directory
by entering cd ~.

b In your home directory, enter mkdir /tmp/test. mkdir stands for
“make directory”. This command creates a new directory named test in
the /tmp directory. In this case, use an absolute path to create the directory.

c To check what happened, now enter ls -l /tmp. The new directory
test should appear in the list of contents of the /tmp directory.

2 Now create a new file in your home directory and copy it to the /tmp/test
directory by using a relative path.

a Enter touch myfile.txt. The touch command with the
myfile.txt option creates a new, empty file named myfile.txt in
your current directory.

b Check this by entering ls -l. The new file should appear in the list of
contents.

c Enter cp myfile.txt ../tmp/test. This copies myfile.txt to
the directory /tmp/test without changing the name of the file.

d Check this by entering ls -l /tmp/test. The file myfile.txt
should appear in the list of contents for /tmp/test.
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To list the contents of home directories of other users, enter ls ~username . In the
example directory tree in Figure 3.4, “Excerpt from a Standard Directory Tree”
(page 94), one of the sample users is tux. In this case, ls ~tuxwould list the contents
of the home directory of tux.

NOTE: Handling Blanks in Filenames or Directory Names

If a filename contains a space, either escape the space using a back slash (\)
in front of the blank or enclose the filename in single or double quotes. Other-
wise Bash interprets a filename like My Documents as the names of two files
or directories. The difference between single and double quotes is that variable
expansion takes place within double quotes. Single quotes ensure that the shell
sees the quoted string literally.

3.1.4 Useful Features of the Shell
Entering commands in Bash can include a lot of typing. In the following, get to know
some features of the Bash that can make your work a lot easier and save a lot of typing.

History and Completion
By default, Bash “remembers” commands you have entered. This feature is called
history. To repeat a command that has been entered before, press ↑ until the pre-
vious command appears at the prompt. You can also move forward through the list of
previously entered commands by pressing ↓ . You always have the chance to edit this
command, for example, changing the name of a file, before you execute the command
by pressing Enter . To edit the command line, just move the cursor to the desired position
using the arrow keys and start typing. Use Ctrl + R to search in the history.

Completing a filename or directory name to its full length after typing its first letters
is another helpful feature of Bash. To do so, type the first letters then press →| . If
the filename or path can be uniquely identified it is completed at once and the cursor
moves to the end of the filename. You can then enter the next option of the command,
if necessary. If the filename or path cannot be uniquely identified (because there are
several filenames starting with the same letters), the filename or path is only completed
up to the point where again several options are possible. You can then obtain a list of
them by pressing →| a second time. After this, you can enter the next letters of the
file or path then try completion again by pressing →| . When completing filenames
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and paths with the help of →| , you can simultaneously check whether the file or path
you want to enter really exists (and you can be sure of getting the spelling right).

Wild Cards
Another convenience offered by the shell is wild cards for pathname expansion. Wild
cards are characters that can stand for other characters. There are three different types
of these in Bash:

?
Matches exactly one arbitrary character

*
Matches any number of characters

[set]
Matches one of the characters from the group specified inside the square brackets,
which is represented here by the string set. As part of set you can also specify
character classes using the syntax [:class:], where a class is one of alnum,
alpha, ascii, etc.

Using ! or ^ at the beginning of the group ([!set]) matches one character other than
those identified by set.

Assuming that your test directory contains the files Testfile, Testfile1,
Testfile2, and datafile, the command ls Testfile? lists the files
Testfile1 and Testfile2. With ls Test*, the list also includes Testfile.
ls *fil* shows all the sample files. Finally, you can use the setwild card to address
all sample files whose last character is a number: ls Testfile[1-9] or, using
classes, ls Testfile[[:digit:]].

Of the four types of wild cards, the most inclusive one is the asterisk. It could be used
to copy all files contained in one directory to another one or to delete all files with one
command. The command rm *fil*, for instance, would delete all files in the current
directory whose name includes the string fil.
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Viewing Files with Less and More
Linux includes two small programs for viewing text files directly in the shell: less
and more. Rather than starting an editor to read a file like Readme.txt, simply enter
less Readme.txt to display the text in the console window. Use Space to scroll
down one page. Use Page ↑ and Page ↓ to move forward or backward in the text. To
exit less, press Q .

Instead of less, you can also use the older program more. However, it is less convenient
because it does not allow you to scroll backwards.

The program less got its name from the the precept that less is more and can also be
used to view the output of commands in a convenient way. To see how this works, read
Section “Redirection and Pipes” (page 100).

Redirection and Pipes
Normally, the standard output in the shell is your screen or the console window and
the standard input is the keyboard. However, the shell provides functions by which you
can redirect the input or the output to another object, such as a file or another command.
With the help of the symbols > and <, for example, you can forward the output of a
command to a file (output redirection) or use a file as input for a command (input
redirection). For example, if you want to write the output of a command such as ls to
a file, enter ls -l > file.txt. This creates a file named file.txt that contains
the list of contents of your current directory as generated by the ls command. However,
if a file named file.txt already exists, this command overwrites the existing file.
To prevent this, use >>. Entering ls -l >> file.txt simply appends the output
of the ls command to an already existing file named file.txt. If the file does not
exist, it is created.

Sometimes it is also useful to use a file as the input for a command. For example, with
the tr command, you can replace characters redirected from a file and write the result
to the standard output, your screen. Suppose you want to replace all characters t of
your file.txt from the example above with x and print this to your screen. Do so
by entering tr t x < file.txt.

Just like the standard output, the standard error output is sent to the console. To redirect
the standard error output to a file named errors, append 2> errors to the corre-
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sponding command. Both standard output and standard error are saved to one file named
alloutput if you append >& alloutput.

Using pipelines or pipes is also a sort redirection, although the use of the pipe is not
constrained to files. With a pipe (|), you can combine several commands, using the
output of one command as input for the next command. For example, to view the contents
or your current directory in less, enter ls | less. This only makes sense if the
normal output with ls would be too lengthy. For instance, if you view the contents of
the dev directory with ls /dev, you only see a small portion in the window. View
the entire list with ls /dev | less.

3.1.5 Archives and Data Compression
Now that you have already created a number of files and directories, consider the subject
of archives and data compression. Suppose you want to have the entire test directory
packed in one file that you can save on a USB stick as a backup copy or send by e-mail.
To do so, use the command tar (for tape archiver). With tar --help, view all the
options for the tar command. The most important of these options are explained here:

-c
(for create) Create a new archive.

-t
(for table) Display the contents of an archive.

-x
(for extract) Unpack the archive.

-v
(for verbose) Show all files on screen while creating the archive.

-f
(for file) Choose a filename for the archive file. When creating an archive, this
option must always be given as the last one.

To pack the test directory with all its files and subdirectories into an archive named
testarchive.tar, use the options -c and -f. For testing purposes, also add -v
to follow the progress of the archiving, although this option is not mandatory. After
using cd to change to your home directory where the test directory is located, enter
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tar -cvf testarchive.tar test. After that, view the contents of the archive
file with tar -tf testarchive.tar. The test directory with all its files and
directories has remained unchanged on your hard disk. To unpack the archive, enter
tar -xvf testarchive.tar, but do not try this yet.

For file compression, the obvious choice is gzip or, for a even better compression ratio,
bzip2. Just entergzip testarchive.tar (orbzip2 testarchive.tar,
but gzip is used in this example). With ls, now see that the file testarchive.tar
is no longer there and that the file testarchive.tar.gz has been created instead.
This file is much smaller and therefore much better suited for transfer via e-mail or
storage on a USB stick.

Now, unpack this file in the test2 directory created earlier. To do so, enter cp
testarchive.tar.gz test2 to copy the file to that directory. Change to the
directory with cd test2. A compressed archive with the .tar.gz extension can
be unzipped with the gunzip command. Enter gunzip testarchive.tar.gz,
which results in the file testarchive.tar, which then needs to be extracted or
untarred with tar -xvf testarchive.tar. You can also unzip and extract a
compressed archive in one step with tar -xvf testarchive.tar.gz (adding
the -z option is no longer required). With ls, you can see that a new test directory
has been created with the same contents as your test directory in your home directory.

3.1.6 Cleaning Up
After this crash course, you should be familiar with the basics of the Linux shell or
command line. You may want to clean up your home directory by deleting the various
test files and directories using the rm and rmdir commands. In Section 3.3, “Important
Linux Commands” (page 106), find a list of the most important commands and a brief
description of their functions.

3.2 Users and Access Permissions
Since its inception in the early 1990s, Linux has been developed as a multiuser system.
Any number of users can work on it simultaneously. Users need to log in to the system
before starting a session at their workstations. Each user has a username with a corre-
sponding password. This differentiation of users guarantees that unauthorized users
cannot see files for which they do not have permission. Larger changes to the system,
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such as installing new programs, are also usually impossible or restricted for normal
users. Only the root user, or super user, has the unrestricted capacity to make changes
to the system and unlimited access to all files. Those who use this concept wisely, only
logging in with full root access when necessary, can cut back the risk of unintentional
loss of data. Because under normal circumstances only root can delete system files or
format hard disks, the threat from the Trojan horse effect or from accidentally entering
destructive commands can be significantly reduced.

3.2.1 File System Permissions
Basically, every file in a Linux file system belongs to a user and a group. Both of these
proprietary groups and all others can be authorized to write, read, or execute these files.

A group, in this case, can be defined as a set of connected users with certain collective
rights. For example, call a group working on a certain project project3. Every user
in a Linux system is a member of at least one proprietary group, normally users.
There can be as many groups in a system as needed, but only root is able to add
groups. Every user can find out, with the command groups, of which groups he is a
member.

File Access
The organization of permissions in the file system differs for files and directories.
File permission information can be displayed with the command ls -l. The
output could appear as in Example 3.1, “Sample Output Showing File Permissions”
(page 103).

Example 3.1 Sample Output Showing File Permissions
-rw-r----- 1 tux project3 14197 Jun 21  15:03 Roadmap

As shown in the third column, this file belongs to user tux. It is assigned to the
group project3. To discover the user permissions of the Roadmap file, the first
column must be examined more closely.

---r--rw--

Permissions for Other
Users

Group PermissionsUsers PermissionsType
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This column consists of one leading character followed by nine characters grouped
in threes. The first of the ten letters stands for the type of file system component.
The hyphen (–) shows that this is a file. A directory (d), a link (l), a block device
(b), or a character device could also be indicated.

The next three blocks follow a standard pattern. The first three characters refer to
whether the file is readable (r) or not (–). A w in the middle portion symbolizes
that the corresponding object can be edited and a hyphen (–) means it is not possible
to write to the file. An x in the third position denotes that the object can be executed.
Because the file in this example is a text file and not one that is executable, exe-
cutable access for this particular file is not needed.

In this example, tux has, as owner of the file Roadmap, read (r) and write access
(w) to it, but cannot execute it (x). The members of the group project3 can read
the file, but they cannot modify it or execute it. Other users do not have any access
to this file. Other permissions can be assigned by means of ACLs (access control
lists).

Directory Permissions
Access permissions for directories have the type d. For directories, the individual
permissions have a slightly different meaning.

Example 3.2 Sample Output Showing Directory Permissions
drwxrwxr-x 1 tux project3 35 Jun 21 15:15  ProjectData

In Example 3.2, “Sample Output Showing Directory Permissions” (page 104), the
owner (tux) and the owning group (project3) of the directory ProjectData
are easy to recognize. In contrast to the file access permissions from File Access
(page 103), the set reading permission (r) means that the contents of the directory
can be shown. The write permission (w) means that new files can be created. The
executable permission (x) means that the user can change to this directory. In the
above example, the user tux as well as the members of the group project3 can
change to the ProjectData directory (x), view the contents (r), and add or
delete files (w). The rest of the users, on the other hand, are given less access. They
may enter the directory (x) and browse through it (r), but not insert any new files
(w).
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3.2.2 Modifying File Permissions
Changing Access Permissions

The access permissions of a file or directory can be changed by the owner and, of
course, by rootwith the command chmod followed by the parameters changing
the permissions and one or more filenames. The parameters form different cate-
gories:

1. Users concerned

• u (user)—owner of the file

• g (group)—group that owns the file

• o (others)—additional users (if no parameter is given, the changes apply to all
categories)

2. A character for deletion (–), setting (=), or insertion (+)

3. The abbreviations

• r—read

• w—write

• x—execute

4. Filename or filenames separated by spaces

If, for example, the user tux in Example 3.2, “Sample Output Showing Directory
Permissions” (page 104) also wants to grant other users write (w) access to the di-
rectory ProjectData, he can do this using the command chmod o+w
ProjectData.

If, however, he wants to deny all users other than himself write permissions, he
can do this by entering the command chmod go-w ProjectData. To prohibit
all users from adding a new file to the folder ProjectData, enter chmod -w
ProjectData. Now, not even the owner can create a new file in the directory
without first reestablishing write permissions.
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Changing Ownership Permissions
Other important commands to control the ownership and permissions of the file
system components are chown (change owner) and chgrp (change group). The
command chown can be used to transfer ownership of a file to another user.
However, only root is permitted to perform this change.

Suppose the file Roadmap from Example 3.2, “Sample Output Showing Directory
Permissions” (page 104) should no longer belong to tux, but to the user geeko.
root should then enter chown geeko Roadmap.

chgrp changes the group ownership of the file. However, the owner of the file
must be a member of the new group. In this way, the user tux from Example 3.1,
“Sample Output Showing File Permissions” (page 103) can switch the group owning
the file ProjectData to project4 with the command chgrp project4
ProjectData, as long as he is a member of this new group.

3.3 Important Linux Commands
This section gives insight into the most important commands of your SUSE Linux
system. There are many more commands than listed in this chapter. Along with the in-
dividual commands, parameters are listed and, where appropriate, a typical sample ap-
plication is introduced. To learn more about the various commands, use the manual
pages, accessed with man followed by the name of the command, for example, man
ls.

In the man pages, move up and down with PgUp and PgDn . Move between the begin-
ning and the end of a document with Home and End . End this viewing mode by
pressing Q . Learn more about the man command itself with man man.

In the following overview, the individual command elements are written in different
typefaces. The actual command and its mandatory options are always printed as
command option. Specifications or parameters that are not required are placed in
[square brackets].

Adjust the settings to your needs. It makes no sense to write ls file if no file named
file actually exists. You can usually combine several parameters, for example, by
writing ls -la instead of ls -l -a.
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3.3.1 File Commands
The following section lists the most important commands for file management. It covers
anything from general file administration to manipulation of file system ACLs.

File Administration
ls [options] [files]

If you run ls without any additional parameters, the program lists the contents of
the current directory in short form.

-l
Detailed list

-a
Displays hidden files

cp [options] source target
Copies source to target.

-i
Waits for confirmation, if necessary, before an existingtarget is overwritten

-r
Copies recursively (includes subdirectories)

mv [options] source target
Copies source to target then deletes the original source.

-b
Creates a backup copy of the source before moving

-i
Waits for confirmation, if necessary, before an existing targetfile is
overwritten

rm [options] files
Removes the specified files from the file system. Directories are not removed by
rm unless the option -r is used.
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-r
Deletes any existing subdirectories

-i
Waits for confirmation before deleting each file

ln [options] source target
Creates an internal link from source to target. Normally, such a link points
directly to source on the same file system. However, if ln is executed with the
-s option, it creates a symbolic link that only points to the directory in which
source is located, enabling linking across file systems.

-s
Creates a symbolic link

cd [options] [directory]
Changes the current directory. cd without any parameters changes to the user's
home directory.

mkdir [options] directory
Creates a new directory.

rmdir [options] directory
Deletes the specified directory if it is already empty.

chown [options] username[:[group]] files
Transfers ownership of a file to the user with the specified username.

-R
Changes files and directories in all subdirectories

chgrp [options] groupname files
Transfers the group ownership of a given file to the group with the specified
group name. The file owner can only change group ownership if a member of both
the current and the new group.

chmod [options] mode files
Changes the access permissions.

The mode parameter has three parts: group, access, and access type.
group accepts the following characters:
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u
User

g
Group

o
Others

For access, grant access with + and deny it with -.

The access type is controlled by the following options:

r
Read

w
Write

x
Execute—executing files or changing to the directory

s
Setuid bit—the application or program is started as if it were started by the
owner of the file

As an alternative, a numeric code can be used. The four digits of this code are
composed of the sum of the values 4, 2, and 1—the decimal result of a binary mask.
The first digit sets the set user ID (SUID) (4), the set group ID (2), and the sticky
(1) bits. The second digit defines the permissions of the owner of the file. The third
digit defines the permissions of the group members and the last digit sets the per-
missions for all other users. The read permission is set with 4, the write permission
with 2, and the permission for executing a file is set with 1. The owner of a file
would usually receive a 6 or a 7 for executable files.

gzip [parameters] files
This program compresses the contents of files using complex mathematical algo-
rithms. Files compressed in this way are given the extension .gz and need to be
uncompressed before they can be used. To compress several files or even entire
directories, use the tar command.
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-d
Decompresses the packed gzip files so they return to their original size and
can be processed normally (like the command gunzip)

tar options archive files
tar puts one or more files into an archive. Compression is optional. tar is a quite
complex command with a number of options available. The most frequently used
options are:

-f
Writes the output to a file and not to the screen as is usually the case

-c
Creates a new tar archive

-r
Adds files to an existing archive

-t
Outputs the contents of an archive

-u
Adds files, but only if they are newer than the files already contained in the
archive

-x
Unpacks files from an archive (extraction)

-z
Packs the resulting archive with gzip

-j
Compresses the resulting archive with bzip2

-v
Lists files processed

The archive files created by tar end with .tar. If the tar archive was also com-
pressed using gzip, the ending is .tgz or .tar.gz. If it was compressed using
bzip2, the ending is .tar.bz2. Application examples can be found in Sec-
tion 3.1.5, “Archives and Data Compression” (page 101).
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locate patterns
This command is only available if you have installed the findutils-locate
package. The locate command can find in which directory a specified file is lo-
cated. If desired, use wild cards to specify filenames. The program is very speedy,
because it uses a database specifically created for the purpose (rather than searching
through the entire file system). This very fact, however, also results in a major
drawback: locate is unable to find any files created after the latest update of its
database. The database can be generated by root with updatedb.

updatedb [options]
This command performs an update of the database used by locate. To include
files in all existing directories, run the program as root. It also makes sense to
place it in the background by appending an ampersand (&), so you can immediately
continue working on the same command line (updatedb &). This command
usually runs as a daily cron job (see cron.daily).

find [options]
With find, search for a file in a given directory. The first argument specifies the
directory in which to start the search. The option -name must be followed by a
search string, which may also include wild cards. Unlike locate, which uses a
database, find scans the actual directory.

Commands to Access File Contents
file [options] [files]

With file, detect the contents of the specified files.

-z
Tries to look inside compressed files

cat [options] files
The cat command displays the contents of a file, printing the entire contents to
the screen without interruption.

-n
Numbers the output on the left margin

less [options] files
This command can be used to browse the contents of the specified file. Scroll half
a screen page up or down with PgUp and PgDn or a full screen page down with
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Space . Jump to the beginning or end of a file using Home and End . Press Q
to exit the program.

grep [options] searchstring files
The grep command finds a specific search string in the specified files. If the search
string is found, the command displays the line in which searchstring was
found along with the filename.

-i
Ignores case

-H
Only displays the names of the respective files, but not the text lines

-n
Additionally displays the numbers of the lines in which it found a hit

-l
Only lists the files in which searchstring does not occur

diff [options] file1 file2
The diff command compares the contents of any two files. The output produced
by the program lists all lines that do not match. This is frequently used by program-
mers who need only send their program alterations and not the entire source code.

-q
Only reports whether the two files differ

-u
Produces a “unified” diff, which makes the output more readable

File Systems
mount [options] [device] mountpoint

This command can be used to mount any data media, such as hard disks, CD-ROM
drives, and other drives, to a directory of the Linux file system.

-r
Mount read-only
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-t filesystem
Specify the file system, commonly ext2 for Linux hard disks, msdos for
MS-DOS media, vfat for the Windows file system, and iso9660 for CDs

For hard disks not defined in the file /etc/fstab, the device type must also be
specified. In this case, only root can mount it. If the file system should also be
mounted by other users, enter the option user in the appropriate line in the /etc/
fstab file (separated by commas) and save this change. Further information is
available in the mount(1) man page.

umount [options] mountpoint
This command unmounts a mounted drive from the file system. To prevent data
loss, run this command before taking a removable data medium from its drive.
Normally, only root is allowed to run the commands mount and umount. To
enable other users to run these commands, edit the /etc/fstab file to specify
the option user for the respective drive.

3.3.2 System Commands
The following section lists a few of the most important commands needed for retrieving
system information and controlling processes and the network.

System Information
df [options] [directory]

The df (disk free) command, when used without any options, displays information
about the total disk space, the disk space currently in use, and the free space on all
the mounted drives. If a directory is specified, the information is limited to the
drive on which that directory is located.

-h
Shows the number of occupied blocks in gigabytes, megabytes, or kilobytes—in
human-readable format

-T
Type of file system (ext2, nfs, etc.)
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du [options] [path]
This command, when executed without any parameters, shows the total disk space
occupied by files and subdirectories in the current directory.

-a
Displays the size of each individual file

-h
Output in human-readable form

-s
Displays only the calculated total size

free [options]
The command free displays information about RAM and swap space usage,
showing the total and the used amount in both categories. See Section “The free
Command” (Chapter 10, Special Features of SUSE Linux, ↑Reference) for more
information.

-b
Output in bytes

-k
Output in kilobytes

-m
Output in megabytes

date [options]
This simple program displays the current system time. If run as root, it can also
be used to change the system time. Details about the program are available in the
date(1) man page.

Processes
top [options]

top provides a quick overview of the currently running processes. Press H to
access a page that briefly explains the main options for customizing the program.
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ps [options] [process ID]
If run without any options, this command displays a table of all your own programs
or processes—those you started. The options for this command are not preceded
by hyphen.

aux
Displays a detailed list of all processes, independent of the owner

kill [options] process ID
Unfortunately, sometimes a program cannot be terminated in the normal way. In
most cases, you should still be able to stop such a runaway program by executing
the kill command, specifying the respective process ID (see top and ps). kill
sends a TERM signal that instructs the program to shut itself down. If this does not
help, the following parameter can be used:

-9
Sends a KILL signal instead of a TERM signal, bringing the specified process
to an end in almost all cases

killall [options] processname
This command is similar to kill, but uses the process name (instead of the process
ID) as an argument, killing all processes with that name.

Network
ping [options] hostname or IP address

Theping command is the standard tool for testing the basic functionality of TCP/IP
networks. It sends a small data packet to the destination host, requesting an imme-
diate reply. If this works, ping displays a message to that effect, which indicates
that the network link is basically functioning.

-c number
Determines the total number of packages to send and ends after they have been
dispatched (by default, there is no limitation set)

-f
flood ping: sends as many data packages as possible; a popular means, reserved
for root, to test networks
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-i value
Specifies the interval between two data packages in seconds (default: one
second)

nslookup
The domain name system resolves domain names to IP addresses. With this tool,
send queries to name servers (DNS servers).

telnet [options] hostname or IP address [port]
Telnet is actually an Internet protocol that enables you to work on remote hosts
across a network. telnet is also the name of a Linux program that uses this protocol
to enable operations on remote computers.

WARNING

Do not use telnet over a network on which third parties can “eavesdrop.”
Particularly on the Internet, use encrypted transfer methods, such as ssh,
to avoid the risk of malicious misuse of a password (see the man page for
ssh).

Miscellaneous
passwd [options] [username]

Users may change their own passwords at any time using this command. The ad-
ministrator root can use the command to change the password of any user on the
system.

su [options] [username]
The su command makes it possible to log in under a different username from a
running session. Specify a username and the corresponding password. The password
is not required from root, because root is authorized to assume the identity of
any user. When using the command without specifying a username, you are
prompted for the root password and change to the superuser (root).

-
Use su - to start a login shell for the different user.

halt [options]
To avoid loss of data, you should always use this program to shut down your system.
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reboot [options]
Does the same as halt except the system performs an immediate reboot.

clear
This command cleans up the visible area of the console. It has no options.

3.3.3 For More Information
There are many more commands than listed in this chapter. For information about
other commands or more detailed information, the O'Reilly publication Linux in a
Nutshell is recommended.

3.4 The vi Editor
Text editors are still used for many system administration tasks as well as for program-
ming. In the world of Unix, vi stands out as an editor that offers comfortable editing
functions and is more ergonomic than many editors with mouse support.

3.4.1 Operating Modes
NOTE: Display of Keys

In the following, find several commands that you can enter in vi by just pressing
keys. These appear in uppercase as on a keyboard. If you need to enter a key
in uppercase, this is stated explicitly by showing a key combination including
the Shift key.

Basically, vi makes use of three operating modes: insert mode, command mode, and
extended mode. The keys have different functions depending on the mode. On start-up,
vi is normally set to the commandmode. The first thing to learn is how to switch between
the modes:

Command Mode to Insert Mode
There are many possibilities, including A for append, I for insert, or O for a
new line under the current line.
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Insert Mode to Command Mode
Press Esc to exit the insert mode. vi cannot be terminated in insert mode, so it is
important to get used to pressing Esc .

Command Mode to Extended Mode
The extended mode of vi can be activated by entering a colon (:). The extended or
exmode is similar to an independent line-oriented editor that can be used for various
simple and more complex tasks.

Extended Mode to Command Mode
After executing a command in extended mode, the editor automatically returns to
command mode. If you decide not to execute any command in extended mode,
delete the colon with <— . The editor returns to command mode.

It is not possible to switch directly from insert mode to extended mode without first
switching to command mode.

vi, like other editors, has its own procedure for terminating the program. You cannot
terminate vi while in insertmode. First, exit insertmode by pressing Esc . Subsequently,
you have two options:

1. Exit without saving: To terminate the editor without saving the changes, enter
: – Q – ! in command mode. The exclamation mark (!) causes vi to ignore
any changes.

2. Save and exit: There are several possibilities to save your changes and terminate
the editor. In command mode, use Shift + Z Shift + Z . To exit the program
saving all changes using the extended mode, enter : – W – Q . In extended
mode, w stands for write and q for quit.

3.4.2 vi in Action
vi can be used as a normal editor. In insert mode, enter text and delete text with the
<— and Del keys. Use the arrow keys to move the cursor.

However, these control keys often cause problems, because there are many terminal
types that use special key codes. This is where the command mode comes into play.
Press Esc to switch from insert mode to command mode. In command mode, move
the cursor with H , J , K , and L . The keys have the following functions:
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H
Move one character to the left

J
Move one line down

K
Move one line up

L
Move one character to the right

The commands in command mode allow diverse variations. To execute a command
several times, simply enter the number of repetitions before entering the actual command.
For example, enter 5 L to move the cursor five characters to the right.

A selection of important commands is shown in Table 3.1, “Simple Commands of the
vi Editor” (page 119) This list is far from complete. More complete lists are available
in the documentation found in Section 3.4.3, “For More Information” (page 120)

Table 3.1 Simple Commands of the vi Editor

Change to command modeEsc

Change to insert mode (characters appear at the current cursor
position)

I

Change to insert mode (characters are inserted after the current
cursor position)

A

Change to insert mode (characters are added at the end of the
line)

Shift + A

Change to replace mode (overwrite the old text)Shift + R

Replace the character under the cursorR

Change to insert mode (a new line is inserted after the current
one)

O
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Change to insert mode (a new line is inserted before the current
one)

Shift + O

Delete the current characterX

Delete the current lineD – D

Delete up to the end of the current wordD – W

Change to insert mode (the rest of the current word is overwrit-
ten by the next entries you make)

C – W

Undo the last commandU

Redo the change that was undoneCtrl + R

Join the following line with the current oneShift + J

Repeat the last command.

3.4.3 For More Information
vi supports a wide range of commands. It enables the use of macros, shortcuts, named
buffers, and many other useful features. A detailed description of the various options
would exceed the scope of this manual. SUSE Linux comes with vim (vi improved),
an improved version of vi. There are numerous information sources for this application:

• vimtutor is an interactive tutor for vim.

• In vim, enter the command :help to get help for many subjects.

• A book about vim is available online at http://www.truth.sk/vim/
vimbook-OPL.pdf.

• The Web pages of the vim project at http://www.vim.org feature all kinds
of news, mailing lists, and other documentation.
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• A number of vim sources are available on the Internet:http://www.selflinux
.org/selflinux/html/vim.html,http://www.linuxgazette.com/
node/view/9039, andhttp://www.apmaths.uwo.ca/~xli/vim/vim
_tutorial.html. See http://linux-universe.com/HOWTO/
Vim-HOWTO/vim-tutorial.html for further links to tutorials.

IMPORTANT: The VIM License

vim is “charityware,” which means that the authors do not charge any money
for the software but encourage you to support a nonprofit project with a
monetary contribution. This project solicits help for poor children in Uganda.
More information is available online at http://iccf-holland.org/index
.html, http://www.vim.org/iccf/, and http://www.iccf.nl/.
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4Help and Documentation
SUSE Linux comes with various sources of information and documentation. The SUSE
Help Center provides central access to the most important documentation resources on
your system in searchable form. These resources include online help for installed appli-
cations, manual pages, info pages, databases on hardware and software topics, and all
manuals delivered with your product.

4.1 Using the SUSE Help Center
When you start the SUSE Help Center for the first time from the main menu (SuSE
Help Center) or with the command susehelp in the shell, a window as shown in
Figure 4.1, “The Main Window of the SUSE Help Center” (page 124) is displayed. The
dialog window consists of three main areas:

Menu Bar and Toolbar
The menu bar provides the main editing, navigation, and configuration options.
File contains the option for printing the currently displayed content. Under Edit,
access the search function.Go contains all navigation possibilities: Table of Contents
(home page of the Help Center), Back, Forward, and Last Search Result. With
Settings → Build Search Index, generate a search index for all selected information
sources. The toolbar contains three navigation icons (forward, back, home) and a
printer icon for printing the current contents.

Navigation Area with Tabs
The navigation area in the left part of the window provides an input field for a
quick search in selected information sources. Details regarding the search and the
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configuration of the search function in the Search tab are presented in Section 4.1.2,
“The Search Function” (page 125). The Contents tab presents a tree view of all
available and currently installed information sources. Click the book icons to open
and browse the individual categories.

View Window
The view window always displays the currently selected contents, such as online
manuals, search results, or Web pages.

Figure 4.1 The Main Window of the SUSE Help Center

NOTE: Language Selects View

The documentation available in the SUSE Help Center depends on the current
language. Changing your language changes the tree view.

4.1.1 Contents
The SUSE Help Center provides access to useful information from various sources. It
contains special documentation for SUSE Linux (Start-Up andReference), all available
information sources for your workstation environment, online help for the installed
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programs, and help texts for other applications. Furthermore, the SUSE Help Center
provides access to SUSE's online databases that cover special hardware and software
issues for SUSE Linux. All these sources can be searched comfortably once a search
index has been generated.

4.1.2 The Search Function
To search all installed information sources of SUSE Linux, generate a search index and
set a number of search parameters. To do this, use the Search tab, shown in Figure 4.2,
“Configuring the Search Function” (page 125).

Figure 4.2 Configuring the Search Function

If no search index has been generated, the system automatically prompts you to do so
when you click the Search tab or enter a search string then click Search. In the window
for generating the search index, shown in Figure 4.3, “Generating a Search Index”
(page 126), use the check boxes to determine the information sources to index. The index
is generated when you exit the dialog with Build Index.
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Figure 4.3 Generating a Search Index

To limit the search base and the hit list as precisely as possible, use the three drop-down
menus to determine the number of displayed hits and the selection area of sources to
search. The following options are available for determining the selection area:

Default
A predefined selection of sources is searched.

All
All sources are searched.

None
No sources selected for the search.

Custom
Determine the sources to search by activating the respective check boxes in the
overview.

When you have completed the search configuration, click Search. The relevant items
are then displayed in the view window and can easily be navigated with mouse clicks.
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4.2 Man Pages
Man pages are an essential part of any Linux system. They explain the usage of a
command and all available options and parameters. Man pages are sorted in categories
as shown in Table 4.1, “Man Pages—Categories and Descriptions” (page 127) (taken
from the man page for man itself).

Table 4.1 Man Pages—Categories and Descriptions

DescriptionNumber

Executable programs or shell commands1

System calls (functions provided by the kernel)2

Library calls (functions within program libraries)3

Special files (usually found in /dev)4

File formats and conventions (/etc/fstab)5

Games6

Miscellaneous (including macro packages and conventions), for
example, man(7), groff(7)

7

System administration commands (usually only for root)8

Kernel routines (nonstandard)9

Generally, man pages are delivered with the associated command. They can be browsed
in the help center or directly in a shell. To display a man page in a shell, use the man
command. For example, to display the man page for ls enter man ls. Each man page
consists of several parts labeled NAME, SYNOPSIS, DESCRIPTION, SEE ALSO, LI-
CENSING, and AUTHOR. There may be additional sections available depending on
the type of command. With Q , exit the man page viewer.
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Another possibility to display a man page is to use Konqueror. Start Konqueror and
type, for example,man:/ls. If there are different categories for a command, Konqueror
displays them as links.

4.3 Info Pages
Info pages are another important source of information on your system. Usually they
are more verbose than man pages. You can browse an info page with an info viewer
and display the different sections, called “nodes.” Use the command info for this task.
For example, to view the info page of info itself, type info info in the shell.

For more convenience, use the Help Center or Konqueror. Start Konqueror and type
info:/ to view the top level. To display the info page for grep, type info:/grep.

4.4 The Linux Documentation Project
The Linux Documentation Project (TLDP) is run by a team of volunteers who write
Linux and Linux-related documentation (see http://www.tldp.org). The set of
documents contains tutorials for beginners, but is mainly focused on experienced users
and professional system administrators. TLDP publishes HOWTOs, FAQs, and guides
(handbooks) under a free license.

4.4.1 HOWTOs
HOWTOs are usually a short, informal, step-by-step guide to accomplishing a specific
task. It is written by experts for nonexperts in a procedural manner. For example, how
to configure a DHCP server. HOWTOs can be found in the package howto and are
installed under /usr/share/doc/howto

4.4.2 Frequently Asked Questions
FAQs (frequently asked questions) are a series of questions and answers. They originate
from Usenet newsgroups where the purpose was to reduce continuous reposting of the
same basic questions.

128 Start-Up

http://www.tldp.org


4.5 Wikipedia: The Free Online
Encyclopedia

Wikipedia is “a multilingual encyclopedia designed to be read and edited by anyone”
(see http://en.wikipedia.org). The content of Wikipedia is created by its
users and is published under a free license (GFDL). Any visitors can edit articles, which
gives the danger of vandalism, but this does not repel visitors. With over four hundred
thousand articles, find an answer for nearly every topic.

4.6 Guides and Books
A broad range of guides and books are available for Linux topics.

4.6.1 SUSE Books
SUSE provides detailed and informative books. We provide HTML and PDF versions
of our books in different languages. The PDF file is available on the DVD in the direc-
tory docu. For HTML, install the package suselinux-manual_LANG (replace
LANGwith your preferred language.) After the installation, find them in the SUSE Help
Center.

4.6.2 Other Manuals
The SUSE help center offers additional manuals and guides for various topics or pro-
grams. More can be found athttp://www.tldp.org/guides.html. They range
from Bash Guide for Beginners to Linux FilesystemHierarchy to Linux Administrator's
Security Guide. Generally, guides are more detailed and exhaustive than a HOWTO or
FAQ. They are usually written by experts for experts. Some of these books are old but
still valid. Install books and guides with YaST.
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4.7 Package Documentation
If you install a package in your system, a directory /usr/share/doc/packages/
packagename is created. You can find files from the package maintainer as well as
additional information from SUSE. Sometimes there are also examples, configuration
files, additional scripts, or other things available. Usually you can find the following
files, but they are not standard and sometimes not all files are available.

AUTHORS
The list of the main developers of this package and usually their tasks.

BUGS
Known bugs or malfunctions of this package. Usually also a link to a Bugzilla Web
page where you can search all bugs.

CHANGES, ChangeLog
Summary of changes from version to version. Usually interesting for developers,
because it is very detailed.

COPYING, LICENSE
Licensing information.

FAQ
Question and answers collected from mailing lists or newsgroups.

INSTALL
Procedures for installing this package in your system. Normally you do not need
it, because you have the package installed already.

README, README.*
General information such as how to use it and what you can do with this package.

TODO
Things that are not implemented yet, but probably will be in the future.

MANIFEST
List of files with a brief summary.

NEWS
Description of what is new in this version.
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4.8 Usenet
Created in 1979 before the rise of the Internet, Usenet is one of the oldest computer
networks and still in active use. The format and transmission of Usenet articles is very
similar to e-mail, but is developed for a many-to-many communication.

Usenet is organized into seven topical categories: comp.* for computer-related discus-
sions, misc.* for miscellaneous topics, news.* for newsgroup-related matters,
rec.* for recreation and entertainment,sci.* for science-related discussions,soc.*
for social discussions, and talk.* for various controversial topics. The top levels are
split in subgroups. For instance, comp.os.linux.hardware is a newsgroup for
Linux-specific hardware issues.

Before you can post an article, have your client connect to a news server and subscribe
to a specific newsgroup. News clients include Knode or Evolution. Each news server
communicates to other news servers and exchanges articles with them. Not all news-
groups may be available on your news server.

Interesting newsgroups for Linux users are comp.os.linux.apps,
comp.os.linux.questions, andcomp.os.linux.hardware. If you cannot
find a specific newsgroup, go tohttp://www.linux.org/docs/usenetlinux
.html. Follow the general Usenet rules available online at http://www.faqs
.org/faqs/usenet/posting-rules/part1/.

4.9 Standards and Specifications
There are various sources that provide information about standards or specifications.

http://www.linuxbase.org
The Free Standards Group is an independent nonprofit organization that promotes
the distribution of free software and open source software. The organization endeav-
ors to achieve this by defining distribution-independent standards. The maintenance
of several standards, such as the important LSB (Linux Standard Base), is supervised
by this organization.

http://www.w3.org
The World Wide Web Consortium (W3C) is certainly one of the best-known
standards organizations. It was founded in October 1994 by Tim Berners-Lee and
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concentrates on standardizing Web technologies. W3C promotes the dissemination
of open, license-free, and manufacturer-independent specifications, such as HTML,
XHTML, and XML. These Web standards are developed in a four-stage process
inworking groups and are presented to the public asW3C recommendations (REC).

http://www.oasis-open.org
OASIS (Organization for the Advancement of Structured Information Standards)
is an international consortium specializing in the development of standards for Web
security, e-business, business transactions, logistics, and interoperability between
various markets.

http://www.ietf.org
The Internet Engineering Task Force (IETF) is an internationally active cooperative
of researchers, network designers, suppliers, and users. It concentrates on the de-
velopment of Internet architecture and the smooth operation of the Internet by
means of protocols.

Every IETF standard is published as an RFC (Request for Comments) and is
available free-of-charge. There are six types of RFC: proposed standards, draft
standards, Internet standards, experimental protocols, information documents, and
historic standards. Only the first three (proposed, draft, and full) are IETF standards
in the narrower sense (see http://www.ietf.org/rfc/rfc1796.txt).

http://www.ieee.org
The Institute of Electrical and Electronics Engineers (IEEE) is an organization that
draws up standards in the areas of information technology, telecommunication,
medicine and health care, transport, and others. IEEE standards are subject to a
fee.

http://www.iso.org
The ISO Committee (International Organization for Standards) is the world's largest
developer of standards and maintains a network of national standardization institutes
in over 140 countries. ISO standards are subject to a fee.

http://www.din.de, http://www.din.com
The Deutsches Institut für Normung (DIN) is a registered technical and scientific
association. It was founded in 1917. According to DIN, the organization is “the
institution responsible for standards in Germany and represents German interests
in worldwide and European standards organizations.”
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The association brings together manufacturers, consumers, trade professionals,
service companies, scientists and others who have an interest in the establishment
of standards. The standards are subject to a fee and can be ordered using the DIN
home page.
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Part III. Desktop





5Getting Started with the KDE
Desktop
KDE stands for K Desktop Environment and is a graphical user interface that has many
applications designed to help you in your daily work. This chapter assists you in becom-
ing familiar with the KDE desktop of your Linux system and in performing basic tasks.
KDE also offers many choices to modify your desktop according to your needs and
wishes. Read more about configuring your desktop individually in Chapter 6,Customiz-
ing Your KDE Desktop (page 165).

The following description is based on the default configuration of the KDE desktop
shipped with your product. If you or your system administrator has modified the defaults,
some aspects, such as appearance or keyboard shortcuts, may be different.

5.1 Logging In and Selecting a
Desktop

If more than one user account is configured on your computer, all users must authenti-
cate. When you start your system, you are prompted to enter your username and pass-
word. This is the username and password you created when you installed your system.
If you did not install your system, check with your system administrator for your user-
name and password.

NOTE: Auto Login

If your computer is not run in a networking environment and you are the only
person using it, you can automatically log in to the desktop environment on
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boot. In this case, you do not see any login screen. This feature, called auto
login, can be enabled or disabled during installation or at any time using the
YaST user management module.

The program managing the login process depends on the desktop environment installed
on your system. For KDE, it is KDM.

The KDM login screen has input fields for username and password and the following
menu items:

Session Type
Specifies the desktop to run when you log in. If desktops other than KDE are in-
stalled, they appear in the list. Make changes only if you want to use a session type
other than your default (usually KDE). Future sessions are automatically of the
same type unless you change the session type manually.

System
Performs a system action, such as shutting down the computer or starting different
login actions. Remote Login enables you to log in on a remote machine.

5.1.1 Controlling a Session
The Session Manager starts after your username and password are authenticated by the
login process. The Session Manager lets you save certain settings for each session. It
also lets you save the state of your most recent session and return to that status the next
time you log in.

The Session Manager can save and restore the following settings:

• Appearance and behavior settings, such as fonts, colors, and mouse settings.

• Applications that you were running, such as a file manager or OpenOffice.org.

IMPORTANT: Saving and Restoring Applications

You cannot save and restore applications that Session Manager does not
manage. For example, if you start the vi editor from the command line in
a terminal window, Session Manager cannot restore your editing session.
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For information about configuring session preferences, see Section 6.2.4, “KDE Com-
ponents” (page 170).

5.1.2 Switching Desktops
If you installed both the KDE and the GNOME desktops, use the following instructions
to switch desktops.

1 If you are logged in to KDE, select Log Out → End Current Session from the
main menu. On the login screen, click Session Type.

2 Select the GNOME desktop then click OK.

3 Enter your username.

4 Enter your password.

5 ClickMake Default to make the desktop you chose in Step 2 (page 139) your new
default desktop or click Just For This Session to leave your previous desktop as
the default the next time you log in.

See Chapter 7, Getting Started with the GNOME Desktop (page 175) for more
information about using the GNOME desktop.

5.1.3 Locking Your Screen
To lock the screen, do either of the following:

• From the main menu, select Lock Session.

• Use the keyboard shortcut defined in the Control Center (see Section 6.2.7, “Re-
gional & Accessibility” (page 171)). Usually, this is Ctrl + Alt + L .

TIP: Looking Up and Defining KDE Keyboard Shortcuts

If you want to look up the keyboard shortcuts defined in KDE, select Per-
sonal Settings → Regional & Accessibility → Keyboard Shortcuts from the
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main menu. Alter a shortcut by double-clicking it and entering a new
shortcut. See also Section 6.2.7, “Regional & Accessibility” (page 171).

For quick access, you can also add the Lock and Logout icons to the panel. To do so,
right-click the panel then click Add to Panel → Applet → Lock/Logout Applet.

When you lock your screen, the screensaver starts. To unlock the screen, move your
mouse to display the locked screen dialog. Enter your username and password then
press Enter .

For information about configuring your screensaver, see Section 6.2.1, “Appearance
& Themes” (page 167).

5.2 Logging Out
When you are finished using the computer, you can log out and leave the system running
or restart or shut down the computer. If your system provides power management, you
can also suspend the computer, making the next system start much faster than a complete
boot.

To log out and leave the system running, do one of the following:

• From the main menu select Log Out → End Current Session.

• Use the keyboard shortcut that is defined in the Control Center Section 6.2.7,
“Regional & Accessibility” (page 171). Usually, this is Ctrl + Alt + Del . Then
click End Current Session.

• Click the Logout icon in the panel. If your panel does not include the logout icon,
you can add it to the panel as described in Section 5.1.3, “Locking Your Screen”
(page 139).

5.3 Desktop Components
The graphical desktop environment should not pose any problems for former Windows
or Macintosh users. The main components of the desktop are the icons on the desktop
and the panel at the bottom of the screen.
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Figure 5.1 An Example KDE Desktop

Desktop icons represent files, directories, applications, functions, and removable media,
like CDs or DVDs.

For information about configuring your desktop elements, see Chapter 6, Customizing
Your KDE Desktop (page 165).

The panel (in KDE also called “Kicker”) is a bar, typically located at the top or the
bottom of the screen. It is designed to provide all vital information needed about running
applications or the system and easy access to some important functions or applications.
If you hold your pointer over an icon, a short description is displayed.

Figure 5.2 KDE Panel (Kicker)

The panel typically consists of the following areas:

Main Menu Icon
By default, the left end of the panel has an icon that opens the main menu, similar
to the start button on the MS Windows desktop. The main menu has a well-ordered
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structure for accessing the main applications. It also contains menu items for major
functions like logging out or searching for applications. See Section 5.3.3, “Access-
ing the Main Menu” (page 143).

Quick Launcher
Next to the main menu icon, find the quick launcher. It holds some icons for the
most important functions or applications to enable you to start them without going
through the main menu. It also contains an icon for the SUSE Help Center, which
provides online help for your system. See Chapter 4, Help and Documentation
(page 123).

Desktop Previewer
Next to the quick launcher, find the desktop previewer, which shows your different
desktops. These virtual desktops enable you to organize your work. If you use many
programs simultaneously, you might want to run some programs in one desktop
and other programs in the other desktop. To switch between desktops, click the
desktop symbol in the panel.

Taskbar
The taskbar is located next to the desktop previewer. By default, all started appli-
cations are displayed in the taskbar, which allows you to access any application
regardless of the currently active desktop. If you click a window title in the taskbar,
the application is moved to the foreground. If it is already in the foreground,
clicking minimizes the application.

System Tray
The rightmost part of the panel usually holds the system clock, the volume control,
and several other helper applications.

For information about configuring your panel, see Changing Panel Elements (page 166).

5.3.1 Managing the Trash Bin
The trash bin is a directory for files marked for deletion. Drag icons from the file
manager or the desktop to the trash bin icon by keeping the left mouse button pressed.
Then release to drop them there. Alternatively, right-click an icon and select Move to
Trash from the menu. Click the trash bin icon to view its contents. You can retrieve an
item from the trash if desired.
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Files removed with Delete are not moved to the trash bin, but deleted completely. To
delete the files in the trash bin completely, right-click the trash bin icon then click
Empty Trash Bin.

5.3.2 Accessing CD-ROM, DVD-ROM, and
Floppy Disks

To access data on removable media, click My Computer on the desktop then click the
desired drive.

If you click an icon when a media is available, the file manager starts and displays the
contents. Display a menu with various options by right-clicking the individual icons.
It is also possible to move a file to a different location, such as to the desktop or your
home directory, by simply keeping the left mouse button pressed and dragging the file
to the appropriate location. You are asked whether you want to move or copy the file
or create a link. You can also copy or move files from your home directory to a floppy
disk.

5.3.3 Accessing the Main Menu
Open the main menu by clicking the icon to the far left of the panel. Alternatively, press
Alt + F1 . The main menu is subdivided into these sections: Most Used Applications,
All Applications (a menu with all applications sorted according to categories), and Ac-
tions. Applications that you start most often appear in the Most Used Applications
section.

If you know the name of an application (or at least a part of its name) but are not sure
how to start it from the main menu, you can use the search function provided in the All
Applications section.
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Figure 5.3 Main Menu Search Function

Just type a part of the application name into the search field without pressing the Enter
key afterwards. If the application is installed on your system, the menu structure leading
to this application is highlighted in the main menu.

5.4 Managing Folders and Files with
Konqueror

Konqueror is a unified Web browser, file manager, document viewer, and image
viewer. The following sections covers using Konqueror for file management. For infor-
mation about Konqueror as a Web browser, see Chapter The Web Browser Konqueror
(↑Applications).

Start Konqueror as a file manager by clicking the house icon in the panel. Konqueror
displays the contents of your home directory.
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Figure 5.4 The File Manager Konqueror

The Konqueror file manager window consists of the following elements:

Menu Bar
The menu bar holds menu items for actions like copying, moving, or deleting files,
changing views, starting additional tools, defining your settings, and getting help.

Toolbar
The toolbar provides quick access to frequently used functions that can also be
accessed via the menu. If you hover the pointer over an icon, a short description is
displayed. To the right, the toolbar features the Konqueror icon, which is animated
while a directory or Web page is loaded.

Location Bar
The location bar shows the path to your directory or file in your file system. You
can enter a path to a directory directly by typing it in or by clicking one of the di-
rectories in the display field. Delete the contents of the line by clicking the black
symbol with a white X located left of the location bar. After typing an address,
press Enter or click Go to the right of the input line.

Unlike a Windows operating system, Linux does not use drive letters. In Windows,
you would address the floppy drive as A:\, Windows system data is under C:\,
and so on. In Linux, all files and directories are located in a tree-like structure. The
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topmost directory is referred to as the file system root or just /. All other directories
can be accessed from it. In the following, find a short overview of the most important
directories in a Linux file system:

/home holds the private data of every user who has an account on your system.
The files located here can only be modified by their owner or the system adminis-
trator. Your e-mail directory is located here, for example.

NOTE: Home Directory in a Network Environment

If you are working in a network environment, your home directory may
not be called /home but can be mapped to any directory in the file system.

/media generally holds any type of drive except the hard drive of your system.
Your USB flash drive appears under /media once you have connected it, as do
your digital camera (if it uses USB) and DVD or CD drive.

Under /usr/share/doc, find any kind of documentation on your Linux system
and the installed packages. The manual subdirectory holds a digital copy of this
manual as well as the other manuals and the release notes of the installed version
of your Linux system. The packages directory holds the documentation included
in the software packages.

/windows only appears if you have both MS Windows and Linux installed on
your system. It holds the MS Windows data.

Learn more about the Linux file system concept and find a more comprehensive
list of directories in Section 3.1.2, “Linux Directory Structure” (page 93).

Navigation Panel
You can hide and show the navigation panel by pressing F9 . The navigation
panel displays your information in a tree view. Determine which contents you want
to see by clicking one of the symbols in the tab at the left of the navigation panel.
If you hold your mouse pointer over an icon, a short description is displayed. For
example, you can show the file system as a tree starting at the root folder or at your
home folder.

Display Field
The display field shows the contents of the selected directory or file. In the View
menu, choose between different view modes to display the contents, such as Icon
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View, Tree View, or Detailed List View. If you click a file, Konqueror shows a
preview of the the contents or loads the file into an application for further processing.
If you hold the mouse pointer over the file, Konqueror shows a tooltip with detailed
information on the file, such as owner, permissions, or last modification date.

5.4.1 Copying, Moving, or Deleting Files
For performing actions like copying, moving, or deleting files, you need appropriate
permissions to the folders and files involved in your action. Read more about file system
permissions in Section 3.2, “Users and Access Permissions” (page 102).

TIP: Selecting Objects in Konqueror

Clicking a file or a folder in Konqueror directly starts an action: a preview of
the file is displayed or the folder is opened. To former users of MS Windows,
this behavior may be rather unusual. If you just want to select one or several
files without any other action, press Ctrl then click the object. Alternatively,
alter your mouse settings in the Control Center (see Section 6.2.7, “Regional
& Accessibility” (page 171)).

To copy or move a file or folder, proceed as follows:

1 Right-click the object and select Copy To or Move To from the context menu.

2 If you want to copy or move the object to one of the folders offered in the sub-
menu, select the corresponding menu item and click Copy Here or Move Here.
Destination folders you have already used are listed in lower part of the submenu.

3 To copy or move the object to a different folder select Browse. A tree view of
your file systems opens where you can select the destination folder.

The quickest way to perform actions like copying or moving objects in Konqueror is
the drag-and-drop method. For instance, you can easily move objects from one window
to another by simply dragging them. When dropping the object, you are asked whether
the objects should be moved or copied.

To delete a file or folder, proceed as follows:
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• Select the object and press Del or right-click the file then select Move to Trash
from the context menu. The object is moved to the trash bin. If necessary, you can
restore the file or folder from there or delete it completely. See also Section 5.3.1,
“Managing the Trash Bin” (page 142).

• To delete the object irretrievably, click Edit → Delete or press Shift + Del .

5.4.2 Creating a New Folder
To create a new folder in Konqueror, proceed as follows:

1 Right-click the folder to which to add a subfolder.

2 Select Create New Folder.

3 In the New Folder dialog, enter a name for the new folder and click OK.

5.4.3 Changing File Associations
With Konqueror, you can decide which application should be used to open a file.
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Figure 5.5 Configuring File Associations in Konqueror

1 In Konqueror, click Settings → Configure Konqueror → File Associations.

2 To search for an extension, enter the extension in Find Filename Pattern. Only
file types with a matching file pattern appear in the list. For example, to modify
the application for *.png files, enter png in Find Filename Pattern.

3 In the Known Types list, click the file type to open the setting dialog for this file
type. You can change the icon, the filename patterns, description, and the order
of the applications.

If your tool is not listed, click Add in Application Preference Order then enter
the command.

To change the order of the list entries, click the program to move then give it a
higher or lower priority by clicking Move Up or Move Down. The application
listed at the top is used by default when you click a file of this type.

4 If you need a file type that is not listed in the Known Types list, click Add to open
a dialog where you can select a group and enter a type name.
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The group determines the main type, for example, audio, image, text, or video.
Your file type can usually be assigned to one of these.

a Click OK then determine the extensions of the filename.

b Specify a description in the text field and select which application to use.

5 Click OK.

5.5 Opening or Creating Documents
with OpenOffice.org

The office suite OpenOffice.org offers a complete set of office tools including a word
processor, spreadsheet, presentation, vector drawing, and database components. As
OpenOffice.org is available for a number of operating systems, you can use the same
data across different computing platforms. You can also open and edit files in Microsoft
Office formats then save them back to this format, if needed.

To start OpenOffice.org, press Alt + F2 and enter OOo or click the Office icon on
the desktop.

For a more in-depth introduction to OpenOffice.org, see Chapter The OpenOffice.org
Office Suite (↑Applications) or view the help in an OpenOffice.org program.

5.6 Finding Something on Your
Computer

For searching files, use the application KFind. Start it from the main menu with Find
Files/Folders. Alternatively, press Alt + F2 and enter kfind. With KFind, you can
locate files on your computer using a variety of search criteria, such as file content,
dates, owner, or file size.
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Figure 5.6 Finding Files

5.6.1 Finding Files
To perform a search for certain filenames, proceed as follows:

1 Start KFind from the main menu or command line.

2 Click the Name/Location tab to perform a basic search.

3 Specify the name of the file to find in Named. You can use the following wild
cards:

Asterisk
The asterisk (*) stands for any number of missing characters (even zero).
For example, searching for marc* can find the files marc, marc.png, and
marc_must_not_read_this.kwd. Searching for mar*.kwd can find market-
place.kwd and marc_must_not_read_this.kwd.

Question Mark
The question mark (?) stands for exactly one character. For example,
searching for mar? can find marc, but marc? cannot find anything if your
files are named marc and marc.png. You can put as many question marks
in the search term as you want. It finds exactly that number of characters.

You can combine those two wild card symbols in any search term.
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4 Specify the folder to search in Look In or click Browse to find the folder you
want. Select Include Subfolders to also search all subfolders starting from your
specified folder.

5 Press Enter or click Find.

5.6.2 Performing an Advanced File Search
For a more detailed search, you can also specify further options, such as a text the file
to find must contain:

1 Start KFind from the main menu or the command line.

2 Click the Name/Location tab.

3 Specify the name of the file to find in Named.

4 Specify the folder where you want to search in Look In or click Browse to find
the folder.

5 Click the Contents tab.

6 In File Type, specify the type of file to find.

7 In Containing Text, enter the word or phrase the file you are searching for must
contain.

8 If you want to specify further options, click the Properties tab and choose the
options you want. If you hold the mouse pointer over the options or fields, a short
description is displayed.

9 Click Find to perform the search.

For detailed information about the search options available, refer to the KFind online
help.

For advanced searches, you may want to use search patterns or regular expressions.
KRegExpEditor offers search options based on regular expressions. You can install
KRegExpEditor with YaST as the packagekdeutils3-extra. For more information
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about search patterns and the use of wild cards or regular expressions, refer to Sec-
tion 3.1, “Getting Started with the Bash Shell” (page 90).

5.7 Exploring the Internet
In KDE, the default Web browser is Konqueror. To start Konqueror, click the Konqueror
icon on the panel or press Alt + F2 and enter konqueror. Learn more about
Konqueror as a Web browser in Chapter The Web Browser Konqueror (↑Applications).

In addition to Konqueror, you can use a Mozilla-based browser, Firefox. Start Firefox
from the main menu or by pressing Alt + F2 and entering firefox. You can type
an address into the location bar at the top or click links in a page to move to different
pages, just like in any other Web browser. For more information about Firefox, see
Chapter The Web Browser Firefox (↑Applications) .

5.8 E-Mail and Scheduling
KMail is an e-mail client that supports e-mail protocols like POP3 and IMAP. It also
has multiple e-mail account support, powerful filters, PGP/GnuPG privacy, and online
attachments. Start KMail from the main menu or press Alt + F2 and enter kmail.

Kontact is a personal information management (PIM) tool that combines well-known
applications like KMail, KOrganizer, and KAddressBook into a single interface. This
lets you have easy access to your e-mail, calendar, address book, and other PIM func-
tionality. To launch Kontact, press Alt + F2 and enter kontact. For detailed infor-
mation about using Kontact, see Chapter Kontact: An E-Mail and Calendar Program
(↑Applications).

5.9 Moving Text between Applications
To copy text to the clipboard and insert it again, former MS Windows users automati-
cally try the shortcut keys Ctrl + C and Ctrl + V , which often work in Linux as
well. But copying and inserting texts is even easier in Linux: to copy a text to the clip-
board, just select the text with the mouse then move the mouse cursor to the position
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where you want the text copied. Click the middle button on the mouse to insert the text
(on a two-button mouse, press both mouse buttons simultaneously).

With some applications, if a text is already selected in the application where you want
to insert the text, this method does not work because the text in the clipboard is over-
written by the other selected text. For such cases, the KDE application Klipper is very
useful. Klipper “remembers” the last entries you have moved to the clipboard. By default,
Klipper is started when KDE is loaded and appears as a clipboard icon in the panel. To
view the clipboard contents, click the Klipper icon. The most recent entry is listed on
top and is marked as active with a black check mark. If an extensive text was copied
to Klipper, only the first line of the text is displayed.

To copy an older text fragment from Klipper to an application, select it by clicking it,
move the mouse pointer to the target application, then middle-click. For further infor-
mation about Klipper, see the Klipper online help.

5.10 Important Utilities
The following pages introduce a number of small KDE utilities intended to assist in
daily work. These applications perform various tasks, such as managing your Internet
connections and your passwords, creating data archives, and viewing PDF files.

5.10.1 Managing Internet Connections with
KNetworkManager

You can establish Internet connections with NetworkManager or KInternet. For a de-
scription of KInternet, see Chapter Managing Internet Connections with KInternet
(↑Applications). In YaST, select whether to use NetworkManager. For a list of criteria
that help you to decide whether to use NetworkManager or other applications and for
further information, refer to Section “Managing Network Connections with Network-
Manager” (Chapter 18, Basic Networking, ↑Reference) and Section “Integration in
Changing Operating Environments” (Chapter 30, Mobile Computing with Linux,
↑Reference).

When NetworkManager is enabled, you can monitor your network connections in KDE
with the KNetworkManager applet. Click the KNetworkManager icon in the system
tray to see a list of available network connections, such as wired, wireless, dial-up, or
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VPN. NetworkManager automatically chooses the best network available, but it can
only automatically connect to a known network. The connection currently used is
marked in the list. To activate a different connection, just click another connection. For
some connections, such as WLAN, you may be prompted for additional information,
such as network name, password or passphrase, and encryption details. Network con-
nections are managed by user and the passwords are stored in KWallet.

5.10.2 Managing Passwords with KWallet
Manager

Remembering all the passwords for protected resources to which you need to log in
can be problematic. KWallet remembers them for you. It collects all passwords and
stores them in an encrypted file. With a single master password, open your wallet to
view, search, delete, or create entries. Normally you do not need to insert an entry
manually. KDE recognizes if a resource requires authentication and KWallet starts au-
tomatically.

IMPORTANT: Protect Your KWallet Password

If you forget your KWallet password, it cannot be recovered. Furthermore,
anyone who knows your password can obtain all information contained in the
wallet.

Starting KWallet
When KWallet starts for the first time (for example, when you access a Web site where
you must enter a password to log in), a dialog appears with the welcome screen. Choose
between Basic setup (recommended) and Advanced setup. If you choose Basic setup,
in the next screen you can choose whether to store personal information. Some KDE
applications, such as Konqueror or KMail, can use the wallet system to store Web form
data and cookies. Select Yes, I wish to use the KDE wallet to store my personal infor-
mation for this purpose and leave with Finish.

If you choose Advanced setup, you have an additional security level screen. The default
settings are generally acceptable for most users, but others may wish to change them.
Automatically close idle wallets closes wallets after a period of inactivity. To separate
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network passwords and local passwords, activate Store network passwords and local
passwords in separate wallet files. Close with Finish.

You can alter the settings at any time by right-clicking the KWallet icon in the panel
and selectingConfigureWallet. A dialog box opens where you can select several options.
By default, all passwords are stored in one wallet, kdewallet, but you can also add new
wallets. Once configured, KWallet appears in the panel.

The KWallet Manager
To store data in your wallet or view its contents, click the KWallet icon in the panel.
A dialog box opens, showing the wallets that are accessible on your system. Click the
wallet to open. A window prompts for your password.

After a successful login, the KWallet Manager window opens. It is divided into four
different parts: the top left part displays a summary, the top right part displays subfolders,
the lower left part shows a list with folder entries, and the lower right part shows the
contents of a selected entry.

In the KWallet Manager, you can change your master password for KWallet at any
time with File → Change Password.

Figure 5.7 The KWallet Manager Window

You can add or delete folders. Selecting a folder updates the folder entry list and the
summary display. Selecting a folder entry updates the entry contents pane and allows
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you to edit that entry. Entries can also be created or deleted using the context menu for
the folder contents.

Copying Your Wallet to Another Computer
For the most part, KWallet resides silently in the panel and is automatically activated
if needed. However, you can copy your wallet files to another computer (for example,
your laptop). To simplify this task, wallets can be dragged from the manager window
to a file browser window. This let you easily package a new wallet for transfer to another
environment. For example, a new wallet could be created and copied onto a removable
flash memory device. Important passwords could be transferred there, so you have them
available in other locations.

5.10.3 Displaying, Decompressing, and
Creating Archives

To save space on the hard disk, use a packer that compresses files and directories to a
fraction of their original size. The application Ark can be used to manage such archives.
It supports common formats, such as zip, tar.gz, tar.bz2, lha, and rar.

Start Ark from the main menu or from the command line with ark. If you already have
some compressed files, move these from an open Konqueror window to the Ark window
to view the contents of the archive. To view an integrated preview of the archive in
Konqueror, right-click the archive in Konqueror and select Preview in Archiver. Alter-
natively, select File → Open in Ark to open the file directly.
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Figure 5.8 Ark: File Archive Preview

Once you have opened an archive, perform various actions. Action offers options such
as Add File, Add Folder, Delete, Extract, View, Edit With, and Open With.

To create a new archive, select File → New. Enter the name of the new archive in the
dialog that opens and specify the format using Filter. After confirming with Save or by
pressing Enter , Ark opens an empty window. You can drag and drop files and directo-
ries from the file manager into this window. As the final step, Ark compresses everything
into the previously selected archive format. For more information about Ark, select
Help → Ark Handbook.

5.10.4 Managing Print Jobs in KDE
Printers can either be connected to your system locally or via a network. Either kind of
configuration is made initially using YaST. For an in-depth coverage of printer confi-
guration, see Chapter Printer Operation (↑Reference). As soon as a connection has
been established, you can start using the printer.

To control print jobs in KDE, use two different applications. Start and configure the
print job with KPrinter then control the processing of the print job with KJobViewer.

Start KPrinter with kprinter from the command line. A small window opens in
which to choose a printer and edit the Properties of your print job, such as page orien-
tation, pages per sheet, and duplex printing. To specify the file to print, the number of
copies, and various other options, click Expand at the bottom left. The window then
expands and shows four tabs: Files, Copies, Advanced Options, and Additional Tags.
See Figure 5.9, “Starting a Print Job with KPrinter” (page 159).
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Figure 5.9 Starting a Print Job with KPrinter

The first tab, Files, determines the file or files to print. Either drag them from the
desktop and drop them into the list window or use the file dialog to locate them. Copies
determines the page selection (all pages of the selected document, the currently selected
one, or a range) and the number of copies. You may also choose to print only the even
or only the odd numbered pages of the selected document. Use Advanced Options to
specify any additional information for the print job. Enter any Billing information if
needed or set a custom page label at the top and bottom of the page. The Job Priority
can also be set here. The fourth tab, Additional Tags is rarely needed. Once your print
job has been filed, you can watch its progress using KJobViewer.

TIP: Printing from KDE Applications

The KPrinter dialog opens any time you print from a KDE application. The dialog
is basically the same except for the lack of the Files tab, which is not needed
because the file to print was determined when you selected Print.
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Start KJobViewer from the main menu or with kjobviewer from the command line.
A window like that in Figure 5.10, “Managing Print Jobs with KJobViewer” (page 160)
opens, listing all the print jobs queued on your printer. As long as your print job is not
active, you can edit it. Do this using the entries of the Jobs menu.

Figure 5.10 Managing Print Jobs with KJobViewer

If, for example, you want to check if you sent the correct document to the printer, you
can stop the job and resume it if you decide to print it. Remove your own print jobs
from the queue with Remove. To change the printer, select a different printer with Move
to Printer.

With Restart, reprint a document. To do this, select Filter → Toggle Completed Jobs,
select the desired document, and click Jobs→ Restart. Clicking Jobs→ Job IPP Report
shows the technical details of a job. Use Jobs→ Increase Priority and Jobs→Decrease
Priority to set the priority, depending on how quickly you need the document.

Filter enables you to switch between various printers, toggle completed jobs, and limit
the view to your own print jobs by selecting Show Only User Jobs. The current user is
then displayed in the top right field.

Settings → Configure KJobViewer opens a configuration dialog. Here, determine the
maximum number of print jobs to display. Enter a number in the field or use the slider
to the right to determine a value. Press OK to save the setting or Cancel to exit the dialog
without saving.

The icons in the toolbar correspond to the functions you can access by way of the menu.
A help text explaining the function is displayed when you move the mouse pointer over
one of the icons.
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The job list consists of eight columns. The job ID is automatically assigned by the print
system to identify the various jobs. The next column contains the login of the user who
sent the job followed by the filename of the document. The status column indicates
whether a job is still in the queue, currently being printed, or already completed. Next,
the size of the document is displayed in kilobytes and number of pages. The default
priority of 50 can be increased or reduced if necessary. Billing information can be cost
centers or other company-specific information. If you right-click a job in the list, the
Jobs menu opens under the mouse pointer, allowing you to select an action. Only a few
functions are available for completed jobs. If you activate Keep window permanent,
KJobViewer opens automatically the next time you log in.

5.10.5 Taking Screen Shots
With KSnapshot, you can create snapshots of your screen or individual application
windows. Start the program from the main menu or by pressing Alt + F2 and entering
ksnapshot. The KSnapshot dialog consists of two parts. The upper area (Current
Snapshot) contains a preview of the current screen and three buttons for creating and
saving the screen shots. The lower area contains further options for the actual creation
of the screen shot.

Figure 5.11 KSnapshot

To take a screen shot, use Snapshot Delay to determine the time (in seconds) to wait
between clicking New Snapshot and the actual creation of the screen shot. If Only Grab
the Window Containing the Pointer is selected, only the window containing the pointer
is saved. To save the screen shot, click Save Snapshot and designate the directory and
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filename for the image in the subsequent dialog. Click Print Snapshot to print the screen
shot.

You can also use The GIMP to take screen shots. To open The GIMP, press Alt +
F2 and enter gimp. When you run GIMP for the first time, it installs some files in
your home directory and displays dialogs that give you the opportunity to adapt it to
your environment. For information about using The GIMP, refer to ChapterManipulating
Graphics with The GIMP (↑Applications) or see its help. You may need to install the
help with YaST (kdeutils3-extra).

5.10.6 Viewing PDF Files with KPDF
PDF is probably one of more important formats. KPDF is a KDE program that can view
and print them.

Start KPDF by pressing Alt + F2 and entering kpdf. Load a PDF file with File →
Open. KPDF displays it in its main window. On the left side, there is a sidebar with
thumbnails and a contents view. Thumbnails give an overview of the page. The contents
view contains bookmarks to navigate in your document. Sometimes it is empty, meaning
bookmarks are not supported by this PDF.

To view two pages in the main window, select View → Two Pages. The view depends
on what last two options you activate in the View menu.

Another nice option is to select the area in which you are interested with the select tool
from the toolbar. Draw a rectangle and choose from the pop-up menu whether you need
the selected area as text or as a graphic. It is copied to the clipboard. You can even save
the area to a file.

5.10.7 Font Administration with KFontinst
By default, SUSE Linux provides various fonts commonly available in different file
formats (Bitmap, TrueType, etc.). These are known as system fonts. Users can addition-
ally install their own fonts from various collections on CD-ROM. Such user-installed
fonts are, however, only visible and available to the corresponding user.
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The KDE control center provides a comfortable tool for administering system and user
fonts. It is shown in Figure 5.12, “Font Administration from the Control Center”
(page 163).

Figure 5.12 Font Administration from the Control Center

To check which fonts are currently available, type the URL fonts:/ into the address
field of a Konqueror session. This displays two windows: Personal and System.
User-installed fonts are installed to the folder Personal. Only root can install to the
System folder.

To install fonts as a user, follow these steps:

1. Start the Control Center and access the appropriate module with System Admin-
istration → Font Installer.

2. Choose Add Fonts from the toolbar or from the menu available when right-
clicking the list.

3. In the dialog that opens, select one or more fonts for installation.

4. The marked fonts are then installed to your personal font folder. Selecting a font
shows a preview.
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To update system fonts, first select Administrator mode and enter your root password.
Then proceed as described for user font installation.

5.11 Obtaining Software Updates
Click the ZENworks updater in your panel to install additional software and apply se-
curity updates. Select the software packages to install from the list then click Update.
For background information and configuration options, see Section 2.12, “Update from
the Command Line” (page 76).

5.12 For More Information
As well as the applications described here for getting started, KDE can run a lot of
other applications. Find detailed information about many important applications in the
Applications manual.

• To learn more about KDE and KDE applications, also refer to http://www.kde
.org/ and http://www.kde-apps.org/.

• To report bugs or add feature requests, go to http://bugs.kde.org/.
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6Customizing Your KDE Desktop
You can change the way your KDE desktop looks and behaves to suit your own personal
tastes and needs. If you only want to change the appearance of individual desktop objects,
you can usually access a configuration dialog by right-clicking the object. For customiz-
ing certain groups of desktops elements or changing the overall appearance of your
KDE desktop, refer to Section 6.2, “Configuring Your Desktop with the Control Center”
(page 166).

6.1 Changing Individual Desktop Icons
In the following, find some examples of how to change individual desktops elements.

Procedure 6.1 Creating New Desktop Objects

To add a new desktop object, proceed as follows:

1 Right-click an empty space on the desktop and select Create New.

2 From the submenu, choose the type of object to create on the desktop: a folder,
file, or one of several types of links.

3 Enter the name of the new object when prompted to do so.

4 To change the properties of the new object, right-click the new icon and select
Properties. A dialog appears, showing four tabs where you can change the
properties of the object, such as the permissions.
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5 Apply your changes and leave the dialog with OK.

Procedure 6.2 Changing Panel Elements

Add new elements to the quick launch area and the system tray in the panel as follows:

1 Right-click an empty patch of the panel.

2 To add a new application to the panel:

a From the context menu, select Add Application to Panel.

b Select the application to add from one of the categories of the submenu.

c Move the button to the desired position by dragging and dropping it with
the mouse.

d To change the icon for the application, right-click the button and select
Configure Application Button. By clicking the application icon in the dialog
box that appears, open a new window in which to select a different icon.

3 To add a new applet to the panel:

a From the context menu select Add Applet to Panel.

b In the dialog box that appears, you can restrict the number of applets shown
by selecting a special type of applet in Show or by typing a part of the applet
name in Search.

c Select the applet to add and click Add to Panel. The applet is inserted into
the panel.

6.2 Configuring Your Desktop with
the Control Center

With KDE, you can personalize your desktop to a very high degree. You can change a
variety of settings, such as the desktop background, screen saver, fonts, keyboard and
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mouse configuration, and sounds. Adjust these settings with the modules of the KDE
Control Center. Start the Control Center from the main menu or press Alt + F2 and
enter kcontrol.

The side bar provides different categories with a subset of settings each. Just click a
category icon and explore the possibilities provided there. You can always return to
the higher-level category by clicking Back. For an overview of all categories, switch
to a tree view. Change the view by selecting View → Mode → Tree View.

Clicking an item displays the corresponding settings on the right. Change the settings
as desired. No changes take effect until you click Apply. If you have changed an option
then decide that you want to leave the settings as they were, click Reset to discard the
changes. Reset all items on the page to the default values by clickingDefault. Changing
some settings may require root permissions. Log in as root if prompted to do so.

The following sections introduce the major categories and contain procedures for some
common changes you may want to apply to your KDE desktop. Detailed information
about the settings of each category is provided by the Help button on each page of set-
tings or in the help center.

6.2.1 Appearance & Themes
This category lets you change the way your KDE desktop and applications look. You
can access a number of settings.

Background holds options for the background of your desktop, such as colors, pictures,
or slide shows. If you configured multiple virtual desktops, you can set different options
for each. See Section 6.2.2, “Desktop” (page 168).

Colors lets you manage and edit color schemes for your desktop. There are a variety
of color schemes installed by default but you can also create your own color scheme
using a predefined scheme as starting point.

With Fonts, all fonts and font attributes used on the KDE desktop can be configured.
You can also modify antialiasing settings. By default, antialiasing is activated for all
fonts. Antialiasing is a software technique for diminishing jagged edges that should be
smooth. Although it reduces the jagged appearance of the lines, it also makes them
fuzzier. To deactivate or customize antialiasing, select the corresponding options.
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In the Icons section, control the icon style for the entire KDE desktop. Icons are used
on the desktop, panel, and toolbars of applications. You can choose icon themes, adjust
icon sizes, assign effects to icons (for example, you can make them semitransparent or
colorize them), and configure settings for each of the different places icons are used.

Launch Feedback allows you to modify what kind of cursor and taskbar feedback you
want for starting applications. For example, instead of a bouncing cursor indicating that
an application is loading, you can set a blinking cursor.

A screen saver automatically appears if you do not use your computer for a specific
time. In the Screensaver section, change the screen saver or configure the time-out before
it starts.

In the Splash Screen section, you can change the splash screen that displays on KDE
start-up.

Style holds options for user interface elements (called widgets) in KDE, such as buttons,
menus, and scroll bars. You can choose a certain style and see a preview of it.

With Theme Manager, choose, install, or modify configuration sets (themes) for your
KDE desktop.

Window Decorations provides options for the title bar of the windows and the style of
the borders around windows.

6.2.2 Desktop
The Desktop settings configure the appearance and behavior of your KDE desktop.

In Behavior, configure options such as showing or hiding desktop icons, showing tool
tips, and icon layout. You can also specify if you want to see previews of particular file
types on the desktop and which devices have icons.

InMultiple Desktops, increase or reduce the number of virtual desktops to use and enter
a name for each desktop. By default, two virtual desktops are configured on your system.
You can switch between the desktops with the desktop previewer in the panel or by
using the mouse wheel.

Panels controls panel options such as size, position, length, and display. You can also
change the appearance of the panel with transparency, background images, and icon
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zooming. Because the main menu is also part of the panel, also configure various menu
options here, including the applications shown in your main menu.

In the Taskbar section, configure options such as whether to show windows from all
desktops on the taskbar, grouping of similar tasks, and what action on the taskbar your
mouse buttons trigger.

Window Behavior customizes the default KDE window manager, kwin. Here, control
what happens when windows are moved, clicked, or resized. You can bind actions to
certain keys and mouse events.

Window-Specific Settings lets you customize settings that only apply to some windows.
It only takes effect if you use KWin as your window manager.

6.2.3 Internet & Network
The Internet &Network category helps you to configure Internet and networking options.

Two sections deal with how to manage your Bluetooth devices and services: Paired
Bluetooth Devices and Bluetooth Services. In theConnection Preferences section, KDE
lets you change the time-out values for different connections.

Desktop Sharing is useful if you want to invite other people to your desktops. Only let
trustworthy users take part in your session.

File Sharing allows you to configure Samba (Windows) and NFS (UNIX) file sharing.
The settings can only be changed if you are an administrator. If you log in as root, you
can add, change, or remove folders to share with others.

Use Local Network Browsing if you want to browse a local network. It is like “Network
Neighborhood.” Take into account that you may need some additional software, espe-
cially the LISa daemon (see package kdenetwork3-lisa).

In Proxy, you can customize proxy and SOCKS servers. Normally, if your administrator
does not tell you to use this, it is probably not useful for you.

The settings in Samba should only be configured with YaST.

Web Browser offers settings for the default KDE browser, Konqueror. For example,
you can customize fonts, manage cookies, and determine Web behavior, such Web
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shortcuts. For more information about how to use Web shortcuts, refer to Section “Using
Web Shortcuts” (Chapter 7, The Web Browser Konqueror, ↑Applications).

6.2.4 KDE Components
This category holds advanced KDE options, such as the default application to open
when clicking a link.

The Component Chooser module handles basic tasks. You can change the default e-
mail client, text editor, messenger, terminal, and Web browser. Whenever a KDE appli-
cation needs to start an application of these types, it always calls the default component
set here.

KDE uses File Associations to identify a file type and start an appropriate application.
Here, you can also choose which icon represents each file type and whether to show
files of a certain type in an embedded or a separate viewer.

The File Manager module configures the behavior of Konqueror as a file manager.
Here, define which fonts and font sizes to use, the path to your home directory, if pre-
views are allowed, and if quick copy and move actions are allowed.

In KDE Performance , you can optimize the performance of your KDE desktop.

An overview of all plug-ins of the KDE daemon is shown in Service Manager. This
module shows two different types: services invoked on start-up and services called on
demand. Normally do not change the settings of this module, because it is vital for
KDE.

In Session Manager, define how KDE handles sessions on login and shutdown. By
default, KDE remembers your previous session and restores the applications you were
using the next time you login. You can define different options here, such as excluding
individual applications from being restored.

Spell Checker lets you modify what spell checker to use, what types of errors to check
for, and the default dictionary to use. The KDE spell checking system (KSpell) provides
support for several spell checking utilities: the most commonly used are ASpell and
ISpell.
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6.2.5 Peripherals
This category holds settings for various devices that can be plugged in to your computer,
such as a digital camera, display, keyboard, and mouse.

Digital Camera lets you configure support for your digital camera. You can add your
camera model and define the type of port by which it is connected to your computer.

With Display, modify your display options, such as screen size and power control if
supported by your display.

Joystick helps to check whether your joystick is working correctly. You can adjust the
calibration.

The Keyboard section allows you to modify basic keyboard settings such as keyboard
repeat delay.

Of course, you can also adjust a lot of Mouse settings, such as actions to be triggered
by single or double clicking, cursor themes, and double click intervals.

With OBEX Devices, configure OBEX connections for your devices, such as PDAs.

Remote Controls allows you to configure bindings between your remote controls and
KDE applications.

6.2.6 Power Control
This category is only useful for laptops. Laptop Battery monitors your batteries. Power
management software must be installed.

6.2.7 Regional & Accessibility
This category holds regional settings as well as options for handicapped persons.

In Accessibility, configure functions that can help individuals with difficulties in hearing
or motor function. These include certain sound and keyboard options.
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The Country/Region & Language section lets you configure options that are specific
for your location, such as language, currency, and number and date format.

In Input Actions, configure mouse gestures and keyboard shortcuts for starting applica-
tions and running commands.

In the Keyboard Layout section, find multiple layouts for different languages. If Enable
Keyboard Layouts is selected, you can add and activate several keyboard layouts, such
as English and German, and switch between them. Fine-tune them in the Xkb Options
tab.

In theKeyboard Shortcuts section, you can define global KDE shortcuts. For an overview
of the currently active shortcuts, refer to the list of Global Shortcuts. You can also
choose a different, predefined shortcut scheme, such as a Windows or Mac scheme.

6.2.8 Security & Privacy
This category holds settings for personal security certificates, KWallet, password
treatment, and privacy settings.

To make KDE more secure, Crypto allows you to configure SSL (secure socket layer).
This is used in most KDE applications as well as others. There is also a possibility to
manage your personal certificates.

KDEWallet allows you to configure the KDE Wallet system, KWallet. It saves sensitive
information, such as passwords and form data, for several applications in a strongly
encrypted file, protected with a master password that you define. For information about
using KWallet, see Section 5.10.2, “Managing Passwords with KWallet Manager”
(page 155).

To change your personal settings, go to Password & User Account. Here, set a new
name, organization, e-mail address, SMTP server, or password.

The Privacy module manages personal Web browsing data. For example, use it to clear
the cache, delete the history of visited Web sites, or remove unwanted cookies.
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6.2.9 Sound & Multimedia
Use this category to perform all settings for the playback of audio CDs and for the
sound system.

In Audio CDs, configure encoding and device settings.

With Sound System, configure aRts, KDE's sound server. This allows you to hear your
system sound while simultaneously listening to a music CD.

With System Bell, switch from system notifications (default) to a system bell and
specify the volume, pitch, and duration of the bell.

The System Notifications section defines how the system should inform you in the event
of a problem, when a task is performed, or if an event requiring your immediate attention
occurs. In the upper part of the dialog, select the application for which to configure the
system notifications. As soon as you select a program, all events the application can
send to the user are listed in the lower window. Determine the notification type for each
notification in the Actions dialog.

The default view of the system notification dialog only offers Play a sound for audible
notification. Click More Options to access other action modes. You can log the notifi-
cation to a file, execute a program, or show the message in a pop-up window. In the
lower part of the dialog under Quick Controls, globally activate or deactivate the actions
for all programs.

6.2.10 System Administration
This category offers options for central system tasks. Most of the sections require root
permission to make changes.

With the Font Installer, you can install personal or systemwide fonts. To change system
fonts, click Administrator Mode.
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Login Manager configures the KDE login manager, KDM. You can change the appear-
ance, fonts used, background shown, shutdown behavior, what users are displayed at
login, and some convenience issues for the login screen.

The Path section defines the paths to some important directories for your data:
desktop, autostart, and documents.
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7Getting Started with the GNOME
Desktop
This chapter introduces the GNOME (GNU Network Object Model Environment)
desktop. It provides a brief overview of the most important elements and functionalities
of your desktop, including an in-depth description of the Nautilus file manager. It also
introduces several smart and useful applications that can help you feel at home in your
new desktop environment. For information about configuring your desktop, see Chap-
ter 8, Customizing Your GNOME Desktop (page 201).

7.1 Logging In and Selecting a
Desktop

If more than one user account is configured on your computer, all users must authenti-
cate. When you start your system, you are prompted to enter your username and pass-
word. This is the username and password you created when you installed your system.
If you did not install your system, check with your system administrator for your user-
name and password.

NOTE: Auto Login

If your computer is not run in a networking environment and you are the only
person using it, you can automatically boot into the desktop environment. In
this case, you do not see a login screen. This feature, called auto login, can be
enabled or disabled during installation or at any time using the YaST user
management module.
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The program managing the login process depends on the desktop environment installed
on your system. For GNOME, it is GDM. The login screen has the following items:

Login Prompt
Enter your username and password to log in.

Language menu
Specify the language to use in your session.

Session menu
Specify the desktop to run. If other desktops are installed, they appear in the list.
Make changes only if you want to use a session type other than your default (usu-
ally GNOME). Future sessions are automatically of the same type unless you change
the session type manually.

Reboot
Restarts the computer.

Shut Down
Shuts down the computer.

7.1.1 Controlling a Session
After your username and password are authenticated, the Session Manager starts. The
Session Manager lets you save certain settings for each session. It also lets you save
the state of your most recent session and return to that session the next time you log in.

The Session Manager can save and restore the following settings:

• Appearance and behavior settings, such as fonts, colors, and mouse settings

• Applications that you were running, such as a file manager or OpenOffice.org

TIP: Saving and Restoring Applications

You cannot save and restore applications that Session Manager does not
manage. For example, if you start the vi editor from the command line in
a terminal window, Session Manager cannot restore your editing session.
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7.1.2 Switching Desktops
If you installed both the GNOME and the KDE desktops, use the following instructions
to switch desktops.

1 If you are logged in to GNOME, click Desktop → Logout → OK. If you are
logged in to KDE, select Logout → End Current Session. On the login screen,
click Session.

2 Select the desired desktop then click OK.

3 Enter your username.

4 Enter your password.

5 ClickMake Default to make the desktop you chose in Step 2 (page 177) your new
default desktop or click Just For This Session to leave your previous desktop as
the default the next time you log in.

See Chapter 5, Getting Started with the KDE Desktop (page 137) for information about
using the KDE desktop.

7.1.3 Locking Your Screen
To lock the screen, do either of the following:

• Select Desktop → Lock Screen.

• If the Lock button is present on a panel, click it. To add the Lock button to a panel,
right-click the panel then click Add to Panel → Lock Screen → Add.

When you lock your screen, the screen saver starts or the screen goes black. To unlock
the screen, move your mouse to display the locked screen dialog. Enter your password
then click Unlock or press Enter .
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7.2 Logging Out
When you are finished using the computer, you can log out and leave the system running,
restart the system, or shut down the computer. If your system provides power manage-
ment, you can choose to suspend the computer, making the next system start much
faster than a complete boot.

To log out, click Desktop → Log Out then select one of the available options.

To save your current settings so that you can restore the session later, select Save current
setup.

If the Log Out button is present on a panel, you can click it to access the same logout
options. To add the Log Out button to a panel, right-click the panel then click Add to
Panel → Log Out → Add.

7.3 Desktop Components
The main components of the GNOME desktop are icons that link to files, folders, or
programs and a panel at the bottom of the screen (similar to the task bar in Windows).
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Figure 7.1 An Example GNOME Desktop

Double-click an icon to start its associated program. Right-click an icon to access addi-
tional menus and options. You can also right-click any empty space on the desktop to
access additional menus for configuring or managing the desktop itself.

7.3.1 Default Desktop Icons
The GNOME desktop features desktop icons providing basic navigation and function-
alities for your system.

You can right-click an icon to display a menu offering file operations such as copying,
cutting, or renaming. Selecting Properties displays a configuration dialog. Change the
title of an icon and the icon itself with Select Custom Icon. Use the Emblems tab to add
a small icon to an item (such as a file or a folder) to visually mark the item. For example,
to mark a file as important, add an Important emblem to the file icon. Use the Permis-
sions tab to view and modify the access, read, and write permissions for this file for
the user, group, or others. The Notes tab manages comments. The menu for the trash
can additionally features the Empty Trash option, which deletes the contents of the trash
can.
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To remove an icon from the desktop, simply drag it to the trash can. Be careful with
this option—if you throw folder or file icons into the trash can, the actual data is
deleted. If the icons only represent links to a file or directory, only the links are deleted.

To create a link on the desktop to a folder or a file, access the desired object with
Nautilus (see Section 7.4.1, “Navigating in Nautilus” (page 185)). Right-click the object
then click Make Link. Drag the link from the Nautilus window and drop it onto the
desktop.

7.3.2 The Desktop Context Menu
Right-clicking an empty spot on the desktop displays a menu with various options.
Select Create Folder to create a new folder or Create Document to create a new docu-
ment. Create a launcher icon for an application withCreate Launcher. Provide the name
of the application and the command for starting it then choose an icon to represent it.
The order and alignment of desktop icons are controlled by the Clean Up by Name and
Keep Aligned options. It is also possible to change the desktop background or paste an
item on the desktop.

7.3.3 The Panel
On your first login, the GNOME desktop starts with a panel located at the bottom of
the screen. This panel holds the three panel menus (Applications, Places, and Desktop),
a system tray holding applets, such as Beagle Search, Display Settings, and Network
Settings, and a notification area with the system clock.

The panel also contains the window icons of all started applications. If you click the
name of a window on the panel, the window is moved to the foreground. If the program
is already in the foreground, a mouse click minimizes it. Clicking a minimized applica-
tion reopens the window.

If you right-click an empty spot in the panel, a menu opens, offering the options listed
in the following table:
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Table 7.1 Panel Menu Options

DescriptionOption

Opens a list of applications and applets that can be added
to the panel.

Add to Panel

Removes the panel from the desktop. All the panel settings
are lost.

Delete This Panel

Locks the panel in its current position (so that it cannot be
moved to another location on the desktop) or unlocks the
panel (so it can be moved).

Lock/UnlockPanel Posi-
tion

To move the panel to another location, middle-click and
hold on any vacant space on the panel then drag the panel
to the new location.

Modifies the properties for this panel.Properties

Creates a new panel and adds it to the desktop.New Panel

Opens the help center.Help

Opens information about the panel application.About Panels

The Applications Menu
The Applications menu provides a structured list of the applications installed on your
system. Most of them are grouped into smaller submenus dedicated to a category, such
as System, Office, and Internet. To start any application, click Applications to display
the complete menu, select a suitable category, click the submenu, then click the appli-
cation's name. Applications not listed in the menu can be started from the Run Applica-
tion prompt ( Alt + F2 ) if you know the command.
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The Places Menu
The Places menu provides easy access to common locations, such as your home direc-
tory, drives, the desktop, and network folders. A search function for recent documents
and a file search can also be launched with this menu. For more information about file
management of local and remote folders, see Section 7.4.2, “File Management”
(page 186).

The Desktop Menu
TheDesktopmenu contains controls for managing your desktop. Here, find theGNOME
Control Center (customizes your desktop), Lock Screen (starts the screen saver), Log
Out (ends your session), and an easy-to-use program for taking screen shots of your
desktop. The screen shot function can also be accessed by pressing the Print Screen key
(also known as PrtSc ).

Applets
An applet is a small application that resides within a panel, indicated by a small icon
that you click to interact with the applet. Unlike “real” applications, applets do not have
their own windows on screen. Some applets are already preconfigured to be in your
panel on first start, but there are many more applets you can add to your own panels.

To add an applet to a panel, right-click any empty space on the panel then click Add to
Panel. Select the applet to add then click Add. The new applet is then permanently
added to the panel.
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Figure 7.2 Adding a New Icon to the Panel

To modify the properties of an applet, right-click the applet to display its menu then
click Properties. To move an applet, drag it to a new location on the panel.

7.3.4 Managing the Trash Bin
The trash bin is a directory for files, folders, and desktop objects marked for deletion.
You can drag items from the file manager or the desktop to the trash bin icon by keeping
the left mouse button pressed then releasing the button to drop them there. Alternatively,
right-click an icon, file, or folder and select Move to Trash.

If you need to retrieve a file from the trash bin, you can display the contents and move
the file out of Trash. When you empty Trash, you delete the contents permanently.

Displaying Trash
You can display the contents of Trash in any of the following ways:

From a File Browser Window
Click Go → Trash. The contents of Trash are displayed in the window.

From a File Object Window
Click Places → Trash. The contents of Trash are displayed in the window.
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From the Desktop
Double-click the Trash icon on the desktop.

Emptying Trash
Empty the trash bin using either of the following methods:

From a File Browser Window
Click File → Empty Trash.

From the Desktop
Right-click the Trash icon then select Empty Trash.

7.3.5 Accessing CD-ROM, DVD-ROM, and
Floppy Disks

To access floppy disks, CDs, or DVDs, insert the medium into the appropriate drive
then click Places → Computer. Double-click the appropriate icon in Computer to start
the file manager and view the contents of the disk.

Figure 7.3 Computer

You can copy files to and from other directories by dragging and dropping.
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WARNING

Do not simply remove disks from the drive after using them. Floppy disks, CDs,
and DVDs must always be unmounted from the system first. Close all file
manager sessions still accessing the medium then right-click the icon for the
medium and select Eject from the menu. Then safely remove the disk when
the tray opens automatically.

Format floppy disks by clicking Applications → System → File System → Floppy
Formatter. Select the density of the floppy disk and the file system settings: Linux native
(ext2), the file system for Linux, or DOS (FAT) to use the floppy with Windows systems.

7.4 Managing Files and Folders with
Nautilus

Nautilus is GNOME's file manager and viewer. You can use Nautilus to create folders
and documents, display and manage your files and folders, run scripts, write data to a
CD, and open URIs. The following sections provide an overview of the basic functions
of Nautilus and a few tips on its configuration. For more information, see the help pages
for Nautilus. You can open Nautilus using the menu entry or by clicking the Computer
or Home icon on the desktop.

7.4.1 Navigating in Nautilus
The standard window of Nautilus is shown in Figure 7.4, “Nautilus Standard Window”
(page 186). The default view of a folder's content is the icon view featuring just an icon
and the filename for each file. If configured accordingly, a preview of the file's content
can be provided. When you double-click a folder icon, a new Nautilus window opens,
displaying the folder's content.
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Figure 7.4 Nautilus Standard Window

To navigate between folders, use the drop-down menu in the bottom left corner of the
Nautilus window. Here, find all parent folders for the current directory up to the root
file system. Select the folder you want and open it in a new Nautilus window on top of
the old one. Open just the immediate parent of the current folder by clicking File →
Open Parent. To close these parent folders, click File → Close Parent Folders.

If you prefer a browser-like file navigation, switch to the Nautilus browser interface
by right-clicking a folder then clicking Browse Folder. A new Nautilus window opens,
providing the normal functionality but with a browser's look and feel.

To navigate folders and files, you can use the Back, Forward, and Up buttons as you
would in a Web browser. The functionalities and configuration options described in
Section 7.4.2, “File Management” (page 186) also apply to the browser interface.

7.4.2 File Management
Perform several tasks in Nautilus by simply dragging and dropping. For example, you
can drag any file from the desktop and drop it onto an open Nautilus window. If you
have two Nautilus windows open, you can drag a file or folder from one window and
drop it onto another. To copy an item, select the item, press and hold Ctrl , then drag
the item to a new location. Dragging text from an application to a folder window creates
a new text document.
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To move files between directories, open the source directory containing the file to move,
click File → Open Location, type the path to the target directory, click Open, then drag
the files to the Nautilus window holding the target directory. Files and folders can be
moved to and from an open Nautilus window and the desktop.

To create multiple copies of a file, click Edit → Duplicate. For a simple cut, copy, and
paste of files, use the Edit menu or right-click the file icon then select the appropriate
item from the context menu that appears. To rename a file, right-click it then click Re-
name.

Nautilus also supports file browsing across a network. To connect to a remote server,
such as an FTP, SSH, HTTP, or Samba server, click File → Connect to Server. You
are then prompted for the type of server and some additional information, such as the
name of the folder you want to access, the port number, and a username. When you
click Connect, the remote folder is displayed as part of the Places panel menu and ap-
pears as a desktop icon. For any future connections, select the appropriate item from
the Places menu and provide the necessary authentication to log in to these network
folders. To close these connections, right-click the desktop icon then click Unmount
Volume.

Nautilus provides basic CD and DVD burning functionality. To copy data to CD or
DVD, create a directory containing the data you want to burn, click Places→ CD/DVD
Creator, drag the folder holding the data onto the CD/DVD Creator window, then click
File → Write to Disc.

7.4.3 Editing MIME Types
MIME types determine which application should open a file when clicked in a Web or
file browser. The actual file type and the MIME type of a file are closely associated
with each other. An HTML file has the html file type and would be registered to have
a text/html MIME type. Nautilus has built-in support for most of the common
MIME types and proposes the appropriate application when you choose to open a file.
In this case, it would propose a Web browser.

To edit a MIME type:

1 In a Nautilus window, right-click a file of the MIME type to change.

2 Click Properties → Open With.
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3 Click Add to search for a suitable application.

4 Select the application to use then click Add.

5 Click Close to exit the dialog.

Figure 7.5 Editing the MIME Type

Even if a MIME type has not yet been registered, the procedure is the same. These
modifications are applied globally, which means that any file of this type is subsequently
opened by the defined application.

7.5 Managing Network Connections
Use the NetworkManager applet in the system tray of the panel for managing network
connections. Click the icon to see all the available networks, such as wired and wireless
networks, VPN connections, and dial-up connections. If multiple connections are listed,
select the connections to use. Right-click the icon and uncheck Enable Networking or
Enable Wireless if you want to stop these services completely. Disabling wireless is
necessary in sensitive environments where you are not allowed to use wireless network
devices.
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Also use the NetworkManager applet for configuring wireless networks. gconf stores
the settings in ~/.gconf and the gnome-keyring-manager helps remember the pass-
words.

Find more information about networking in mobile environments in Chapter Mobile
Computing with Linux (↑Reference) and general information about NetworkManager
in Section “Managing Network Connections with NetworkManager” (Chapter 18, Basic
Networking, ↑Reference).

7.6 Accessing Network Shares
Other network devices, like workstations and servers, can be set up to share some or
all of their resources. Typically, files and folders are marked to let remote users access
them. These are called network shares. If your system is configured to access network
shares, you can use the file manager to access these shares.

To access network shares, click the Computer button in any file manager window. The
window displays the network share types that you can access. Double-click a network
resource type then click the network share to access. You might be required to authen-
ticate to the resource by providing a username and password.

7.7 Opening or Creating Documents
with OpenOffice.org

The office suite OpenOffice.org offers a complete set of office tools including a word
processor, spreadsheet, presentation program, vector drawing program, and database
component. Because OpenOffice.org is available for a number of operating systems,
you can use the same data across different computing platforms. You can also open
and edit files in Microsoft Office format and save them back to this format, if needed.
To start OpenOffice.org, press Alt + F2 and enter OOo.

A number of sample documents and templates are included with OpenOffice.org. Access
the templates by clicking File → New → Templates and Documents. In addition, you
can use AutoPilot, a feature that guides you through the creation of letters and other
common documents.
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For a more in-depth introduction to OpenOffice.org, see Chapter The OpenOffice.org
Office Suite (↑Applications) or view the help in any OpenOffice.org program.

7.8 Finding Files on Your Computer
Using Search for File from the Places menu, you can locate files on your computer
using any number of search criteria. You can also open the Search for Files dialog by
entering gnome-search-tool in a terminal window.

Figure 7.6 Search for Files Dialog

Search for Files uses the find, grep, and locate UNIX commands. All searches are case
insensitive.

7.8.1 Performing a Basic Search
1 Click Places → Search for Files.

2 Type the search text in Name Contains. The search text can be a filename or
partial filename, with or without wild cards, as shown in the following table:

ResultExampleSearch Text

Searches for all files that contain
“myfile.txt” in the filename.

myfile.txtFull or partial filename
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ResultExampleSearch Text

Searches for all files that have a
.c or .h extension.

*.[ch]Partial filename combined
with wild cards (* [ ])

3 In Look in Folder, type the path to the directory in which to begin the search.

4 Click Find.

Search for Files searches in the directory specified and any subdirectories of the direc-
tory and displays the results of the search in the Search Results list. If no files are found
that match the search criteria, the application displays the message No files found
in the list.

7.8.2 Adding Search Options
Use Show More Options to search by file content, dates, owner, or file size.

1 Click Places → Search for Files.

2 Type the search text in Name Contains.

3 In Look in Folder, type the path to the directory in which to begin the search.

4 Click Show More Options then click Available Options.

5 Select a search option to apply then clickAdd. The following options are available:

DescriptionOption

Searches for a file by filename. Type a full filename
or a partial filename with wild cards in the field

Contains the Text

provided. Use an asterisk (*) to indicate any number
characters. Use a question mark (?) to indicate a
single character. The search is case sensitive.
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DescriptionOption

Searches for files that were modified within the pe-
riod specified (in days).

Date Modified Less
Than

Searches for files that were modified before the pe-
riod specified (in days).

Date Modified More
Than

Searches for files that are equal to or larger than the
size specified (in kilobytes).

Size At Least

Searches for files that are smaller than or equal to
the size specified (in kilobytes).

Size At Most

Searches for empty files.File is Empty

Searches for files that are owned by the user speci-
fied.

Owned By User

Searches for files that are owned by the group spec-
ified.

Owned By Group

Searches for files that are owned by a user or group
that is unknown to the system.

Owner is Unrecognized

Searches for filenames that do not contain the string
that you enter. Enter a full filename or a partial file-

Name Does Not Con-
tain

name with wildcards in the field provided. Use an
asterisk (*) to indicate any number of characters.
Use a question mark (?) to indicate a single character.
The search is case sensitive.

Searches for files that contain the specified regular
expression in their directory path or filename. Regu-

NameMatches Regular
Expression

lar expressions are special text strings used to de-
scribe a search pattern. For more information, see
http://www.regular-expressions.info.
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DescriptionOption

Includes hidden and backup files in the search.Show Hidden and
Backup Files

Follows symbolic links when searching for files.Follow Symbolic Links

Searches in directories that are not in the same file
system as the start directory.

Include Other Filesys-
tems

6 Specify the required search information for the search option.

7 Repeat Step 5 (page 191) and Step 6 (page 193) for each search option to apply.
To remove a search option from the current search, click the Remove button next
to the option.

8 Click Find.

7.8.3 Using the Search Results List
You can use the search results list to open or delete a file found during a search or save
the search results to a file.

Figure 7.7 Search Results List
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To open a file displayed in the list, right-click the file then click Open or double-click
the file. To open the folder that contains a file displayed in the Search Results list, right-
click the file then click Open Folder. To delete a file displayed in the Search Results
list, right-click the file then click Move to Trash.

To save the results of the last search that Search for Files performed, right-click anywhere
in the search results list then click Save Results As. Type a name for the file to which
to save the results then click Save.

7.8.4 Disabling Quick Searches
By default, Search for Files tries to speed up some searches by using the locate
command.locate provides a secure way to index and quickly search for files. Because
locate relies on a file index, the results might not be up to date. To disable quick
searches, run the following command in a terminal window:
gconftool-2 --type=bool --set /apps/gnome-search-tool/disable/quick/search 1

For more information about locate, see Section “The Command locate” (Chapter 10,
Special Features of SUSE Linux, ↑Reference).

7.9 Exploring the Internet
GNOME includes Firefox, a Mozilla™-based Web browser. Start it by clicking Pro-
grams → Firefox Web Browser or clicking its quick start icon in the top panel.

You can type an address into the location bar at the top or click links in a page to move
to different pages, just like in any other Web browser. For information about Firefox,
refer to Chapter The Web Browser Firefox (↑Applications).

7.10 E-Mail and Calendering
Novell Evolution seamlessly combines e-mail, a calendar, an address book, and a task
list in one easy-to-use application. With its extensive support for communications and
data interchange standards, Evolution can work with existing corporate networks and
applications, including Microsoft Exchange. To start Evolution, click Applications →
Office → Evolution.
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The first time you start it, Evolution prompts you with a few questions as it sets up a
mail account and helps you import mail from your old mail client. Then it shows you
how many new messages you have and lists upcoming appointments and tasks, the
current weather, and news from news feeds. The calendar, address book, and mail tools
are available in the shortcut bar on the left.

For more information, see Chapter Evolution: An E-Mail and Calendar Program
(↑Applications) and the Evolution 2.4 User Guide at http://www.novell.com/
documentation/evolution24/index.html.

7.11 Moving Text between
Applications

To copy text between applications, select the text then move the mouse cursor to the
position where you want the text copied. Click the middle button on the mouse or the
scroll wheel to copy the text.

When copying information between programs, you must keep the source program open
and paste the text before closing it. When a program closes, any content from that ap-
plication on the clipboard is lost.

7.12 Important Utilities
GNOME has many applets and applications designed to interact with the desktop and
each other. This section introduces some of them. Learn how to manage little notes on
your desktop, use the GNOME dictionary, chat using Gaim, and enjoy various types
of multimedia applications.

7.12.1 Taking Notes with Tomboy
Tomboy is a desktop note-taking application that helps you organize ideas and informa-
tion. To add Tomboy to a panel, right-click the panel then click Add to Panel. Scroll
down the list of items, select Tomboy Notes, then click Add. The Tomboy icon appears
on your panel.
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Left-click the panel icon to open the Tomboy menu then select Create New Note. Type
the text of your note. Link notes with each other by clicking Link. These links can even
survive renaming and reorganizing. A Search Notes function located in the panel menu
of Tomboy lets you search your notes. Web links and e-mail addresses can also be
dropped onto Tomboy. Click Recent Changes to view a list of your notes in the order
they were last modified.

Tomboy also supports advanced editing features, such as highlighted text, inline spell
checking, automatically-linking Web and e-mail addresses, undo and redo, and font
styling and sizing.

Figure 7.8 Examples of Tomboy Notes

7.12.2 Dictionary
GNOME Dictionary provides dictionary definitions of words using any server that
supports the dict protocol (an Internet standard for client/server dictionary applications).
An Internet connection is required because this applet accesses an online dictionary.
To open Dictionary, click Applications → Office → Dictionary → Dictionary or enter
gnome-dictionary in a terminal window.
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Figure 7.9 GNOME Dictionary

Enter a word in Look Up. By default, the query is sent to the dict.org server. To use a
different server, click Edit → Preferences. dict.org lets you choose between various
databases for special vocabularies, such as jargon or computer terminology. Under
Strategy, specify the search strategy to use, such as matching the exact word, parts of
the word, or the prefix or suffix. Click Help to access the online manual.

7.12.3 Messaging Using Gaim
Gaim is a powerful instant messenger client. It supports various protocols, such as AIM,
ICQ, GroupWise®, IRC, Jabber, and MSN. Its most popular features include the ability
to log in to multiple accounts on multiple instant messaging networks at the same time,
automatic text replacement, and spell checking. Gaim has buddy pounces (known as
“buddy alerts” in AOL Messenger), meaning that you can configure Gaim to notify
you whenever one of your buddies enters or leaves a channel you are currently connected
to. Gaim can send you a message announcing this, play a sound, or execute a command.

To access Gaim, click Applications → Internet → Chat → Gaim Internet Messenger
or enter gaim in a terminal window. On first start-up, create a list of your accounts on
different instant messaging networks by clicking Accounts → Add. Select the protocol
then specify your screen name, password, and alias. Select Remember password and
Auto-login if you want Gaim to log in automatically on start-up. To keep track of your
e-mail while using Gaim, select New mail notifications. To use a buddy icon with your
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account, open a file dialog and select one. Additional options, such as proxy settings
and server addresses, can be configured after clicking Show more options. When you
have completed your account settings, click Save to exit this dialog.

As soon as you are finished specifying the account data, it is shown in the login window.
To sign on, select your account from the Account menu, type your password, click Sign
on, and start chatting.

7.12.4 Internet Telephony and Video
Conferencing with GnomeMeeting

GnomeMeeting lets you see and speak to other people via Internet telephony (VoIP)
and video conferencing. The GnomeMeeting address book is shared with the Evolution™
e-mail client, so you do not need to specify contact information in more than one place.
You can browse for other GnomeMeeting users on your local network without discov-
ering their contact details first and you can view your own video output side-by-side
with the video from your conversation partners so you see what they see.

To open GnomeMeeting, clickApplications→ Internet→ Telephone→GnomeMeeting.
The first time you access GnomeMeeting, you need to complete the steps in the First
Time Configuration Druid that automatically opens.

7.12.5 Managing Archives with File Roller
In GNOME, you can manage file archives with File Roller. As an archive manager, it
can create and modify archives, view the content of an archive, view a file contained
in the archive, and extract files from the archive. File Roller supports the following
formats: tar archives uncompressed (.tar) or compressed with gzip (.tar.gz ,
.tgz), bzip (.tar.bz , .tbz), bzip2 (.tar.bz2, .tbz2), compress (.tar.Z ,
.taz), lzop (.tar.lzo , .tzo); Zip archives (.zip); Jar archives (.jar , .ear,
.war); Lha archives (.lzh); Rar archives (.rar); and single files compressed with
gzip, bzip, bzip2, compress, and lzop.

You can easily view archive contents from File Roller with other applications without
needing to decompress the archives. File Roller supports drag and drop, allowing you
to drag file icons from the desktop or file manager (Nautilus) to the File Roller window
and drop them there.
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To open File Roller, click Applications → Utilities → Archiving → Archive Manager.
To create a new archive, click Archive → New. Specify a name for the new archive
(without a file extension) and the directory in which to create the archive. Then select
an archive type. Click New to exit the dialog. Add files to the archive by dragging and
dropping files from the desktop or the file manager or by clicking Edit → Add Files.

After completing the selection and configuration, exit the dialog. The archive you cre-
ated is available for further processing at the specified location. To decompress an
archive, load it to File Roller, click Edit → Extract then specify the target directory.

7.12.6 Reading News Feeds with Blam
Blam is a tool that helps you keep track of the growing number of news feeds distributed
as RSS. RSS provides news updates from a Web site in a simple form for your computer.
You can read these files in a program called an aggregator, which collects news from
various Web sites. Blam is a GNOME aggregator that lets you subscribe to any number
of feeds and provides an easy-to-use interface to stay up to date. Blam can print news
entries and automatically updates feeds at regular intervals.

To open Blam, click Applications → Internet → RSS Reader → Blam Feed Reader.
Channels appear in a list on the left of the Blam window. Click any channel then view
the headlines in the top-right panel. Clicking a headline displays the article in the lower-
right panel. To see the full article, scroll to the bottom of the lower-right panel and click
Show in browser.

Figure 7.10 Blam Feed Reader
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To add a new channel, clickChannel→Add, enter the URL, then clickOK. For example,
entering http://www.novell.com/newsfeeds/rss/slp.xml adds the
SUSE Linux Professional Cool Solutions channel to your list and downloads the latest
articles.

7.13 Obtaining Software Updates
Use the ZENworks updater to install additional software and apply security updates.
Select the software packages to install from the list then click Update. For background
information and configuration options, see Section 2.12, “Update from the Command
Line” (page 76).

200 Start-Up

http://www.novell.com/newsfeeds/rss/slp.xml


8Customizing Your GNOME Desktop
Use Desktop Preferences to customize your GNOME desktop. Some of the settings
you might want to change include the desktop background, screen saver, keyboard and
mouse, sounds, and file associations. Start by clicking Desktop → GNOME Control
Center then select the desktop settings to modify. In the individual modules, access
help for the options by clicking Help. The system immediately adopts every change
made in a configuration module.

Figure 8.1 GNOME Desktop Preferences
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8.1 Hardware Settings
The hardware settings configure your keyboard, mouse, printers, removable drives, and
media and set your screen resolution.

8.1.1 Modifying Keyboard Preferences
Use Keyboard Preferences to modify the autorepeat preferences for your keyboard and
to configure typing break settings. Click the Accessibility button to start the keyboard
accessibility preference tool.

8.1.2 Configuring the Mouse
Use Mouse Preference to configure your mouse for right-hand use or for left-hand use.
You can also specify the speed and sensitivity of mouse movement.

8.1.3 Installing and Configuring Printers
You could use this module to install and configure printers. On a SUSE Linux system,
these settings are best made with YaST as described in Section 2.4.4, “Printer” (page 44).

8.1.4 Configuring Removable Drives and
Media

Use this module to set preferences for removable drives and media. These settings
control automatic actions for devices and various media.

8.1.5 Specifying Screen Resolution Settings
You could use this module to specify the resolution settings for your screen, including
resolution and refresh rate. On a SUSE Linux system, these settings are best made with
YaST as described in Section “X11 Setup with SaX2” (Chapter 14, The X Window
System, ↑Reference).
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8.2 Look and Feel Settings
Look and Feel lets you change your desktop background, choose fonts, screensavers,
and themes, and customize window behavior.

8.2.1 Changing the Desktop Background
The desktop background is the image or color that is applied to your desktop. You can
customize the desktop background in the following ways:

• Select an image for the desktop background. The image is superimposed on the
desktop background color. The desktop background color is visible if you select a
transparent image or if the image does not cover the entire desktop.

• Select a color for the desktop background. You can select a solid color or create a
gradient effect with two colors (where one color blends gradually into another
color).

You can also change the appearance of your desktop background from within the
Nautilus file manager. To use an image file as a background picture, drag it from the
file manager and drop it into Desktop Wallpaper.

If you do not want any background picture, click No Wallpaper and select a desktop
color instead.

8.2.2 Selecting Fonts
Use Font Preferences to select the fonts to use in your applications, windows, terminals,
and desktop. The upper part of the dialog shows the fonts selected for the application,
desktop, window title, and terminal. Click one of the buttons to open a selection dialog
where you can set the font family, style, and size.
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8.2.3 Configuring the Screen Saver
Use Screensaver Preferences to select or change your screen saver. A screen saver is
a small program that takes over the display screen if there are no keystrokes or mouse
movements for a specified duration of time.

You can select a Random screen saver (random selection of screen savers from a custom-
defined list) or a Blank screen instead of a screen saver or Disable the screen saver
function. Another option is to select a specific screen saver from the list of installed
screen savers. The currently selected screen saver is displayed in the preview window
on the right.

Use Activate after to determine when the screen should be made completely blank (if
you choose the Blank screen option) or when the screen saver starts after there are no
keystrokes or mouse movements. All time references are in minutes.

Select Lock screen when active to lock the screen when a screen saver is running. To
unlock the screen, move the mouse or press a key on the keyboard then enter your
password.

8.2.4 Choosing a Theme
A theme is a group of coordinated settings that specify the visual appearance of a part
of the desktop. Use Theme Preferences to select from a list of preinstalled themes or
customize the settings to your own preferences. The list of available themes includes
several themes for users with accessibility requirements.

A theme contains settings that affect different the following parts of the desktop:

Controls
The visual appearance of windows, panels, and applets. Also the visual appearance
of the GNOME-compliant interface items that appear on windows, panels, and
applets, such as menus, icons, and buttons. Some of the controls setting options
that are available are designed for special accessibility needs.

Window Frame
The appearance of the frames around windows only.
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Icon
The appearance of the icons on panels and the desktop background.

The color settings for the desktop and applications are controlled using themes. You
can choose from a variety of preinstalled themes. Selecting a style from the list overview
applies it automatically. Theme Details opens another dialog where you can customize
the style of single desktop elements, like window content, window borders, and icons.
Making changes and leaving the dialog by clickingClose switches the theme to custom.
Click Save Theme to save your modified theme under a custom name. The Internet and
other sources provide many additional themes for GNOME as .tar.gz files. Install these
with Install Theme. You can also drag new themes into the Theme Preferences window
and drop them there.

8.2.5 Customizing Window Behavior
Use Window Preferences to customize window behavior for the desktop. You can de-
termine how a window reacts to contact with the mouse pointer or to double-clicks on
its title bar and define which key to hold to move an application window.

When several application windows populate the desktop, the active one by default is
the last one clicked. Change this behavior by activating Select windows when the mouse
moves over them. If desired, activate Raise selected window after an interval and adjust
the latency time with the slider. This raises a window a short time after the window
receives focus.

Application windows can be shaded (rolled up) by double-clicking the title bar, leaving
only the title bar visible. This saves space on the desktop and is the default behavior.
It is also possible to set windows to maximize when the title bar is double-clicked.

Select a modifier key to press for moving a window ( Ctrl , Alt , or the Windows logo
key).

8.3 Personal Settings
Personal Settings lets you configure accessibility and assistive technology options,
change your password, and customize keyboard shortcuts.
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8.3.1 Configuring Accessibility Settings
The settings of this module facilitate the use of the keyboard for users with motion
impairments. The module consists of the three tabs: Basic, Filters, and Mouse Keys.
Before modifying settings, activate Enable keyboard accessibility features.

8.3.2 Configuring Assistive Technology
Support

The GNOME desktop includes assistive technologies for users with special needs.
These technologies include a screen reader, magnifier, and on-screen keyboard. To
enable the technologies, first select Enable assistive technologies then select the tech-
nologies you want.

The gok package must be installed to get on-screen keyboard support. The
gnopernicus and gnome-mag packages must be installed to get screen reading
and magnifying capabilities.

8.3.3 Changing Your Password
Use this module to change your password. Specify your current password, specify your
new password twice, then click OK. Using capitals, numbers, and symbols increases
the security of a password.

8.3.4 Customizing Keyboard Shortcuts
A keyboard shortcut is a key or combination of keys that provides an alternative to
standard ways of performing an action. Use Keyboard Shortcuts to display the default
keyboard shortcuts. You can customize the shortcuts to your preferences.

To change the shortcut keys for an action, click the shortcut for the action then press
the keys to associate with the action. To disable the shortcut keys for an action, click
the shortcut for the action then press <— .

206 Start-Up



8.4 System Settings
System Settings configures network proxies, search and indexing, sessions, and sound
settings.

8.4.1 Configuring Network Proxies
The Network Proxy Preferences tool lets you configure how your system connects to
the Internet. You can configure the desktop to connect to a proxy server and specify
the details of the server. A proxy server is a server that intercepts requests to another
server and fulfills the request itself, if it can. You can specify the Domain Name Service
(DNS) name or the IP address of the proxy server. A DNS name is a unique alphabetic
identifier for a computer on a network. An IP address is a unique numeric identifier for
a computer on a network.

8.4.2 Setting Search and Indexing
Preferences

Use this module to set preferences for the Beagle search tool. On Search, click Start
search & indexing services automatically to start the Beagle daemon when you log in.
You can also choose the key strokes that display the Beagle search window by specifying
any combination of Ctrl , Alt , and a function key, and you can determine the maximum
number of results to display when a search is performed.

On Indexing, choose to index your home directory (selected by default), not to index
your home directory, and to add additional directories to index. Make sure you have
rights to the directories you add. You can also specify resources that you do not want
indexed. These resources can include directories, patterns, mail folders, or types of
objects.

For more information about Beagle, see Chapter Using Beagle (↑Applications).
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8.4.3 Managing Sessions
You can set session preferences and specify which applications to start when you begin
a session. You can configure sessions to save the state of applications then restore the
state when you start another session.

You can also use this preference tool to manage multiple sessions. For example, you
might have a mobile session that starts applications you use most frequently when
traveling, a demo session that starts applications used to present a demonstration or
slide show to a customer, and a work session that uses a different set of applications
when you are working in the office.

8.4.4 Setting Sound Preferences
Sound Preference controls when the sound server starts. You can also specify which
sounds to play when particular events occur.

8.5 Modifying the Appearance of
Menus and Toolbars

Use the options in the Menu and Toolbar Preferences dialog to modify the appearance
of menus, menu bars, and toolbars for GNOME-compliant applications. To accessMenu
and Toolbar Preferences, click Applications → Utilities → Desktop → Menus &
Toolbars.

Select Show icons in menus to display an icon beside each item in a menu. Some menu
items do not have an icon. Editable menu accelerators lets you assign different keyboard
shortcuts to menu items. Select this option, highlight a menu item in any application,
then press the keys you want to assign. The shortcut then appears on the menu. Click
<— to remove a shortcut.

Detachable toolbars lets you move toolbars from application windows to any location
on the screen. If you select this option, handles appear on the left side of toolbars in
your applications. Click and hold this area then drag the toolbar to its new location.
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Toolbar button labels lets you choose to display toolbar icons as Text only, Icons only,
Text beside icons, or Text below icons. The default setting is Text below icons.

8.6 Setting Preferred Applications
To improve the interoperability of your GNOME desktop, you can configure the default
Web browser, mail reader, and terminal applications that are launched whenever another
GNOME application needs these functionalities. To do this, click Applications →
Utilities → Desktop → Preferred Applications.

On Web Browser, Mail Reader, or Terminal, select the name of the application to use
as the default. For example, if you set your default browser to Firefox on Web Browser,
Firefox is started when you click a link in an e-mail. You can also click Custom to
customize the application's command. All settings made in Preferred Applications apply
only to GNOME applications.
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Part IV. Troubleshooting





9Common Problems and Their
Solutions
This chapter offers a range of common problems that can arise with SUSE Linux, with
an intention of covering as many of the various types of potential problems as possible.
That way, even if your precise situation is not listed here, there might be one similar
enough to offer hints as to the solution.

9.1 Finding Information
Linux logs things in a fair amount of detail. There are several places to look when you
have problems with a SUSE Linux system, most of which are standard to Linux systems
in general and some of which are peculiar to SUSE Linux systems.

The following is a list of the most commonly checked log files and what they typically
contain.

DescriptionLog File

Messages from the kernel during the boot
process.

/var/log/boot.msg

Messages from the mail system./var/log/mail.*

Ongoing messages from the kernel and sys-
tem log daemon when running.

/var/log/messages
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DescriptionLog File

Hardware messages from the SaX display
and KVM system.

/var/log/SaX.log

Messages from the desktop applications cur-
rently running. Replace userwith the actual
username.

/home/user/
.xsession-errors

All messages from the kernel and system log
daemon assigned WARNING level or higher.

/var/log/warn

Binary file containing user login records for
the current machine session. View it with
last.

/var/log/wtmp

Various start-up and runtime logs from the
X Window system. It is useful for debugging
failed X start-ups.

/var/log/Xorg.*.log

Directory containing YaST's actions and their
results.

/var/log/YaST2/

Directory containing Samba server and client
log messages.

/var/log/samba/

Linux comes with a number of tools for system analysis and monitoring. See Chap-
ter System Monitoring Utilities (↑Reference) for a selection of the most important ones
used in system diagnostics.

Each scenario included in the following begins with a header describing the problem
followed by a paragraph or two offering suggested solutions, available references for
more detailed solutions, and cross-references to other scenarios that might be related.

9.2 Installation Problems
Installation problems are situations when a machine fails to install. It may fail entirely
or it may not be able to start the graphical installer. This section highlights some of the
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typical problems you might run into and offers possible solutions or workarounds for
this kind of situations.

9.2.1 No Bootable CD-ROM Drive Available
If your computer does not contain a bootable CD or DVD-ROM drive or if the one you
have is not supported by Linux, there are several options for installing your machine
without a need for a built-in CD or DVD drive:

Booting from a Floppy Disk
Create a boot floppy and boot from floppy disk instead of CD or DVD.

Using an External Boot Device
If it is supported by the machine's BIOS and the installation kernel, boot for instal-
lation from external CD or DVD drives.

Network Boot via PXE
If a machines lacks a CD or DVD drive, but provides a working ethernet connection,
perform a completely network-based installation. See Section “Remote Installation
via VNC—PXE Boot and Wake on LAN” (Chapter 1, Remote Installation, ↑Ref-
erence) and Section “Remote Installation via SSH—PXE Boot and Wake on LAN”
(Chapter 1, Remote Installation, ↑Reference) for details.

Booting from a Floppy Disk (SYSLINUX)
On some older computers, there is no bootable CD-ROM drive available, but a floppy
disk drive. To install on such a system, create boot disks and boot your system with
them. See Section 2.5.3, “Boot and Rescue Disks” (page 51) for directions for creating
boot disks with YaST.

The boot disks include the loader SYSLINUX and the program linuxrc. SYSLINUX
enables the selection of a kernel during the boot procedure and the specification of any
parameters needed for the hardware used. The program linuxrc supports the loading of
kernel modules for your hardware and subsequently starts the installation.

When booting from a boot disk, the boot procedure is initiated by the boot loader
SYSLINUX (package syslinux). When the system is booted, SYSLINUX runs a
minimum hardware detection that mainly consists of the following steps:
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1. The program checks if the BIOS provides VESA 2.0–compliant framebuffer
support and boots the kernel accordingly.

2. The monitor data (DDC info) is read.

3. The first block of the first hard disk (MBR) is read to map BIOS IDs to Linux
device names during the boot loader configuration. The program attempts to
read the block by means of the the lba32 functions of the BIOS to determine if
the BIOS supports these functions.

If you keep Shift pressed when SYSLINUX starts, all these steps are skipped. For
troubleshooting purposes, insert the line
verbose 1

in syslinux.cfg for the boot loader to display which action is currently being per-
formed.

If the machine does not boot from the floppy disk, you may need to change the boot
sequence in the BIOS to A,C,CDROM.

External Boot Devices
Most CD-ROM drives are supported. If problems arise when booting from the CD-
ROM drive, try booting CD 2 of the CD set.

If the system does not have a CD-ROM or floppy disk, it is still possible that an external
CD-ROM, connected with USB, FireWire, or SCSI, can be used to boot the system.
This depends largely on the interaction of the BIOS and the hardware used. Sometimes
a BIOS update may help if you encounter problems.

9.2.2 Installation Fails or Machine Does Not
Boot from the Installation Media

There are two possible reasons for a machine not to boot for installation:

CD or DVD-ROM Drive Unable to Read the Boot Image
Your CD-ROM drive might not be able to read the boot image on CD 1. In this
case, use CD 2 to boot the system. CD 2 contains a conventional 2.88 MB boot
image that can be read even by unsupported drives and allows you to perform the
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installation over the network as described in Chapter Remote Installation (↑Refer-
ence).

Incorrect Boot Sequence in BIOS
The BIOS boot sequence must have CD-ROM set as the first entry for booting.
Otherwise the machine would try to boot from another medium, typically the hard
disk. Guidance for changing the BIOS boot sequence can be found the documenta-
tion provided with your motherboard or in the following paragraphs.

The BIOS is the software that enables the very basic functions of a computer. Mother-
board vendors provide a BIOS specifically made for their hardware. Normally, the
BIOS setup can only be accessed at a specific time—when the machine is booting.
During this initialization phase, the machine performs a number of diagnostic hardware
tests. One of them is a memory check, indicated by a memory counter. When the counter
appears, look for a line, usually below the counter or somewhere at the bottom, men-
tioning the key to press to access the BIOS setup. Usually the key to press is Del ,
F1 , or Esc . Press this key until the BIOS setup screen appears.

Procedure 9.1 Changing the BIOS Boot Sequence

1 Enter the BIOS using the proper key as announced by the boot routines and wait
for the BIOS screen to appear.

2 To change the boot sequence in an AWARD BIOS, look for the BIOS FEATURES
SETUP entry. Other manufacturers may have a different name for this, such as
ADVANCEDCMOS SETUP. When you have found the entry, select it and confirm
with Enter .

3 In the screen that opens, look for a subentry called BOOT SEQUENCE. The boot
sequence is often set to something like C,A or A,C. In the former case, the ma-
chine first searches the hard disk (C) then the floppy drive (A) to find a bootable
medium. Change the settings by pressing PgUp or PgDown until the sequence
is A,CDROM,C.

4 Leave the BIOS setup screen by pressing Esc . To save the changes, select SAVE
& EXIT SETUP or press F10 . To confirm that your settings should be saved,
press Y .
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Procedure 9.2 Changing the Boot Sequence in a SCSI BIOS (Adaptec Host Adapter)

1 Open the setup by pressing Ctrl + A .

2 Select Disk Utilities, which displays the connected hardware components.

Make note of the SCSI ID of your CD-ROM drive.

3 Exit the menu with Esc .

4 Open Configure Adapter Settings. Under Additional Options, select Boot Device
Options and press Enter .

5 Enter the ID of the CD-ROM drive and press Enter again.

6 Press Esc twice to return to the start screen of the SCSI BIOS.

7 Exit this screen and confirm with Yes to boot the computer.

Regardless of what language and keyboard layout your final installation will be using,
most BIOS configurations use the US keyboard layout as depicted in the following
figure:

Figure 9.1 US Keyboard Layout
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9.2.3 Installation Fails and Machine Fails to
Boot

Some hardware types, mainly fairly old or very recent ones, fail to install. In many
cases, this might happen because missing support for this type of hardware in the instal-
lation kernel or due to certain functionalities included in this kernel, such as ACPI, that
still cause problems on some hardware.

If your system fails to install using the standard Installation mode from the first instal-
lation boot screen, try the following:

1 With the first CD or DVD still in the CD-ROM drive, reboot the machine with
Ctrl + Alt + Del or using the hardware reset button.

2 When the boot screen appears, use the arrow keys of your keyboard to navigate
to Installation--ACPI Disabled and press Enter to launch the boot and installation
process. This option disables the support for ACPI power management techniques.

3 Proceed with the installation as described in Chapter 1, Installation with YaST
(page 3).

If this fails, proceed as above, but choose Installation--Safe Settings instead. This option
disables ACPI and DMA support. Most hardware should boot with this option.

If both of these options fail, use the boot options prompt to pass any additional param-
eters needed to support this type of hardware on to the installation kernel. For more
information about the parameters available as boot options, refer to the kernel documen-
tation located in /usr/src/linux/Documentation/kernel-parameters
.txt.

TIP: Obtaining Kernel Documentation

Install the kernel-source package to check out the kernel documentation.

There are various other ACPI-related kernel parameters that can be entered at the boot
prompt prior to booting for installation:
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acpi=off
This parameter disables the complete ACPI subsystem on your computer. This may
be useful if your computer cannot handle ACPI at all or if you think ACPI in your
computer causes trouble.

acpi=force
Always enable ACPI even if your computer has an old BIOS dated before the year
2000. This parameter also enables ACPI if it is set in addition to acpi=off.

acpi=noirq
Do not use ACPI for IRQ routing.

acpi=ht
Run only enough ACPI to enable hyper-threading.

acpi=strict
Be less tolerant of platforms that are not strictly ACPI specification compliant.

pci=noacpi
Disable PCI IRQ routing of the new ACPI system.

For more information about these issues, search for Support Database articles with the
keyword “acpi” at https://portal.suse.com.

Once you have determined the right parameter combination, YaST automatically writes
them to the boot loader configuration to make sure that the system boots properly next
time.

If unexplainable errors occur when the kernel is loaded or during the installation, select
Memory Test in the boot menu to check the memory. If Memory Test returns an error,
it is usually a hardware error.

9.2.4 Machine Fails to Launch the Graphical
Installer

After you insert the first CD or DVD into your drive and reboot your machine, the in-
stallation screen comes up, but after you select Installation, the graphical installer does
not start.
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There are several ways to deal with this situation:

• Try to select another screen resolution for the installation dialogs.

• Select Text Mode for installation.

• Do a remote installation via VNC using the graphical installer.

To change to another screen resolution for installation, proceed as follows:

1 Boot for installation.

2 Press F3 twice to open a menu from which to select a lower resolution for in-
stallation purposes.

3 Select Installation and proceed with the installation as described in Chapter 1,
Installation with YaST (page 3).

To perform an installation in text mode, proceed as follows:

1 Boot for installation.

2 Press F3 twice and select Text Mode.

3 Select Installation and proceed with the installation as described in Chapter 1,
Installation with YaST (page 3).

To perform a VNC installation, proceed as follows:

1 Boot for installation.

2 Enter the following text at the boot options prompt:
vnc=1 vncpassword=some_password

Replace some_password with the password to use for installation.

3 Select Installation then press Enter to start the installation.

Instead of starting right into the graphical installation routine, the system continues
to run in text mode then halts, displaying a message containing the IP address
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and port number under which the installer can be reached via a browser interface
or a VNC viewer application.

4 If using a browser to access the installer, launch the browser and enter the address
information provided by the installation routines on the future SUSE Linux ma-
chine and hit Enter :
http://ip_address_of_machine:5801

A dialog opens in the browser window prompting you for the VNC password.
Enter it and proceed with the installation as described in Chapter 1, Installation
with YaST (page 3).

IMPORTANT

Installation via VNC works with any browser under any operating system,
provided Java support is enabled.

If you use any kind of VNC viewer on your preferred operating system, enter
the IP address and password when prompted to do so. A window opens, displaying
the installation dialogs. Proceed with the installation as usual.

9.2.5 Machine Boots but Starts a
Minimalistic Boot Screen

You inserted the first CD or DVD into the drive, the BIOS routines are finished, but
the system does not start with the graphical boot screen. Instead it launches a very
minimalistic text-based interface. This might happen on any machine not providing
sufficient graphics memory for rendering a graphical boot screen.

Although the text boot screen looks minimalistic, it provides nearly the same function-
ality as the graphical one:

Boot Options
Unlike the graphical interface, the different boot options cannot be selected using
the cursor keys of your keyboard. The boot menu of the text mode boot screen offers
some keywords to enter at the boot prompt. These keywords map to the options
offered in the graphical version. Enter your choice and hit Enter to launch the
boot process.
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Custom Boot Options
After selecting a boot option, enter the appropriate keyword at the boot prompt or
enter some custom boot options as described in Section 9.2.3, “Installation Fails
and Machine Fails to Boot” (page 219). To launch the installation process, press
Enter .

Screen Resolutions
Use the F keys to determine the screen resolution for installation. If you need to
boot in text mode, choose F3 .

9.3 Boot Problems
Boot problems are situations when your system does not boot properly (that is, does
not boot to the expected runlevel and login screen).

9.3.1 Machine Loads the BIOS Properly but
Fails to Load the GRUB Boot Loader

If the hardware is functioning properly, it is possible that the boot loader has become
corrupted and Linux cannot start on the machine. In this case, it is necessary to reinstall
the boot loader.

To reinstall the boot loader, proceed as follows:

1 Insert the installation media into the drive.

2 Reboot the machine.

3 Select Installation from the boot menu.

4 Select a language.

5 Accept the license agreement.

6 In the Installation Mode screen, select Other and set the installation mode to
Repair Installed System.
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7 Once in the YaST System Repair module, select Expert Tools then select Install
New Boot Loader.

8 Restore the original settings and reinstall the boot loader.

9 Leave YaST System Repair and reboot the system.

Other reasons for the machine not booting may be BIOS-related:

BIOS Settings
Check your BIOS for references to your hard drive. GRUB might simply not be
started if the hard drive itself cannot be found with the current BIOS settings.

BIOS Boot Order
Check whether your system's boot order includes the hard disk. If the hard disk
option was not enabled, your system might install properly, but fail to boot when
access to the hard disk is required.

9.3.2 Machine Loads GRUB Properly, but
Does Not Boot into a Graphical Login

If the machine comes up, but does not boot into the graphical login manager, anticipate
problems either with the choice of the default runlevel or the configuration of the X
Window System. To check the runlevel configuration, log in as the root user and
check whether the machine is configured to boot into runlevel 5 (graphical desktop).
A quick way to check this is to examine the contents of /etc/inittab, as follows:
nld-machine:~ # grep "id:" /etc/inittab 
id:5:initdefault:
nld-machine:~ #

The returned line indicates that the machine's default runlevel (initdefault) is set
to 5 and that it should boot to the graphical desktop. If the runlevel is set to any other
number, use the YaST Runlevel Editor module to set it to 5.

IMPORTANT

Do not edit the runlevel configuration manually. Otherwise SuSEconfig (run by
YaST) will overwrite these changes on its next run. If you need to make manual
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changes here, disable future SuSEconfig changes by setting CHECK_INITTAB
in /etc/sysconfig/suseconfig to no.

If the runlevel is set to 5, you might have corruption problems with your desktop or X
Windows software. Examine the log files at /var/log/Xorg.*.log for detailed
messages from the X server as it attempted to start. If the desktop fails during start, it
might log error messages to /var/log/messages. If these error messages hint at
a configuration problem in the X server, try to fix these issues. If the graphical system
still does not come up, consider reinstalling the graphical desktop. For more information
about X server configuration, refer to Chapter The X Window System (↑Reference).

One quick test: the startx command should force the X Window System to start with
the configured defaults if the user is currently logged in on the console. If that does not
work, it should log errors to the console. For more information about the X Window
system configuration, refer to Chapter The X Window System (↑Reference).

9.4 Login Problems
Login problems are those where your machine does, in fact, boot to the expected wel-
come screen or login prompt, but refuses to accept the username and password or accepts
them but then does not behave properly (fails to start the graphic desktop, produces
errors, drops to a command line, etc.).

9.4.1 User Cannot Log In—Valid Username
and Password Combinations Fail

This usually occurs when the system is configured to use network authentication or
directory services and, for some reason, is unable to retrieve results from its configured
servers. The root user, as the only local user, is the only user that can still log in to
these machines. The following are some common reasons why a machine might appear
functional but be unable to process logins correctly:

• The network is not working. For further directions on this, turn to Section 9.5,
“Network Problems” (page 232).

Common Problems and Their Solutions 225



• DNS is not working at the moment (which prevents GNOME or KDE from working
and the system from making validated requests to secure servers). One indication
that this is the case is that the machine takes an extremely long time to respond to
any action. More information about this topic can be found in Section 9.5, “Network
Problems” (page 232).

• If the system is configured to use Kerberos, the system's local time might have
drifted past the accepted variance with the Kerberos server time (this is typically
300 seconds). If NTP (network time protocol) is not working properly or local NTP
servers are not working, Kerberos authentication ceases to function because it de-
pends on common clock synchronization across the network.

• The system's authentication configuration is misconfigured. Check the PAM confi-
guration files involved for any typos or misordering of directives. For additional
background information about PAM and the syntax of the configuration files in-
volved, refer to Chapter Authentication with PAM (↑Reference).

In all cases that do not involve external network problems, the solution is to reboot the
system into a single-user mode and repair the configuration before booting again into
operating mode and attempting to log in again.

To boot into single-user mode:

1 Reboot the system. The boot screen appears, offering a prompt.

2 Enter 1 at the boot prompt to make the system boot into single-user mode.

3 Enter the username and password for root.

4 Make all the necessary changes.

5 Boot into the full multiuser and network mode by entering telinit 5 at the
command line.
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9.4.2 User Cannot Log In—Particular Valid
Username and Password Not Accepted

This is by far the most common problem users encounter, because there are many reasons
this can occur. Depending on whether you use local user management and authentication
or network authentication, login failures occur for different reasons.

Local user management can fail for the following reasons:

• The user might have entered the wrong password.

• The user's home directory containing the desktop configuration files is corrupted
or write protected.

• There might be problems with the X Window System authenticating this particular
user, especially if the user's home directory has been used with another Linux dis-
tribution prior to installing the current one.

To locate the reason for a local login failure, proceed as follows:

1 Check whether the user remembered his password correctly before you start de-
bugging the whole authentication mechanism. If the user might not remember
his password correctly, use the YaST User Management module to change the
user's password.

2 Log in as root and check /var/log/messages for error messages of the
login process and of PAM.

3 Try to log in from a console (using Ctrl + Alt + F1 ).

If this is successful, the blame cannot be put on PAM, because it is possible to
authenticate this user on this machine. Try to locate any problems with the X
Window System or the desktop (GNOME or KDE). For more information, refer
to Section 9.4.3, “ Login Successful but GNOME Desktop Fails ” (page 230) and
Section 9.4.4, “ Login Successful but KDE Desktop Fails” (page 230).

4 If the user's home directory has been used with another Linux distribution, remove
the Xauthority file in the user's home. Use a console login via Ctrl + Alt

+ F1 and run rm .Xauthority as this user. This should eliminate X authen-
tication problems for this user. Try a graphical login again.
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5 If graphical login still fails, do a console login with Ctrl + Alt + F1 . Try to
start an X session on another display, the first one (:0) is already in use:
startx -- :1

This should bring up a graphical screen and your desktop. If it does not, check
the log files of the X Window System (/var/log/Xorg.displaynumber
.log) or the log file for your desktop applications (.xsession-errors in
the user's home directory) for any irregularities.

6 If the desktop could not start because of corrupt configuration files, proceed with
Section 9.4.3, “ Login Successful but GNOME Desktop Fails ” (page 230) or
Section 9.4.4, “ Login Successful but KDE Desktop Fails” (page 230).

The following are some common reasons why network authentication for a particular
user might fail on a specific machine:

• The user might have entered the wrong password.

• The username exists in the machine's local authentication files and is also provided
by a network authentication system, causing conflicts.

• The home directory exists but is corrupt or unavailable. Perhaps it is write protected
or is on a server that is inaccessible at the moment.

• The user does not have permission to log in to that particular host in the authentica-
tion system.

• The machine has changed hostnames, for whatever reason, and the user does not
have permission to log in to that host.

• The machine cannot reach the authentication server or directory server that contains
that user's information.

• There might be problems with the X Window System authenticating this particular
user, especially if the user's home has been used with another Linux distribution
prior to installing the current one.

To locate the cause of the login failures with network authentication, proceed as follows:

1 Check whether the user remembered his password correctly before you start de-
bugging the whole authentication mechanism.
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2 Determine the directory server the machine relies on for authentication and make
sure that it is up and running and properly communicating with the other machines.

3 Determine that the user's username and password work on other machines to
make sure that his authentication data exists and is properly distributed.

4 See if another user can log in to the misbehaving machine.

If another user can log in without difficulty or if root can log in, log in and
examine the/var/log/messages file. Locate the time stamps that correspond
to the login attempts and determine if PAM has produced any error messages.

5 Try to log in from a console (using Ctrl + Alt + F1 ).

If this is successful, the blame cannot be put on PAM or the directory server on
which the user's home is hosted, because it is possible to authenticate this user
on this machine. Try to locate any problems with the X Window System or the
desktop (GNOME or KDE). For more information, refer to Section 9.4.3, “ Login
Successful but GNOME Desktop Fails ” (page 230) and Section 9.4.4, “ Login
Successful but KDE Desktop Fails” (page 230).

6 If the user's home directory has been used with another Linux distribution, remove
the Xauthority file in the user's home. Use a console login via Ctrl + Alt

+ F1 and run rm .Xauthority as this user. This should eliminate X authen-
tication problems for this user. Try a graphical login again.

7 If graphical login still fails, do a console login with Ctrl + Alt + F1 . Try to
start an X session on another display, the first one (:0) is already in use:
startx -- :1

This should bring up a graphical screen and your desktop. If it does not, check
the log files of the X Window System (/var/log/Xorg.displaynumber
.log) or the log file for your desktop applications (.xsession-errors in
the user's home directory) for any irregularities.

8 If the desktop could not start because of corrupt configuration files, proceed with
Section 9.4.3, “ Login Successful but GNOME Desktop Fails ” (page 230) or
Section 9.4.4, “ Login Successful but KDE Desktop Fails” (page 230).
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9.4.3 Login Successful but GNOME Desktop
Fails

If this is true for a particular user, it is likely that the user's GNOME configuration files
have become corrupted. Some symptoms might include the keyboard failing to work,
the screen geometry becoming distorted, or even the screen coming up as a bare gray
field. The important distinction is that if another user logs in, the machine works nor-
mally. If this is the case, it is likely that the problem can be fixed relatively quickly by
simply moving the user's GNOME configuration directory to a new location, which
causes GNOME to initialize a new one. Although the user is forced to reconfigure
GNOME, no data is lost.

1 Log in as root.

2 cd to the user's home directory.

3 Move the user's GNOME configuration directories to a temporary location:
mv ./.gconf ./.gconf-ORIG-RECOVER
mv ./.gnome2 ./.gnome2-ORIG-RECOVER

4 Log out.

5 Have the user log in, but do not allow him to run any applications.

6 Recover the user's individual application configuration data (including the Evo-
lution e-mail client data) by copying the ~/.gconf-ORIG-RECOVER/apps/
directory back into the new ~/.gconf directory as follows:
cp -a ./.gconf-ORIG-RECOVER/apps ./.gconf/

If this causes the login problems, attempt to recover only the critical application
data and force the user to reconfigure the remainder of the applications.

9.4.4 Login Successful but KDE Desktop Fails
There are several reasons why a KDE desktop would not allow users to login. Corrupted
cache data can cause login problems as well as corrupt KDE desktop configuration
files.
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Cache data is used at desktop start-up to increase performance. If this data is corrupted,
start-up is slowed down or fails entirely. Removing them forces the desktop start-up
routines to start from scratch. This takes more time than a normal start-up, but data is
intact after this and the user can login.

To remove the cache files of the KDE desktop, issue the following command as root:
rm -rf /tmp/kde-user /tmp/socket-user

Replace user with the actual username. Removing these two directories just removes
the corrupted cache files, no real data is harmed using this procedure.

Corrupted desktop configuration files can always be replaced with the initial configura-
tion files. If you want to recover the user's adjustments, carefully copy them back from
their temporary location, after the configuration has been restored using the default
configuration values.

To replace a corrupted desktop configuration with the initial configuration values,
proceed as follows:

1 Log in as root.

2 Enter the user's home directory:
cd /home/user

3 Move the KDE configuration directory and the .skel files to a temporary loca-
tion:
mv .kde .kde-ORIG-RECOVER 
mv .skel .skel-ORIG-RECOVER

4 Log out.

5 Let the user log in to this machine.

6 After the desktop has started successfully, copy the user's own configurations
back into place:
user@nld-machine:~ > cp -a .kde-ORIG-RECOVER/share .kde/share
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IMPORTANT

If the user's own adjustments caused the login to fail and continue to do
so, repeat the procedure as described above, but do not copy the .kde/
share directory.

9.5 Network Problems
Many problems of your system may be network-related, even though they do not seem
to be at first. For example, the reason for a system not allowing users to log in might
be a network problem of some kind. This section introduces a simple check list you
can apply to identify the cause of any network problem encountered.

When checking the network connection of your machine, proceed as follows:

1 If using an ethernet connection, check the hardware first. Make sure that your
network cable is properly plugged into your computer. The control lights next
to your ethernet connector, if available, should both be active.

If the connection fails, check whether your network cable works with another
machine. If it does, your network card causes the failure. If hubs or switches are
included in your network setup, suspect them to be the culprits as well.

2 If using a wireless connection, check whether the wireless link can be established
by other machines. If this is not the case, contact the wireless network's adminis-
trator.

3 Once you have checked your basic network connectivity, try to find out which
service is not responding.

Gather the address information of all network servers needed in your setup. Either
look them up in the appropriate YaST module or ask your system administrator.
The following list gives some of the typical network servers involved in a setup
together with the symptoms of an outage.

DNS (Name Service)
A broken or malfunctioning name service affects the network's functioning
in many ways. If the local machine relies on any network servers for authen-
tication and these servers cannot be found due to name resolution issues,
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users would not even be able to log in. Machines in the network managed
by a broken name server would not be able to “see” each other and commu-
nicate.

NTP (Time Service)
A malfunctioning or completely broken NTP service could affect Kerberos
authentication and X server functionality.

NFS (File Service)
If any application needed data stored in an NFS mounted directory, it would
not be able to start up or function properly if this service was down or mis-
configured. In a worst case scenario, a user's personal desktop configuration
would not come up if his home directory containing his .gconf or .kde
subdirectories could not be found due to an outage of the NFS server.

Samba (File Service)
If any application needed data stored in a directory on a Samba server, it
would not be able to start or function properly if this service was down.

NIS (User Management)
If your SUSE Linux system relied on a NIS server to provide the user data,
users would not be able to log in to this machine if the NIS service was down.

LDAP (User Management)
If your SUSE Linux system relied on an LDAP server to provide the user
data, users would not be able to log in to this machine if the LDAP service
was down.

Kerberos (Authentication)
Authentication would not work and login to any machine would fail.

CUPS (Network Printing)
Users would not be able to print.

4 Check whether the network servers are running and whether your network setup
allows you to establish a connection:

IMPORTANT

The debugging procedure described below only applies to a simple net-
work server/client setup that does not involve any internal routing. We
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assume both server and client to be members of the same subnet without
the need for additional routing.

a Use ping hostname (replace hostname with the hostname of the
server) to check whether each one of them is up and responding to the net-
work. If this command is successful, it tells you that the host you were
looking for is up and running and that the name service for your network is
configured correctly.

If ping fails with destination host unreachable, either your
system or the desired server is not properly configured or down. Check
whether your system is reachable by running ping your_hostname
from another machine. If you succeed to reach your machine from another
machine, it is the server that is not running at all or not configured correctly.

If ping fails with unknown host, the name service is not configured
correctly or the hostname used was incorrect. Use ping -n ipaddress
to try to connect to this host without name service. If this is successful,
check the spelling of the hostname and for a misconfigured name service
in your network. For further checks on this matter, refer to Step 4.b
(page 234). If ping still fails, either your network card is not configured
correctly or your network hardware is faulty. Refer to Step 4.c (page 235)
for information about this.

b Use host hostname to check whether the hostname of the server you
are trying to connect to is properly translated into an IP address and vice
versa. If this command returns the IP address of this host, the name service
is up and running. If this the host command fails, check all network confi-
guration files relevant to name and address resolution on your host:

/etc/resolv.conf
This file is used to keep track of the name server and domain you are
currently using. It can be modified manually or be automatically adjusted
by YaST or DHCP. Automatic adjustment is preferable. However, make
sure that this file has the following structure and all network addresses
and domain names are correct:
search fully_qualified_domain_name
nameserveripaddress_of_nameserver
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This file can contain more than one name server address, but at least
one of them must be correct to provide name resolution to your host.
If needed, adjust this file using the YaST DNS and Hostname module.

If your network connection is handled via DHCP, enable DHCP to
change hostname and name service information by selecting Change
Hostname via DHCP and Update Name Servers and Search List via
DHCP in the YaST DNS and Hostname module.

/etc/nsswitch.conf
This file tells Linux where to look for name service information. It
should look like this:
...
hosts: files dns
networks: files dns
...

The dns entry is vital. It tells Linux to use an external name server.
Normally, these entries are automatically made by YaST, but it never
hurts to check.

If all the relevant entries on the host are correct, let your system admin-
istrator check the DNS server configuration for the correct zone infor-
mation. For detailed information about DNS, refer to Chapter The Do-
main Name System (↑Reference). If you have made sure that the DNS
configuration of your host and the DNS server are correct, proceed with
checking the configuration of your network and network device.

c If your system cannot establish a connection to a network server and you
have excluded name service problems from the list of possible culprits,
check the configuration of your network card.

Use the command ifconfig network_device (executed as root)
to check whether this device was properly configured. Make sure that both
inet address and Mask are configured correctly. An error in the IP
address or a missing bit in your network mask would render your network
configuration unusable. If necessary, perform this check on the server as
well.

d If name service and network hardware are properly configured and running,
but some external network connections still get long time-outs or fail entirely,
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use traceroute fully_qualified_domain_name (executed as
root) to track the network route these requests are taking. This command
lists any gateway (hop) a request from your machine passes on its way to
its destination. It lists the response time of each hop and whether this hop
is reachable at all. Use a combination of traceroute and ping to track down
the culprit and let the administrators know.

Once you have identified the cause of your network trouble, you can resolve it yourself
(if the problem is located on your machine) or let the system administrators of your
network know about your findings so they can reconfigure the services or repair the
necessary systems.

9.6 Data Problems
Data problems are when the machine might or might not boot properly but, in either
case, it is clear that there is data corruption on the system and that the system needs to
be recovered. These situations call for a backup of your critical data, enabling you to
recover the status quo from before your system failed. SUSE Linux offers dedicated
YaST modules for system backup and restoration as well as a rescue system that can
be used to recover a corrupted system from the outside.

9.6.1 Backing Up Critical Data
System backups can be easily managed using the YaST System Backup module:

1 As root, start YaST and select System → System Backup.

2 Create a backup profile holding all details needed for the backup, filename of
the archive file, scope, and type of the backup:

a Select Profile Management → Add.

b Enter a name for the archive.

c Enter the path to the location of the backup if you want to keep a local
backup. For your backup to be archived on a network server (via NFS),
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enter the IP address or name of the server and the directory that should hold
your archive.

d Determine the archive type and click Next.

e Determine the backup options to use, such as whether files not belonging
to any package should be backed up and whether a list of files should be
displayed prior to creating the archive. Also determine whether changed
files should be identified using the time-consuming MD5 mechanism.

Use Expert to enter a dialog for the backup of entire hard disk areas. Cur-
rently, this option only applies to the Ext2 file system.

f Finally, set the search constraints to exclude certain system areas from the
backup area that do not need to be backed up, such as lock files or cache
files. Add, edit, or delete items until your needs are met and leave with OK.

3 Once you have finished the profile settings, you can start the backup right away
with Create Backup or configure automatic backup. It is also possible to create
other profiles tailored for various other purposes.

To configure automatic backup for a given profile, proceed as follows:

1 Select Automatic Backup from the Profile Management menu.

2 Select Start Backup Automatically.

3 Determine the backup frequency. Choose daily, weekly, or monthly.

4 Determine the backup start time. These settings depend on the backup frequency
selected.

5 Decide whether to keep old backups and how many should be kept. To receive
an automatically generated status message of the backup process, check Send
Summary Mail to User root.

6 Click OK for your settings to be applied and the first backup started at the time
specified.
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9.6.2 Restoring a System Backup
Use the YaST System Restoration module to restore the system configuration from a
backup. Restore the entire backup or select specific components that were corrupted
and need to be reset to their old state.

1 Start YaST → System → System Restoration.

2 Enter the location of the backup file. This could be a local file, a network
mounted file, or a file on a removable device, such as a floppy or a CD. Then
click Next.

The following dialog displays a summary of the archive properties, such as the
filename, date of creation, type of backup and optional comments.

3 Review the archived content by clicking Archive Content. Clicking OK returns
you to the Archive Properties dialog.

4 Expert Options opens a dialog in which to fine-tune the restore process. Return
to the Archive Properties dialog by clicking OK.

5 Click Next to open the view of packages to restore.

PressAccept to restore all files in the archive or use the various Select All,Deselect
All, and Select Files buttons for a fine-tuning of your selection. Only check the
Restore RPM Database option if it is corrupted or deleted and if this file is in-
cluded in the backup.

6 After you click Accept, the backup is restored. Click Finish to leave the module
after the restore process is completed.

9.6.3 Recovering a Corrupted System
There are several reasons why a system could fail to come up and run properly. A cor-
rupted file system after a system crash, corrupted configuration files, or a corrupted
boot loader configuration are the most common ones.

SUSE Linux offers a graphical front-end for system repair. The following section intro-
duces the YaST System Repair module.
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SUSE Linux offers two different methods to cope with this kind of situation. You can
either use the YaST System Repair functionality or boot the rescue system. The following
sections cover both flavors of system repair.

Using YaST System Repair
Before launching the YaST System Repair module, determine in which mode to run it
to best fit your needs. Depending on the severeness and cause of your system failure
and your expertise, there are three different modes to choose from:

Automatic Repair
If your system failed due to an unknown cause and you basically do not know
which part of the system is to blame for the failure, use Automatic Repair. An ex-
tensive automated check will be performed on all components of your installed
system. For a detailed description of this procedure, refer to Section “Automatic
Repair” (page 239).

Customized Repair
If your system failed and you already know which component is to blame, you can
cut the lengthy system check with Automatic Repair short by limiting the scope of
the system analysis to those components. For example, if the system messages
prior to the failure seem to indicate an error with the package database, you can
limit the analysis and repair procedure to checking and restoring this aspect of your
system. For a detailed description of this procedure, refer to Section “Customized
Repair” (page 241).

Expert Tools
If you already have a clear idea of what component failed and how this should be
fixed, you can skip the analysis runs and directly apply the tools necessary for the
repair of the respective component. For details, refer to Section “Expert Tools”
(page 242).

Choose one of the repair modes as described above and proceed with the system repair
as outlined in the following sections.

Automatic Repair

To start the automatic repair mode of YaST System Repair, proceed as follows:
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1 Boot the system with the original installation medium used for the initial instal-
lation (as outlined in Chapter 1, Installation with YaST (page 3)).

2 Select the Repair Installed System installation mode.

3 Select Automatic Repair.

YaST now launches an extensive analysis of the installed system. The progress
of the procedure is displayed at the bottom of the screen with two progress bars.
The upper bar shows the progress of the currently running test. The lower bar
shows the overall progress of the analysis. The log window in the top section
tracks the currently running test and its result. See Figure 9.2, “Automatic Repair
Mode” (page 240). The following main test runs are performed with every run.
They contain, in turn, a number of individual subtests.

Figure 9.2 Automatic Repair Mode

Partition Tables of All Hard Disks
Checks the validity and coherence of the partition tables of all detected hard
disks.

Swap Partitions
The swap partitions of the installed system are detected, tested, and offered
for activation where applicable. The offer should be accepted for the sake
of a higher system repair speed.
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File Systems
All detected file systems are subjected to a file system–specific check.

Entries in the File /etc/fstab
The entries in the file are checked for completeness and consistency. All
valid partitions are mounted.

Boot Loader Configuration
The boot loader configuration of the installed system (GRUB or LILO) is
checked for completeness and coherence. Boot and root devices are examined
and the availability of the initrd modules is checked.

Package Database
This checks whether all packages necessary for the operation of a minimal
installation are present. While it is optionally possible also to analyze the
base packages, this takes a long time because of their vast number.

4 Whenever an error is encountered, the procedure stops and a dialog opens outlin-
ing the details and possible solutions.

Read the screen messages carefully before accepting the proposed fix. If you
decide to decline a proposed solution, your system remains unchanged.

5 After the repair process has been terminated successfully, click OK and Finish
and remove the installation media. The system automatically reboots.

Customized Repair

To launch the Customized Repair mode and selectively check certain components of
your installed system, proceed as follows:

1 Boot the system with the original installation medium used for the initial instal-
lation (as outlined in Chapter 1, Installation with YaST (page 3)).

2 Select the Repair Installed System installation mode.

3 Select Customized Repair.

Choosing Customized Repair shows a list of test runs that are all marked for ex-
ecution at first. The total range of tests matches that of automatic repair. If you
already know where no damage is present, unmark the corresponding tests.
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Clicking Next starts a narrower test procedure that probably has a significantly
shorter running time.

Not all test groups can be applied individually. The analysis of the fstab entries
is always bound to an examination of the file systems, including existing swap
partitions. YaST automatically resolves such dependencies by selecting the
smallest number of necessary test runs.

4 Whenever an error is encountered, the procedure stops and a dialog opens outlin-
ing the details and possible solutions.

Read the screen messages carefully before accepting the proposed fix. If you
decide to decline a proposed solution, your system remains unchanged.

5 After the repair process has been terminated successfully, click OK and Finish
and remove the installation media. The system automatically reboots.

Expert Tools

If you are knowledgeable with SUSE Linux and already have a very clear idea of what
needs to be repaired in your system, directly apply the tools skipping the system analysis.

To make use of the Expert Tools feature of the YaST System Repair module, proceed
as follows:

1 Boot the system with the original installation medium used for the initial instal-
lation (as outlined in Chapter 1, Installation with YaST (page 3)).

2 Select the Repair Installed System installation mode.

3 Select Expert Tools.

Choose one or more of the following options to repair your faulty system:

Install New Boot Loader
This starts the YaST boot loader configuration module. Find details in Sec-
tion “Configuring the Boot Loader with YaST” (Chapter 9, The Boot Loader,
↑Reference).
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Run Partitioning Tool
This starts the expert partitioning tool in YaST. Find details in Section 2.5.6,
“Partitioner” (page 53).

Repair File System
This checks the file systems of your installed system. You are first offered
a selection of all detected partitions and can then choose the ones to check.

Recover Lost Partitions
It is possible to attempt to reconstruct damaged partition tables. A list of
detected hard disks is presented first for selection. Clicking OK starts the
examination. This can take a while depending on the processing power and
size of the hard disk.

IMPORTANT: Reconstructing a Partition Table

The reconstruction of a partition table is tricky. YaST attempts to
recognize lost partitions by analyzing the data sectors of the hard
disk. The lost partitions are added to the rebuilt partition table when
recognized. This is, however, not successful in all imaginable cases.

Save System Settings to Floppy
This option saves important system files to a floppy disk. If one of these files
become damaged, it can be restored from disk.

Verify Installed Software
This checks the consistency of the package database and the availability of
the most important packages. Any damaged installed packages can be rein-
stalled with this tool.

4 After the repair process has been terminated successfully, click OK and Finish
and remove the installation media. The system automatically reboots.

9.7 Support for SUSE Linux
Useful support information for SUSE Linux is available in a number of sources. If you
encounter problems with the installation or use of SUSE Linux that you are unable to
solve, our experienced support staff can offer practical assistance with the free installa-
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tion support for registered products and the incident-based support by phone or Web.
Nearly all common customer problems can be eliminated quickly and competently.

9.7.1 Free Installation Support
Our free installation support is provided for a period of 90 days following the activation
of your registration code (starting latest with the release of a new version). If you cannot
find an answer to your question in any of the available information sources, we will
gladly provide assistance for the following issues:

• Installation on a typical private workstation or laptop equipped with a single pro-
cessor, at least 256 MB RAM, and 3 GB of free hard disk space.

• Resizing of one Windows partition that occupies the entire hard disk.

• Installation of a local ATAPI CD or DVD drive.

• Installation on the first or second hard disk in an IDE-only system (/dev/hda or
/dev/hdb) or supported S-ATA system, excluding RAID.

• Integration of a standard keyboard and standard mouse.

• Configuration of the graphical user interface (without the hardware acceleration
feature of the graphics card).

• Installation of the boot manager in the MBR of the first hard disk or on a floppy
disk without modifying the BIOS mapping.

• Setup of Internet access with a supported PCI ISDN card or external serial modem
(not USB). Alternatively, setup of DSL based on PPPoE with a supported NIC.

• Basic configuration of an ALSA-supported PCI sound card.

• Basic configuration of a locally-attached compatible printer with YaST.

• Basic configuration of an IDE CD writer for use with k3b (CD burning application)
without changing the jumper setting.

• Configuration of a supported PCI ethernet card for LAN access with either DHCP
(client) or static IP. This does not include the configuration of the LAN or any
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other computers or network components. It also does not cover the configuration
of the computer as a router. Fault analysis is limited to checking for proper loading
of the kernel module and the correct local network settings.

• Configuration of an e-mail client (only Evolution and KMail) for collecting mail
from a POP3 account. Fault analysis is limited to checking for proper settings in
the e-mail client.

• Support for the package selection Standard System.

• Upgrade from the previous version of the product.

• Kernel updates (only official SUSE Linux update RPMs).

• Installation of bug fixes and security updates from ftp.suse.com or a SUSE FTP
mirror using online update or the manual method.

For a detailed listing of the subjects covered by the free installation support, please
check http://www.novell.com/usersupport.

Contact Information for Free Installation Support
Reach our support staff under the following links and phone numbers. Any prices listed
are call costs, not costs for support.

• http://support.novell.com/eService

• Germany: Phone: 0900 111 2 777 (12 Cent/min) (Monday through Friday from
13:00 to 17:00 CET)

• Austria: Phone: 0820 500 781 (14.5 cent/min) (Monday through Friday from 13:00
to 17:00 CET)

• Switzerland: Phone: 0848 860 847 (costs depend on provider) (Monday through
Friday from 13:00 to 17:00 CET)

• UK: Phone: +44-1344-326-666 (Monday through Friday from 13:00 to 17:00 GMT)

• United States and Canada: Phone: +1-800-796-3700 (Monday through Friday from
12:00 p.m. to 6:00 p.m. EST or 09:00 a.m. to 03:00 p.m. PST)
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• France: Phone: +33 1 55 62 50 50 (Monday through Friday from 13:00 to 17:00
CET)

• Spain: Phone: +34 (0)91 375 3057 (Monday through Friday from 13:00 to 17:00
CET)

• Italy: Phone: +39 02 2629 5555, support is available in Italian (Monday through
Friday from 13:00 to 17:00 CET)

• Czech Republic: E-mail: support@suse.cz (Monday through Friday)

• All other countries: Support is provided in English only. Phone: +44-1344-326-666
(Monday through Friday from 12:00 to 18:00 CET)

For the most recent contact information, refer to http://www.novell.com/
support/products/suselinux/contacts.html.

Important Notes
1. Only customers with a valid, activated registration code are entitled to free sup-

port. You can activate your registration code athttp://www.novell.com/
usersupport.

2. The registration code is not transferable to another person.

3. The free support covers only the initial installation on one computer. Refer to
our Web site for further information.

4. We can provide support only for hardware supported by SUSE Linux. Refer to
our Component Database atwww.novell.com/usersupport/hardware
for information about supported hardware components.

Contact Recommendations
Misspelled commands, links, or directory names often cause frustrating problems and
are particularly common during phone conversations. To help prevent this problem,
please send us a brief description of your question or problem by opening a service re-
quest on http://support.novell.com/eService. You will receive a reply
soon after that provides a practical solution.
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9.7.2 Advanced Support
Qualified support is available at transparent rates. If your question is not covered by
the scope of the free service or if you do not have a valid support claim, you can take
advantage of our Advanced Support Program. You can reach us by phone:

• Germany: 0190-86 28 00 (1.86 €/minute)

• Austria: 0900-47 01 10 (1.80 €/minute)

• Switzerland: 0900-70 07 10 (3.13 SFr/minute)

• Rest of Europe: Phone: +44-1344-326-666, Price: € 46 including VAT. Monday-
Friday from 12:00 to 18:00 CET

• United States and Canada: Phone: +1-800-796-3700. Price: $39 including tax.
Monday-Friday from 09:00 a.m. to 06:00 p.m. EST or 06:00 a.m. to 03:00 p.m.
PST.

• All other countries: Phone: +44-1344-326-666, Price: € 46 including VAT, Monday-
Friday, 12:00-18:00 CET

One incident covers up to twenty minutes of assistance from our experienced support
staff. The payment is credit-card based. Visa, Eurocard, and Mastercard are accepted.
Financial transactions may be handled by our service partner, Stream / ECE EMEA
Ltd.

Please be aware that the phone numbers may change during the sales cycle of SUSE
Linux 10.1. Current numbers as well as a detailed listing of the subjects covered by the
Advanced Support Service can be found at http://www.novell.com/
usersupport.

NOTE

While our expert staff will do their best to provide top-quality support, we
cannot guarantee a solution.
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We endeavor to help you as quickly and precisely as possible. The effort and time
needed is considerably reduced if the question is formulated clearly. Please have answers
to the following questions ready before contacting us:

1. Which program and version are you using? During which process does the
problem occur?

2. What exactly is the problem? Try to describe the error as precisely as possible,
using phrases with words such as when (for example, “When X is pressed, this
error appears”).

3. What hardware do you use (graphics card, monitor, printer, ISDN card, etc.)?

Detailed documentation can be found in manuals, online help, and the Support Database.
In most cases, even problems that seem more difficult to solve are covered in the
comprehensive documentation included with SUSE Linux. The SUSE Help Center on
your desktop provides additional information about installed packages, the vital
HOWTOs, and info pages.

You can access the latest Support Database articles online at http://www.novell
.com/usersupport. By means of the Support Database, which is one of the most
frequently used databases in the Linux world, we offer our customers a wealth of
analysis and solution approaches. You can retrieve tested solutions using the keyword
search, history function, or version-dependent search.
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